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Overview  
This portion of the documentation is a detailed explanation of all the functions. The surveyor who is 

unfamiliar with the program should first work through the tutorial.  

A summary of all the menu functions will be presented first. Following the menu summaries is a General 

Concepts section that contains discussions of various concepts and functions that have frequent use.  

The program uses multiple windows in an attempt to group the functions according to the nature of the work. 

Consequently there is a window titled Survey specifically for working with field data. The COGO window is 

used for most of the drawing and calculation functions associated with the point data. The Layout window is 

used for assembling and arranging selected portions of the drawing data along with auxiliary pieces such as 

title blocks, north arrows and certifications. The operation of each of these window types follows the General 

Concepts section.  

Most of the information is organized according to function name. Some functions are closely related and are 

therefore explained together. Use the Menu Summary to quickly find a detailed explanation on any of the 

menu functions.  

Online Help  
The program has an extensive online help system. There are several ways to access the help system.  

1) Press the <F1> key when inside a function dialog. This will bring up context-sensitive help - jumping to the 

section in the online help that talks about the current function.  

2) Press the <F1> key while a menu item is highlighted. Again, this will bring context-sensitive help regarding 

the currently highlighted menu function.  

3) Select Contents from the Help menu in the Main window. (The Main window is the window with the name 

of the program as its title.) This will bring up a help screen with a list of subjects.  

Words that appear in the online help in double underlined green are jumps - left-clicking on these words will 

move to a more detailed explanation in another portion of the online help.  

  

Suggestion: Select the Using Help command from the Help menu in the Main window if you are not 

familiar with the Windows help system. 
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Menu Summary  

 Main Menus    
 

  
Project Menu  

Command  Page  Description  

New  50  Starts a new project  

Open  50  Opens an existing project  

Save  50  Saves current project  

Save As  50  Saves current project with 

new name  

Close  50  Closes the current project  

Delete Project  51  Deletes a project from 

computer  

Authorize  52  Software protection 

function  

About  52  Program version 

information  

Exit  53  Exits the program  

1,2,3...  53  Opens previous projects  
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 Environment Menu    

Command  Page  Description  

Edit Layers  54  Changes your haircut style  

Select Line Style Set  55  Load predefined line styles  

Write Line Style Set  55  Save currently defined 

linestyles  

Options  55  Program options  

 

 

  

 

  View Menu  

Command  Page  Description  

COGO  93  Coordinate Geometry  

Layout  204  Drafting and page design  

Survey  62  Field data entry and adjustment  

DTM  193  Contours, profiles, volumes  

Component  224  Accesses component libraries  

 

 

  

 

  Help Menu  

Command  Page  Description  

Contents  10  Help Contents  

Using Help  10  How to use Help  
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Cogo Menus  

  

 File  35  Save point data to ASCII file  

 Data Collector  35  Save point data to a Data Collector  

 DXF  35    

Print  109  Print the screen  

Exit  53  Exits program  
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COGO Menu  

Command  Page  Description  

Sideshot  125  Point creation from observation data  

Traverse  125  Same as above, except occupy point 

is updated  

Inverse  177  Distance, direction info between two 

points  

Coordinate Transformation  

   Standard  183  Rotation, scaling, linear 

transformation, copying  

State Plane to 

Ground  

  Convert between state plane and 

local grid coordinate systems  

   Best Fit  186  Least squares best fit transformation  

Offset  133  Curve and/or line offsets  

Occupy/Backsight  189  Sets the current occupy point and 

backsight  

Connect Points  133  “Connect the dots” function  

Best Fit Line  135  Fit a line to a set of points  

Options    Various environmental controls for  

COGO  

 

 

  

  



  
  
  
  

  
  

   16  

 

    Points Menu  

Command  Page  Description  

Next Number  190  Numbering protection and control  

Create Points      

   Array  119  Create an array (grid) of points  

   Box Corner  120    

   By Coordinates  120  Create point by northing, easting, 

elevation information  

   Random  120  Creates points at the cursor location  

   By Station /Offset  120  Create by station and offset value  

   Digitize  120  Input from digitizer tablet  

Point in direction  123  Creates points in a given direction at a 

specified distance  

Edit Individually  125  Edits point information and display 

attributes of selected points  

Modify Group  125  Edits common point characteristics of 

selected points  

Copy\Renumber  123  Moves and optionally copies selected 

points to a different point range  

Edit Data  123  Spreadsheet editor for point data  

Stake Tools      

   Radial  125  Radial stake out of selected points  

   Curve  128  Stake out selected curves  

Station/Offset Report  129  Report station/offset values of selected 

points relative to a specified alignment  

 

 

  

    



  

  

  

   17  

 

    Curves Menu  

Command  Page  Description  

Curve Info  142  Provides information on all selected curves  

Curve Annotation  143  Controls annotation of selected curves.  

Divide  143  Splits selected curves at selected points  

Fillet  143  Generates a “fillet” curve for all adjacent pairs of lines or 

for a selected pair or a line and/or curve.  

PC, Forward Tangent 

and...  

146  Creates a curve given the PC, Forward Tangent direction 

and a third curve parameter  

PC, Chord Bearing, 

and...  

147  Creates a curve given the PC, chord bearing and a third 

parameter  

PC, Center Point & 

(Curve Parameter)  

149  Creates a curve given the PC, Center Point and a curve 

parameter  

PC, Center Point & (PT 

Tangent)  

149  Creates a curve given the PC, Center Point and a point on 

the PT tangent line  

PC, PT Tangent & (PI)  152  Creates a curve given the PC, a point on the PT tangent 

line, and the PI  

PC, PT Tangent & (Center 

point)  

150  Creates a curve given the PC, PT and a center point of the 

curve.  

PC, PT & Curve 

Parameter  

150  Creates a curve given the PC, PT, and a parameter of the 

curve  

PC, PT & point on PC/PT 

tangent  

150  Creates a curve given the PC, PT and a point on either the 

PC or PT tangent line  

PC, PT & Point on Curve  151  Creates a curve given the PC, PT and a point on the curve 

(3 Point Curve)  

POC and Tangent Lines  153  Creates a curve given a point on the curve (POC) and 

tangent lines to the PC and PT  

Best Fit Curve  153  Fit Curve to selected points  

Curve Solver  153  Curve parameter calculator  
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Edit Menu  

Command  Page  Description  

Modify Line Text  115  Options to modify text location, regenerate text values and 

position  

Split Lines  136  Breaks lines at selected points on the line  

Line Extend  136  Extend selected lines to specified object.  

Line Style  117  Sets the line style for selected lines  

Edit Text  142  Edit existing text  

Align Texts  140  Rotate selected texts to given angle  

Set Font     

   Default  53  Changes the font of selected text back to default  

   Other  53  Changes the font of selected text to one of your choice  

Set Color  117  Change the color of selected objects  

Set Layer     

   Default  118  Changes the layer of selected objects back to default  

   Other  118  Changes the layer of selected objects to one of your choice  

Clear Select  110  Resets (clears) the selection list  

Hide Objects  96  Make selected objects invisible  

Unhide Objects  96  Makes selected hidden objects visible  

Extract to Overlay  114  Change the overlay of selected objects  

Edit Overlay  114  Add, delete, modify overlays  

Delete Objects (DEL)  118  Deletes selected objects  

Undo  118  Undoes actions of previous commands  
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  Alignment Menu  

Command  Page  Description  

Create  183  Creates alignments from selected lines/curves.  

Edit  155  Edits selected alignments  

Info  163  Displays info on selected boundaries  

Annotation  163  Controls annotation of selected boundaries  

Inverse  115  Generates inverse reports  

Offset  76  Creates one or more offsets  

Angle Adjust  156  Angle balance an alignment  

Compass Rule  165  Compass Rule adjust an alignment  

Station Lines  156  Create/Edit Station Lines  
 

 

Profiles  158  Create/Edit Profiles  
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  Boundary Menu  

Command  Page  Description  

Create  119  Creates boundaries from selected lines/curves.  

Edit  163  Edits selected boundaries  

Info  163  Displays info on selected boundaries  

Annotation  163  Controls annotation of selected boundaries  

Inverse  115  Generates inverse reports  

Predetermined Area    Functions to “chop off” an area of specified size  

  By Pivot Line  165  By a line that pivots around a point  

  By Sliding Line  166  By a line with fixed direction  

Offset  76  Creates one or more offsets  

Fill Boundary    Sets the fill type of a boundary or layout object  

  
  

  Intersections Menu  

Command  Page  Description  

Bearing/Bearing  173  Creates a point at intersection of two 

user-defined lines  

Bearing/Distance  173  Creates a point at the specified 

intersection of a user-defined line and 

circle  

Distance/Distance  174  Creates a point at the specified 

intersection of two user-defined circles  

Tangent Curve  174  Circle/Tangent line intersection  

Perpendicular Offset  174  Create points and/or finds distances for 

locations perpendicular to a line or curve  
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  Draw Menu  

Command  Page  Description  

Arc  40  Draw an arc  

Leader Line  135  Add a leader line  

Line  42  Draw a line  

Polygon (Polyline)  39  Draw a polygon/polyline  

Text  44  Add text  

Component  217  Insert a component  

 

 

  

View Menu      

Command  Page  Description  

Redraw Screen  38  Refresh the screen  

Full View  38  Zoom to full extents  

Pan View  38  Look for golden objects  

Zoom In  38  Enlarge the view  

Zoom Out  38  Reduce the view  

Zoom Previous  38  Go to previous view  

Visibility  96  Data visibility control  

Add View Area  113  Create a view area  

Delete View Area  113  Exterminate a view area  

Select View Area  113  Go to a saved view area  

Find Point  91  Find a point by number  

Radial Select  110  Use circular selection region  

Layout  204  Drafting and page design  

Survey  62  Field data entry and adjustment  
 

 

DTM  193  Contours, profiles, volumes  

Component  224  Accesses component libraries  
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COGO Function Keys 
  

Miscellaneous Menu    

Command  Page  Description  

Status Window  92  Toggles status bar display  

Select Status  92  Toggles select status bar display  

Tool Window  93  Toggles toolbar display  

Tables  178  Point, line & curve tables  

Grid/Snapping  33  Angle and grid snapping control  

Auto Draw  137  Automatic generation of 

lines/curves and point symbols.  

Triangle Solver  191  Triangle Calculator  

F1   F2   F3    F4  
  F5    F6  Legend  

key only  
Help  Cogo  Layout  Survey   DTM  Component  

Context Help  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

   

  

  

  

  

  

  

  

  

  

SHIFT +  

ALT +  

CTRL +  

CTRL+SHIFT+  

ALT+SHIFT+  

Legend  

key only  

F7  F8  F9  F10  
 F11  F12  

  Redraw  Edit Layers       Save As  

  Full View  Clear Select       Save  SHIFT +  

  Zoom In           ALT +  

  Zoom Out         Open  CTRL +  

  Zoom Previous           Print  CTRL+SHIFT+  

  Pan View           ALT+SHIFT+  
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Component Menus  

  
  

 

  Library Menu  

Command  Page  Description  

New  225  Start a new library.  

Open  225  Open an existing library.  
 

 

Save  225  Save changes.  

Save As  225  Save to a different name.  

Delete Component  225  Delete a component from library.  

  

 

  View Menu  

Command  Page  Description  

Redraw Screen  38  Refresh the screen  

Full View  38  Zoom to full extents  

Pan View  38  Look for golden objects  

Zoom In  38  Enlarge the view  

Zoom Out  38  Reduce the view  

Zoom Previous  38  Go to previous view  

COGO  93  Coordinate Geometry  

Layout  204  Drafting and page design  

Survey  62  Field data entry and adjustment  

DTM  224  Contours, profiles, volumes  
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  Misc Menu  

Command  Page  Description  

Status Window  94  Toggles status bar display  

Info  163  Makes a component info Report  

 

 

    

  

DTM 

Menus 
  

  
 

  Project Menu  

Command  Page  Description  

New  50  Starts a new project  

Open  50  Opens an existing project  

Save  50  Saves current project  

Save As  50  Saves current project with new name  

Print  104  Print the sheet(s)  

Exit  53  Exits program  
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  Edit Menu  

Command  Page  Description  

Line Style  117  Sets the line style for selected lines  

Set Font    

Default  53  Changes the font of a selected text to 

default  

Other  53  Changes the font of selected text to a font 

of your choice  

Set Color  117  Change the color of selected objects  

Set Layer    

Default  118  Changes the layer of selected objects back 

to default  

Other  118  Changes the layer of selected objects to a 

layer of your choice  

Delete <DEL>  118  Deletes selected objects  

Cross Sections  193  Cross Section Editing  
 

 

    

  TIN Menu  

Command  Page  Description  

Insert Points  195  Insert selected points into the TIN  

Insert Segment  195  Insert a TIN edge  

Triangle Swap  195  Swap the common leg of adjacent triangles  

Insert Breakline  190  Define a breakline  

Auto Breaklines  197  Create breaklines from point descriptions  

Alignment 

Breaklines  

197  Translates COGO alignments into breaklines  

 

 

Triangulate  198  Create a TIN  

Info  198  Display TIN information  

Volumetrics  200  Calculate volume between surfaces  
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  Contours Menu  

Command  Page  Description  

Generate  199  Create contours  

Settings  199  Set contour intervals, labeling, etc.  

Add Labels  199  Add elevation texts  

Smoothing  199  Alter smoothing factor on selected 

contour segments  

 

 

  

 
 

  Volumetrics Menu  

Command  Page  Description  

TIN Subtraction  199  Create contours  

Average End Area  199  Alter smoothing factor on selected contour segments  
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  View Menu  

Command  Page  Description  

Redraw Screen  38  Refresh the screen  

Full View  38  Zoom to full extents  

Pan View  38  Look for golden objects  

Zoom In  38  Enlarge the view  

Zoom Out  38  Reduce the view  

Zoom Previous  38  Go to previous view  

Visibility  82  Data visibility control  

COGO  93  Coordinate Geometry  

Survey  62  Field data entry and adjustment  

Layout  204  Drafting and page design  

Component  224  Accesses component libraries  

 

 

 

 

 

 

 

 

 

  

Miscellaneous Menu    

Command   Page  Description  

Status Window   92  Toggles status window display  

Select Status   92  Toggles select status display  

Tool Window   93  Toggles toolbar display  

 

 

  

  



  
  
  
  

  
  

   28  

Layout Menus  
  

  

 

  Project Menu  

Command  Page  Description  

New  50  Starts a new project  

Open  50  Opens an existing project  

Save  50  Saves current project  

Save As  50  Saves current project with new name  

Page Layout  103  Sets sheet size, margins and border.  

Print  104  Print the sheet(s)  

Read Form  207  Import a page Form  

Write Form  207  Save a page Form  

Import DXF  36  Import DXF file.  

Export DXF  108  Export to a DXF files.  

Exit  53  Exits program  
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  Data Menu  

Command  Page  Description  

Place Full View  207  Places view of EVERYTHING from 

COGO on the layout sheet  

Place Screen View  207  Places just the view as seen in the  

COGO window  

Place View Area  207  Places a specified view area  

Set Scale  209  Sets/modifies the scale of a selected data 

view  

Create Scale  

Component  

208  Creates a scale component for a selected 

data view  

Edit Scale 

Component  

208  Edits the font and other display 

characteristics of a selected scale  

component  

Place North Arrow  209  Associates a North Arrow to a selected 

data view  

Dataview Visibility  210  Controls visibility of various object 

types.  
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  Edit Menu  

Command  Page  Description  

Group  215  Create a group from selected objects.  

Ungroup  215  Ungroup a group.  

Rotate  222  Rotate mode.  

Delete  216  Delete selected objects.  

Undo  118  Undo last action.  

Redo    Undo last undo  

Default Font  212  Select font used for new text creation.  

Edit Text  211  Edit selected text.  

Set Fill  218  Select the fill pattern (hatch) to use when 

filling objects.  

Set Layer  118  Changes the layer of selected objects  

Set Color  117  Changes the color of selected objects  

Line Style  117  Sets the line style for selected objects  

  
  

  
  

  

Set Font  212  Change the font of selected text.  
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  Draw Menu  

Command  Page  Description  

Arc  40  Arc drawing mode  

Bitmap    Insert a bitmap  

Block Text  212  Enter paragraph text  

Box  211  Box drawing mode  

Circle (2 Point)  41  Circle drawing -center and point on 

circle  

Circle (3 Point)  42  Circle drawing - 3 points on circle  

Cross Section    Insert a cross section  

Ellipse  42  Ellipse drawing mode  

Line  42  Line drawing mode  

Polygon  39  Polygons and polylines  

Profile    Insert a profile  

Splines  136  Bezier curves  

Tables  214  Place tables created in COGO  

Text  211  Text entry mode  

Straight Dimension  43  Straight lines with arrowheads  

Curved Dimension  43  Curved lines with arrowheads  
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  Components Menu  

Command  Page  Description  

Create  216  Create a component from selected objects.  

Delete  216  Delete components by name.  

Place  216  Place components by name.  

Smash  216  Replace selected components with their 

primitive graphic pieces.  

Update  216  Update components by name.  

Get  217  Get a component by name from a library. 

(can also be done visually from the 

component sheet).  

Put  217  Place a created component in a library.  
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  View Menu  

Command  Page  Description  

Redraw Screen  38  Refresh the screen  

Full View  38  Zoom to full extents  

Pan View  38  Look for golden objects  

Zoom In  38  Enlarge the view  

Zoom Out  38  Reduce the view  

Zoom Previous  38  Go to previous view  

Visibility  82  Data visibility control  

Background Color    Sets screen color  

Cogo View  217    

Monochrome    Toggles color vs. black and white display  

Grid/Snapping  33  Snapping control  

COGO  93  Coordinate Geometry  

Survey  62  Field data entry and adjustment  

Component  224  Accesses component libraries  

 

 

 

Miscellaneous Menu    

Command  Page  Description  

Select Status  92  Toggles select status bar display  

Tools  93  Toggles tool bar display  
 

 

Ruler  93  Toggles ruler display  
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Survey Menus  
  

 

  Project Menu  

Command  Page  Description  

New  50  Starts a new project  

Open  50  Opens an existing project  

Save  50  Saves current project  

Save As  50  Saves current project with new name  

Close  50  Closes the current project  

Import Raw  64  Import raw data  

Import Points  65  Import ASCII point data  

Print  66  Prints the screen  

Exit  53  Exits program  
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  Survey Menu  

Command  Page  Description  

Enter Shot  69  Shot entry dialog  

Occupy/Back Sight  189  Sets station and/or backsight  

Inverse  81    

Create Loops  82    

Loop Adjust  78  Traverse Loop Adjustment  

Loop Report  83    

Error Search  78  Linear & Angular Error Search  

Least Squares Adjust  78  Least Squares network adjust  

Unadjust Least Squares  80  Remove Least Squares adjustment  

Options  63    

 

 

    
 

  Edit Menu  

Command  Page  Description  

Fieldbook Editor  71  Spreadsheet-style editor  

Generate COGO  

Points  

81  Transfer point data to COGO  

COGO Filter  81  Select data to transfer to COGO  

Next Number  190  Sets the next to use; overwrite control  

Delete Objects  81  Deletes selected objects  

Save to Overlay  82  Moves selected data to specified overlay  

Modify Line Text  115    

Set Font  29  Change displayed font  
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  Mapcheck Menu  

Command  Page  Description  

Create  84  Create a mapcheck  

To Cogo  86  Transfer mapcheck to COGO  

Edit  85  Edit mapcheck  

Report  86  Generate mapcheck report  

Append  86  Append to existing mapcheck  

 

 

  

 

  GPS Menu  

Command  Page  Description  

Load GPS Files  87  Load GPS receiver files  

Add Control Point(s)  88  Add GPS control point  

Process This Session  88  Process GPS baselines  

Geoid Calculator  90  Find geoid separation at location  
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  View Menu  

Command  Page  Description  

Redraw Screen  38  Redraws the screen  

Full View  38  Zooms to include all the data  

Pan View  38  Changes the center of the view  

Zoom In  38  Magnifies the view  

Zoom Out  38  Reduces the view magnification  

Zoom Previous  38  Return to the previous magnification 

and center  

Visibility  82  Data visibility control  

Find Point  91  Zoom in on a specified point  

COGO  93  Coordinate Geometry  

Layout  204  Drafting and page design  

Component  224  Accesses component libraries  

Survey  62  Field data entry and adjustment  

DTM  193  Contours, profiles, volumes  
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General Concepts  
This section talks about things that are used frequently in the program. Authorization, layers, point 

descriptions, fonts, formula input, importing and exporting of data, the Line Define dialog and 

popup menus are explained.  

Authorization  
Due to blatant attempts to “pirate” the program, we have been forced to add a copy protection 

scheme to the program. When unauthorized, the program will function in a “demonstration mode”. 

In this mode, the program will not print, export data or save projects. All functions except those 

just mentioned will operate normally. Consequently, it is permissible to copy the installation 

diskettes for a friend who has an interest in seeing how the program functions.  

When enabled, or “authorized”, the COGO and Layout sections of the program become fully 

functional. The copy protection does NOT use a hardware lock (dongle) or key diskette. Once 

authorized, the protection scheme is transparent to the surveyor. The DTM and Survey portions of 

the program can be individually enabled allowing us to issue a program that is just COGO and 

Layout (drafting) or COGO, Layout and DTM, etc.  

To authorize your program, it is necessary to send us the wampum and then call to get an 

authorization number (see p.52).  

Program Files  
This section will describe the various files that are created and/or used by the program. They are:  

Miscellaneous Files  
Executable and dynamic link files – these are the actual program and include any file in the 

program directory that ends with .EXE or .DLL. Deleting any of these files will prevent the 

program from working!  

Configuration and settings files - these store information about your personal settings such as 

background color, ASCII formats, precision display, etc. Most of the this information is in the 

PCS.INI file. The settings for the Legal Writer are contained in the LEGAL.INI file. If these files 

are deleted or lost, the program will automatically recreate them with the default settings.  

Component Library files - these files end with .GLB and are used to store created components..  

Form files - these files end with .PTP and contain Layout Forms (see p. 207 for more 

information).  
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Undo files - files ending with .$$$. These files are created and normally deleted while the program 

is running. If the program terminates abnormally, an undo file may be left behind. When the 

program is not running, these files are totally unnecessary and can be safely deleted.  

Help file - this file ends with .HLP and contains the online help information.  

Icon file - this file ends with .ICO and is the little picture that is displayed if you created a 

shortcut.  

Project Files  
When using PCS, files containing project information are not created or saved until the user issues 

a Save or Save As command, or until the Auto Backup occurs. How this whole system works is 

described below.  

PCS files - Every project has associated with it a single project file that contains ALL the 

information for that project. This is a file ending with .PCS. To backup a project, then, only 

requires copying the associated .PCS file to a floppy or other backup media.  

.BAK files - These files contain a copy of the .PCS file and are created when an existed project is 

opened.  

.ABK files - These files contain a copy of the project as of the last time an Auto Backup was 

performed.  

 

Example: Let’s suppose that you have opened PCS and have started to create a drawing. The top 

of the window displays the name of the project – at this point it would be (Untitled). If the 

program runs for longer than the Auto Backup interval, which defaults to 10 minutes (you can 

change this in the Options dialog - see p.56), a message will flash on your screen notifying you 

that an Auto Backup is being performed.  

At this point, a file is created on your computer named UNTITLED.ABK. It is a project file that 

contains all your work to this point.  

If, at any point, you execute the Save or Save As command, the project name will change. Let’s 

assume that you have saved your project as “Junk”. The top of your window will now show 

“Junk.PCS”, to remind you of your current project name. Subsequent Auto Backups will create a 

file named “Junk.ABK”.  

Now suppose that you exit PCS and then restart the program and open “Junk”. At this point 

another file will be created named “Junk.BAK”. This is the backup file and is simply a copy of 

your .PCS file.  

The reason that all of this is done is to try to protect you from the possibility of a “crash”. A 

“crash” occurs when the program terminates abnormally. This can occur as a result of a power 

failure, hardware failure or software failure. If you have used Microsoft Windows for any length 

of time, you may have noticed that many programs will periodically shut down with messages 

talking about “General Protection Fault” or such.  

This is common within the Microsoft Windows environment due to the complexity and nature of 

the system.  

If a “crash” occurs, you can do the following:  
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1.  Restart the computer (if necessary). If a software crash 

occurred, you might have to restart Windows.  

2.  Open PC Survey.  

3.  Find the file with the name of your project but with the 

extension .ABK and open this file. All of your work within 

the Auto Backup Interval (or less) should be there. If this file 

is bad (which can happen, for instance, if your computer 

crashes during the Auto Backup, open the .BAK file instead.  
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Layers  
A layer is a set of attributes associated with certain objects. When an object, such as a point, line 

or text, is created in the program, it is initially assigned to a layer associated with the type of 

object being created. Points will initially be placed on the Point Layer, texts on the Text Layer, etc.  

A layer defines the default color, line style, and font for an object.  

The layer definitions can be viewed and modified through the Edit Layers command in the 

Environment menu (see p.54). Any of the default values can be overridden. This means that you 

can change the line style, color and/or font (if the object is a text) of any object after it is created. 

An object’s layer can also be modified.  

The program also supports Layer Sets. A layer set is the definition of all defined layers. What this 

means is that any set of layer definitions can be saved, making it possible to switch between 

different sets of layer definitions. This also means that the surveyor can define the initial 

appearance of any object that is created and save those definitions as a layer set.  

The layers that are initially defined when the program is installed are a minimum set, with one 

layer defined for each object type. A layer does not have to be associated with an object (Point, 

Line, Text, etc.). The surveyor can modify existing layers, but he can also add and delete layers. 

Up to 256 layers can be defined.  

Point Descriptions  
Points can have a description of up to 15 characters. Therefore, functions that create or modify 

points often have an edit box for inserting a new description or editing an existing one. The edit 

box is actually a dropdown list which can be activated by clicking on the down arrow to the right 

of the box. A list will then be shown containing all predefined descriptions. Predefined 

descriptions are stored in the file  

    
Description edit box  

DESCODES.DAT in the program’s directory. DESCODES.DAT is a simple  

text file. Each line in the file is a  

predefined description. See Appendix A  

for more information on  

DESCODES.DAT.  
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Enabling and disabling  
If the surveyor doesn’t wish 

to enter descriptions for 

points that are being 

created, the Descriptions-

Enable option in the 

Environment - Options 

dialog should be turned off. 

This will disable description 

entry. Dialog with a 

Description edit box  

 
 

 

 

 

 

 

 

 

 

 

Entering and deleting pre-defined descriptions  
New descriptions can be added to the descriptions file (DESCODES.DAT) by typing a name into 

the edit box and pressing the Ins or Insert key. Similarly, currently pre-defined descriptions can 

be deleted by selecting the description from the list (or typing it into the edit box) and pressing the 

Del or Delete key. The program will guard against duplicate descriptions being created in the 

description file.  
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Fonts  

  
 

The Set Font function that exists in many of the windows is used to select the font (including 

typeface, size, and style) for texts. The Font section selects the face name or type of font. Bold or 

italic characteristics are set in the Font Style section while underline or strikeout characteristics 

are set in the Effects section.  

The Size of the font is the height in inches, millimeters or points, depending on what units are 

chosen in the Environment-Options - Units dialog (see p.59). A drop down list is used for 

displaying point size while an edit box with spin buttons is used for inches or millimeters entry (as 

shown above). There are 72 points per inch so  

Example: 9 points = 0.125" = 0.125×25.4 mm = 3.175mm.  

The program does not currently use the Color selection.  

Layer Fonts  
Edit Layers in the Main Window’s Environment menu allows setting layer fonts. In the Modify 

dialog box, the Font button is used to set the default font associated with the layer. Any text items 

created on that layer will use that font unless you specify otherwise.  

Angle Entry  
Some dialog edit boxes are specially designed to handle angle entry. For instance, the Triangle 

Solver (p.191) has three angle entry boxes (Angles a, b and c). Angle edit boxes have special 

features. For one, they will accept angle formulas. Another feature is the ability to “pop up” a 

turned angle calculator. A third feature of angle edit boxes is that the angle of an existing line on 

the screen or the tangent angle of an existing curve can be entered by clicking near that line or 

curve. These features are explained below.  
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Angle Formulas  
Angle entry edit boxes can evaluate formulas (as well as constant values) with standard arithmetic 

operators +, -, *, /, and ^ for addition, subtraction, multiplication, division, and exponentiation 

respectively. A special operator, >, is also recognized which means the angle from one point to 

another point. For example, 5>6 means the angle from point 5 to point 6. Formulas are evaluated 

in a strict left to right order. So, the equation  

5>6/2+90  

means take the angle from 5 to 6 which is, say, 30 degrees. Divide by 2 to get 15 and then add 90 

to get 105 degrees. To check the value of a formula, type an =. The display of the formula will be 

replaced with the value of the formula. To return to a display of the formula, type = again.  

Entering angles from existing lines  
As an example of how this feature operates, given a line from point 1 to point 2 on the screen 

where the angle from point 1 to point 2 is N 45° E, the following applies:  

• Left-clicking near point 1 will insert the formula 2>1 (will be interpreted as S 45° W).  

• Left-clicking near point 2 will insert the formula 1>2 (will be interpreted as N 45° E).  

When selecting a line from the screen with the left button, remember that the line nearest the 

mouse cursor (in terms of perpendicular distance) will be used.  

Entering angles from existing curves  
The tangent angles of existing curves can also be selected from the screen as values for angle entry 

boxes.  

As an example of how this feature operates, given a curve from point 1 to point 2, the following 

applies:  

• Left-clicking near point 1 will insert the tangent azimuth angle at point 1.  

• Left-clicking near point 2 will insert the tangent azimuth angle at point 2.  

When selecting a curve from the screen with the left button, remember that the curve nearest the 

mouse cursor (in terms of perpendicular distance) will be used.  
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Turned Angle Calculator  
The turned angle calculator is accessed by 

pressing the C key on the keyboard when in a 

blank angle edit box. The dialog shown will be 

displayed. To use this dialog, do the following:  

Enter the backsight angle into the BS Angle box 

and the foresight angle into the FS Angle edit 

box by any of the methods described above.  

Select the desired calculation from the list of 

options on the right of the dialog (if different 

from the current selection) and select OK to enter the calculated value or Cancel to abort the 

calculation and return to the original angle edit box.    

Distance Entry  
Similar to angle edit boxes, some dialog edit boxes are specially designed to handle distance entry. 

For instance, the Triangle Solver (p.191) has three distance entry boxes (Sides A, B and C). 

Distance edit boxes also have special features. For one, they will accept distance formulas. 

Another feature of distance edit boxes is that the length of an existing line on the screen can be 

entered by clicking near that line. These features are explained below.  

Distance Formulas  
Distance edit boxes can evaluate formulas with standard arithmetic operators +, -, *, /, and ^ for 

addition, subtraction, multiplication, division, and exponentation respectively. A special operator, 

:, is also recognized which means the distance from one point to another point. For example, 5:6 

means the distance from point 5 to point 6. Formulas are evaluated in a strict left to right order. So 

the equation  

5:6*3+80  

means take the distance from 5 to 6 which is, say, 50 feet. Multiply by 3 to get 150 and then add 

80 to get 230 feet. To check the value of a formula, type an =. The display of the formula will be 

replaced with the value of the formula. To return to a display of the formula, type = again.  

Units  
Normally, the system of units used when entering distances is whatever has been selected in the  

Environment-Options-Units dialog (see p.56), which include metric, US Foot and US Intl. There 

is a way to override the system when entering distances by adding one or more characters at the 

end of the value.  

Example: entering 10C into a distance edit box will evaluate to 10 chains or 660 feet.  

The following table lists the various unit overrides that can be applied.  

Turned Angle Calculator  
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Units  Designator  Example  Conversion Factor  

Chains  C or c  123.4C or 123.4c  1 Chain = 66 Ft.  

Links  L or l  123.4L or 123.4l  1 Link = .66 Ft.  

Perches  P or p  123.4P or 123.4p  1 Perch = 16.5 Ft.  

Rods  R or r  123.4R or 123.4r  1 Rod = 16.5 Ft.  

Vara  V or v  123.4V or 123.4v  1 Vara = .84 meters  

  

Entering distances from existing lines  
As an example of how this feature operates, given a line from point 1 to point 2 on the screen 

where the distance from point 1 to point 2 is 200.00, the following applies:  

  • Left-clicking near point 1 will insert the formula 1:2 (will be interpreted as 200.00).  

When selecting a line from the screen with the left button, remember that the nearest line to the 

mouse (in terms of perpendicular distance) will be used.  

Line Define Dialog  
In many of the program functions, the 

Line Define dialog, or one of its 

derivatives will be encountered. A line 

can be determined by one of five 

methods. In each case a Point on Line is 

given that the line to be defined, 

BEFORE adding in the Offset, will pass 

through. Each method therefore 

determines the direction of the line that passes through the point specified in  

Point on Line, before adding in the offset. These five methods for Example of a Line Define 

Dialog specifying direction are:  

⇒ Select Second Point - The direction from the Point on Line to a second point  

⇒ Select Two Points - The direction from a point (other than Point on Line) to another point  

⇒ Select Line - The direction of an existing line (which is really just the same case as above except 

that it can be selected with a single click).  
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⇒ Azimuth - The direction as specified by an azimuth  

⇒ Bearing - The direction as specified by a bearing  

An additional parameter, Offset, can be used to offset the line, along a perpendicular to the line, 

some specified distance. The following apply:  

• Angle formulas can be used for azimuth and bearing entry. Distance formulas can be used when 

specifying the offset. (see p.30)  

• Specifying a point or line can be done by either typing in the appropriate values or selecting the 

point or line from the screen. When specifying direction by defining a line, the syntax is Point # > 

Point #.  

• When selecting an existing line from the screen (with Select Line selected and the focus in the 

Line edit box), left-clicking near the tail or end of the line will get the direction of the line. Left 

clicking near the head or start of the line will get the direction of the line plus 180°.  

Example: A line exists between points 1 and 2 and has an azimuth angle of 45° 13’. It is desired to 

define a line perpendicular to this line and passing through point 3. Therefore, 3 is entered into 

the Point on Line edit box. Select Line is chosen and the focus moves to the Line edit box. Left-

clicking near point 1 will place 2>1 (equal to 225° 13’) in the edit box, whereas leftclicking near 

point 2 will place 1>2 (equal to 45°13’) in the edit box. Moving the cursor to the end of the line 

and add +90 (i.e. 1>2+90) will define the desired line.  

Angle/Grid/Object Snapping  
The program has several snapping 

modes that allow the surveyor to 

place  points  and 

line/curve/box/polygon endpoints 

precisely relative  to existing objects, 

a defined grid or specified 

direction(s). Snapping control is 

available in both the COGO and 

Layout  windows.   

 Snapping control is invoked 

by selected Grid/Snapping from the 

Misc menu. A dialog box similar to 

the one shown will appear. The 

operation of this dialog is fairly 

complex.  

Absolute Snap Mode applies when a left-click is performed  

when  

  

• Creating points  

• Specifying the first endpoint point of a line/curve/box/polyline  

• Specifying the last endpoint of a line/curve/box/polyline IF Relative Snap Mode is None. The 

various absolute snapping modes include:  
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1) None - no snapping.  

2) Grid - snap to nearest grid point.  

3) Nearest - snap to nearest selectable object.  

4) Endpoint - snap to endpoint of nearest selectable object.  

5) Midpoint - snap to midpoint of nearest selectable object.  

6) Center - snap to the nearest center of selectable curves.  

7) Quadrant - snap to nearest quadrant point of selectable curves. 8) Intersection - snap to nearest 

intersection of two objects.  

  

When using any of the snap modes, except Grid, the following notes apply:  

• The program will use the Click cycle range (see p.56) to determine how far “away” to look for an 

object to snap to.  

• Only selectable objects will be candidates for snapping. This allows the surveyor to snap to the 

nearest arc by turning off the selectability of all objects except arcs, for instance.  

• If no object is found within the Click Cycle Range, the current cursor position will be used. The 

Relative Snap Mode applies when a left click is performed AFTER specifying the first point of a 

line/curve/box/polygon and the snap mode is not None. The relative snapping modes are:  

1) None - no relative snapping. If absolute snapping is enabled, all snaps will behave as absolute 

snaps.  

2) Angle - the Angle Increment and Ref Angle settings are used to snap the cursor to a line that 

passes through the previous point and has an angle that is a multiple of the Angle Increment value 

plus the Ref Angle value.  

3) Perpendicular - this mode applies only to lines when snapping to arcs and circles. When clicking 

near an arc or circle in creating the a subsequent line endpoint, the program will attempt to snap to 

the point  

on the arc/circle such that the line is perpendicular to the arc/circle (line lies along a radius line of 

the arc/circle).  

4) Tangent - this mode also applies only to lines when snapping to arcs and circles. When clicking 

near an arc or circle in creating the subsequent line endpoint, the program will attempt to snap to 

the point on the arc/circle such that the line is tangent to the arc/circle.  

  

Grid Origin specifies the “starting” location for the grid (if used). The grid origin defaults to the 

coordinate system origin.  

Grid Spacing specifies the spacing between grid points in the X/Easting direction and Y/Northing 

direction.  

Sector Increment is used when the snapping mode is Sector. With the default of 90° and a 0° Ref 

Angle, Sector snapping mode will attempt to snap selected locations to the top, bottom, left or 

rightmost sides of an arc or circle (similar to quadrant snapping in other CAD packages).  

Example: Setting the Sector Increment to 45° and Ref Angle to 0° will allow snapping to the top, 

bottom, left, right and northeast, northwest, southeast and southwest points on an arc or circle.  
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The Angle Increment value is used when the Angle snap mode is invoked in Relative Snap Mode 

and the surveyor has already specified the first point of a line. Subsequent points will snap to lie 

along lines through the previous point that are at integer multiples of the Angle Increment value 

PLUS the Ref Angle value.  

Example: Setting the Angle Increment to 15° and the Ref Angle value to 10° will result in 

snapping of points to values of 10°, 25°, 40°, 55°, 70°, etc. relative to the previous point.  

  

Popup Menus  
A popup menu is a menu that can appear anywhere on the screen. The program uses popup menus 

to provide specialized functions for data objects. The standard Windows convention for accessing 

popups is a rightclick of the mouse. In the program, we’ve modified that a bit. Instead of right-

clicking for popups, we use a Shiftright-click sequence. That is:  

1) Hold down the <Shift> key on the keyboard.  

2) Depress and hold the right mouse button.  

3) If a popup is available, it will appear at this point. With the right mouse button still depressed, 

drag to the menu item that is desired.  

  

Importing & Exporting Data  
There are several ways to move information (data) into and out of the program. The three kinds of 

data formats that the program supports are:  

1) ASCII point files - An ASCII point file is a text file where the various point values (number, 

northing easting, elevation, description) are separated by commas or spaces. Each point’s 

information is placed on a separate line of the text file. The ASCII format of point files is user-

definable, so just about any conceivable format is possible. The program comes with several 

formats predefined.  

Point files can be imported into either the Survey or COGO portions of the program. COGO can 

export existing points or points as stakeout values from its stakeout routines.  

2) ASCII raw data files - These are also text files, but the information contained therein is much 

more complex. The types of raw data files currently supported include SMI, SDR (Sokkia/Lietz) 

and TDS.  

Raw data files can only be imported into the Survey portion of the program.  

3) DXF files - Version 12 DXF import and export is mostly supported. However, since AutoCAD 

fonts have no direct mapping into Windows fonts, there may be some differences in the 

appearance of text or special symbols. See the section below on DXF Import and Export for 

more information.  
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4) DWG file - Version 12 (R12) of DWG is currently supported. Support for R13 can be added if 

and when it becomes important to our customers.  

(DWG and DGN will be added in the future - the more phone calls we receive that request these 

features, the higher the priority)  

DXF/DWG Import and Export  
In order to communicate with other CAD packages, the program supports importing and exporting 

DXF files. This importing and exporting can be done in either the COGO window or the Layout 

window.  

Export DXF/DWG  
Exporting DXF or DWG data will write out the data in R12 format.  

Information about relationships between different objects will be lost in this process; for example, 

bearing texts will no longer know which line they belong to.  

Cogo data is all cogo data, contour lines, and layout data that has been placed in the cogo window. 

Page data is everything that is shown on a layout sheet and is exported in page coordinates.  

   1. The interface for all of these options are very similar.  

• To export all cogo data to a DWG file:  

In the Cogo window, select Project | Export | DWG | All  

• To export selected cogo data to a DWG file:  

In the Cogo window, select Project | Export | DWG | Selected  

• To export all cogo data to a DXF file:  

In the Cogo window, select Project | Export | DXF | All  

• To export selected cogo data to a DXF file:  

In the Cogo window, select Project | Export | DXF | Selected  

• To export page data to a DWG file:  

In the Layout window, select Project | Export DWG  

• To export page data to a DXF file:  

In the Layout window, select Project | Export DXF  

1. Select the folder to use and the name to use for the exported file and click on the Save button.  

2. Set the dialog options and then click OK:  

• 2D only : do not export any elevation data  

• Smooth Contours : write out contour lines as detailed polylines. This will may make the output 

file much larger.  
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• Write Tin Faces : export the faces of the tin surface(s)  

   3. In the DXF-DWG Font Line 

Mapping dialog, set the information necessary to map lines and fonts.  

• Style Name : You can define multiple styles in which case this name is used to select which style 

or set of mappings to use.  

• Font Mapping : Each Windows font used in the incoming file will be displayed on each line and a 

corresponding ACAD font can be selected for each.  

• Line Mapping : Each PCS line style used in the incoming file will be displayed on each line and a 

corresponding ACAD line type can be selected for each.  

• Add : Add another line to the list above the button.  

• Delete : Delete the current line from the list above the button.  

• Save : Write this set of mappings out to the .ini file so that it can be used at a later time.  

• Close : exit the dialog.  

Import DXF/DWG  
Importing DXF or DWG data will create data using the information available in the DXF or DWG 

file.  

Blocks in the file will become components in the program. Other than that, there is no information 

in the DXF/DWG file about relationships between different objects so any relationship 

information that you need must be created after the file is imported.  

   1. The interface for all of these options are very similar.  

• To import data from a DWG file in Cogo coordinates:  

In the Cogo window, select Project | Import | DWG  

• To import data from a DXF file in Cogo coordinates:  

In the Cogo window, select Project |Import | DXF  

• To import data from a DWG file onto the layout page:  

In the Layout window, select Project | Import DWG  

• To import data from a DXF file onto the layout page:  

In the Layout window, select Project | Import DXF  

1. Select the folder to use and the name to use for the exported file and click on the Open button.  

2. Set the dialog options and then click OK:  

• Create endpoints : (available in cogo) : will create a point at the ends of each line and each curve 

and will place points at each vertex of polygons and polylines. With this option off, lines and 

curves are drafting objects. With this option on, lines and curves are cogo objects.  

• Select Encapsulate (available in layout) if you want to create a single component containing all of 

the data. This is particularly desirable if you want to be able to move the data as a single unit (as in 

when importing contour data from a photogrammetry company).  
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• Use Cogo Scale : use the current cogo scale for translating the incoming data coordinates. In 

Cogo, the standard option is to no perform any translation at all so select  

• 1 in = : the data in the input file is in inches and will need to be translated to feet or meters in 

Cogo.  

• 1’ or 1 m. = the data in the input file is in feet or meters and will need to be translated to inches in 

Layout.  

If importing from the layout window when the Layout window 

is in Cogo view, the DXF information will be left in world 

coordinates. If the Layout window is in page view when 

importing the DXF data, the data will be translated to page 

coordinates and so things get a bit more complicated. In 

order to translate the DXF information to page coordinates, 

a scaling factor is necessary.  

1. In the DXF-DWG Font Line Mapping dialog, set the 

information necessary to map lines and fonts.  

• Style Name : You can define multiple styles in which case this name is used to select which style 

or set of mappings to use.  

• Font Mapping : Each ACAD font used in the incoming file will be displayed on each line and a 

corresponding Windows font can be selected for each.  

• Line Mapping : Each ACAD line type used in the incoming file will be displayed on each line and 

a corresponding PCS line style can be selected for each.  

• Add : Add another line to the list above the button.  

• Delete : Delete the current line from the list above the button.  

• Save : Write this set of mappings out to the .ini file so that it can be used at a later time.  

• Close : exit the dialog.  

2. In Layout, the program will next pop up a special cursor to show that you need to place the data on 

the page. Click the cross-hairs part of the cursor where you want the upper left corner of the data 

to be placed. The data will be translated to the page coordinates and placed on the page.   
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Data Views and Common View 

Functions  
Data View refers to that portion of the window in which the graphical data is displayed. For 

example, COGO view refers to the portion of the data that is visible in the COGO data window. 

The following discussion on redrawing, panning and zooming applies to all the dataviews within 

the program.  

Setting the view is done by drawing a zoom box by clicking and dragging with the right mouse 

button. To zoom in or magnify the view, draw the box from left to right. The area of the drawing 

enclosed by the box you draw will be magnified to fill the view, maintaining the correct 

perspective.  

Zooming out is done in a similar manner to zooming in except that the box is drawn from right to 

left, rather than left to right. The data currently being drawn on the screen will be shrunk to fit in a 

box that size centered on the screen. Again, the perspective will be maintained.  

Panning is accomplished by double-clicking the right mouse button with the cursor at the location 

that the surveyor wants to center the screen view around. Therefore, right double-clicking at a 

location on the right side of the screen will “slide” the view to the left.  

There are several view functions that are used in most of the program’s windows. These functions 

are explained below.  

Redraw Screen (F8)  
This function refreshes or redraws the screen. When performing various operations in the window, 

the appearance can be “mangled” in various ways. Redrawing the screen will “clean up” any such 

problems.  

Full View (Shift+F8)  
Full View is a zoom function - it zooms the view out such that all data is included in the view.  

Pan View (Alt+Shift+F8)  
Pan View will center the screen around a selected point. When this command is selected, a the 

cursor will change to a “C” with a cross to indicate the point to use as a center. Left-click at the 

desired center point.  

Zoom In (Alt+Shift+F8)  
Zoom In will double the magnification of the view - the center of the view remains the same.  
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Zoom Out (Ctrl+F8)  
Zoom Out is similar to the Zoom In function except the magnification is halved.  

Zoom Previous (Ctrl+Shift+F8)  
Zoom Previous restores the previous magnification and zoom.  

General Drawing Functions  
The program allows the surveyor to create basic drawing objects like polyline/polygons, boxes, 

arcs, texts, etc. The functions for creating these objects are not restricted to just one window, so 

they will be explained in this section. Most of these objects can be created in either a freehand (by 

left-clicking in the data window) or precisely (by entering parameters into an edit box).  

Polyline/Polygon  
The Polyline or Polygon function can be accessed through either the menus or the toolbar. This 

function can be used to create either polylines or polygons. A polyline is a series of connected 

(end-to-end) line segments.  

 Toolbar  When a polyline’s first and last 

endpoint coincide, it becomes a closed figure called a polygon. When  

Button  selecting the Polyline function, the following set of edit boxes will appear at the top of the 

window, replacing the select status bar (if it exists).  

This function includes the ability to draw orthogonal lines by using special characters when 

entering the lengths of a leg/side (in the L edit box). See the notes below for more information.  

To use this function, do the following:  

Select the Polyline function from the Draw menu or the toolbar (the button shown above to the 

right of the Polyline title).  

1) The cursor will change to a set of crosshairs and a set of edit boxes similar to the one displayed 

above will appear below the menu bar at the top of the screen.  

Initially, only the two boxes labeled From will be active. The first box is the northing or vertical 

coordinates while the second is the easting or horizontal coordinates. Notice as the cursor is 

moved, these boxes essentially behave like an x-y readout.  

2) Either left-click at the desired beginning location on the screen OR enter the desired coordinates 

into the From edit boxes by left-clicking in the edit boxes and typing in a value. Use either the 

<TAB> key or <ENTER> key to exit the edit box and save the entry.  

A rubber-banding line will now be displayed with one end fixed at the From location.  

3) To specify the endpoint of this segment, any of the following actions can be taken:  

Left-click in the data window to freehand the ending point. 
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OR  

Enter parameters into two of the four remaining edit boxes at the top of the screen. The first two of 

these boxes the To horizontal and vertical location. The A box is the segment’s angle and the L 

box is the segment’s length.  

OR  

Enter one of four remaining parameters, press the <TAB> or <ENTER> key to enter the value and 

left-click in the data window to get the last parameter.  

There are several buttons on the right side of the Polyline entry bar. There functions are the 

following:  

Backup - remove the previously entered leg/side and allow re-entering of its data.  

Remove - remove the current polyline and start over.  

Close - create a polygon by inserting a leg from the current point to the first point entered.  

Finish - create a polyline from all the entered legs/sides and get ready to enter another polyline.  

Xit - save the existing legs/sides as a polyline and exit the Polyline function.  

Notes:  

• An orthogonal drawing mode exists that will aid in drawing objects such as building outlines. This 

mode is accessed by entering length values into the L edit box preceded by a +, - or = character. 

The +/- character before a distance value will cause the entered leg/side to be drawn with a 

right/left angle of 90° to the previous leg/side. An = character preceding the distance value will 

result in the entered leg/side being drawn in the same direction as the previous leg/side.  

• The <ESC> key will abort the Polyline function without saving the currently entered leg/side 

data.  

• Like the other drawing functions, this function will work in conjunction with the Grid/Snapping 

modes.  

• After a polyline/polygon has been created, selecting the object will result in the display of nibs at 

the vertices which can be moved through a left-click and drag operation.  

Arc  
To create a curve, use Arc in the Draw menu. In this function, the cursor will become a C-cross 

cursor.  

1) Move the cursor to one end of the arc and left-click the left button. A “rubberband” line will 

appear, attached to the clicked location. This line represents the chord of the arc that is being 

created and will move with the cursor.  

2) Move the cursor to the other end of the arc and click the cursor again. A “rubberband” arc will 

now appear that will stretch with the movement of the cursor. The created arc will be counter-

clockwise from the first point to the second point.  

3) As you move the cursor, the center point of the arc will move along an assumed line perpendicular 

to chord’s perpendicular bisector. When you have the desired amount of curvature, click the left 

button again and the arc will be created.  
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(I know that the last explanation is cryptic, so just try it and save me the trouble of creating more 

sketches. You’ll understand when you see it work.)  

  
When an arc is selected, it will be drawn in magenta along with two dotted lines from the center of 

the arc to each endpoint of the arc. Nibs will be placed at each of the end points, at the center, and 

at the center point of each dotted line.  

• Moving the nib at the center point will move the center point of the circle.  

• Moving the nib at one of the end points will move the end point of the circle, changing the degree 

of curvature, location of the center point, or both.  

• Moving one of the nibs on the radial lines will just change the degree of curvature.  

• To move an arc, press the left button anywhere in the arc, wait a half second until the arc flashes, 

move the cursor and arc to the new location and release the button.  

Box  
To create a box, use Box in the Draw menu or select the Box tool from the toolbar.  

1. Move the cursor to the location of one of the corners of the new box and press the left button. A 

rubberbanding box will appear.  

2. Move the cursor to the location of the other corner of the new box, release the button, and the box 

will be created.  

  

  

   Box 

 Selected Box (with nibs)  
  

When a box is selected, it will be drawn in magenta and will have eight nibs which will move each 

side and each corner of the box.  

• Click and drag one of the side nibs to stretch the box just one direction.  
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• Click and drag one of the corner nibs to simultaneously stretch the box in both directions.  

• To move a box, press the left button anywhere in the box, wait a half second until the box flashes, 

move the cursor and box to the new location and release the button.  

Circle (2 Point)  
Circle in the Draw menu will create a circle given a center point and radius.  

1) Select Circle from the Draw menu or select the 2-point circle tool from the toolbar.  

2) Move the cursor to the location of the center of the circle and press the left button. A 

rubberbanding circle will appear. Move the cursor until the radius of the circle is the right size, 

release the button, and the circle will be created.  

  
When a circle is selected, it will be drawn in magenta and will have three nibs, one at the center, 

one on the circle perimeter, and one on the radial line from the center to the circle perimeter.  

• Moving the nib at the center point will move the center point of the circle.  

• Moving the nib on the circle perimeter will change the radius of the circle. •  Moving the nib 

on the radial line will just move the radial line and the point on the perimeter. This can be useful 

when you want the circle pass through a specific point on the page.  

• To move a circle, press the left button anywhere in the circle, wait a half second until the circle 

flashes, move the cursor and circle to the new location and release the button.  

Circle (3 Point)  
Circle (3 Point) in the Draw menu will create a circle given three points that lie on the circle.  

1) Move the cursor to one of the points and click the left button.  

2) Move the cursor to the second point and click the left button.  

3) Finally, move the cursor to the third point, click the left button, and the circle will be created.  

Once created, the three point circle behaves identically to the 2-point circle.  

Ellipse  
To create an ellipse, use Ellipse in the Draw menu or select the Ellipse tool from the toolbar.  

1) Left-click at a point to define one end of an ellipse axis. A rubbenbanding line will appear. This 

line represents an ellipse axis.  



  
  
  
  

  
  

   58  

2) Click again at the other end of the axis. An ellipse will now be drawn that will dynamically size 

and orient with movement of the cursor. As you move the cursor, the center point will remain 

constant as will the length of one axis. The other axis length will change and the distance from the 

cursor to the center point will be half of the length of the other axis with the cursor being at one 

end of the axis. 3) When you have the right ellipse shape, click the left button one last time to 

create the ellipse.  

  

   Ellipse as drawn  Ellipse with nibs  
  

You may be asking yourself, “This is nice, but what can I use it for?”. Good question. In surveying 

practice, ellipses are not an everyday occurrence. You might want to consider using one to dress 

up a title by surrounding it in a nice thick ellipse. Use your imagination (or not, if you want to 

remain employed).  

When an ellipse is selected, it will be drawn in magenta along with two dotted lines from the 

center of the ellipse along each axis to the perimeter of the ellipse. Nibs will be placed at each of 

the end points of the axes, at the center point, and in the middle of each semi-axis.  

• Moving the nib at the center point will move the center point of the circle and, therefore, the entire 

ellipse.  

• Moving the nib at one of the end points will move the end point of the axis, changing the length or 

angle of the axis or both.  

• Moving one of the nibs on the axial lines will just change the angle of the axis.  

• In addition to moving the center point, an ellipse can also be moved by pressing the left button 

anywhere in the ellipse, waiting a half second until the ellipse flashes, moving the cursor and 

ellipse to the new location and releasing the button.  

Line  
To create a line, use Line in the Draw menu or the Line tool from the toolbar. Creating a line is a 

clickanddrag operation.  

1) Left-click (keep the button depressed) at the location for one end of the line. A rubberbanding line 

will now be displayed.  

2) Drag the cursor to the other end point and release the left button to create the line.  
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When a line is selected, it will be drawn in magenta with a nib at both ends.  

• To alter the endpoint location, click-and-drag one of the nibs to the desired location.  

• To move a line, press the left button on or near the line, wait a half second until the line is replaced 

with its outline, move the cursor and line to the new location and release the button.  

Dimensions  
Dimensions are either straight, bent or curved arrows that can point out certain features of the plot. 

The program doesn’t currently support true dimensioning in layout where one can automatically 

annotate distances between points, since this has been deemed of limited use to the surveyor. 

However, if demand increases...  

Straight Dimension  
Straight Dimension in the Draw menu will create an arrow with a straight shaft or with one bend. 

When creating the dimension, the cursor will first be a P-cross. Move the cursor to the location of 

the end of the shaft with the arrowhead, press the left button, drag the cursor to the location of the 

other end of the shaft and release the button.  

  
When a straight dimension is selected, it will be drawn in magenta and will have a nib for moving 

each endpoint as well as a nib for moving the middle point.  

•  To move a straight dimension, press the left button on or near the one of the shaft lines, wait a half 

second until the straight dimension flashes, move the cursor and straight dimension to the new 

location and release the button.  

Curved Dimension  
Curved in the Draw menu will create an arrow with a curved shaft. Creating the dimension is just 

the same as creating a curve so refer to the Arc section on p.40 for details on creating a curve. The 

first click will define the end point with the arrowhead.  
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Altering and moving a curved dimension are also identical to altering and moving an arc.  

Adding Text  
The Text function is used for adding text in either COGO or Layout. To use this function:  

1) Invoke the function by selecting Text in the Draw menu or through the toolbar.  

2) Left-click at the location in the dataview where you wish to place the text. A vertical insertion 

mark will appear in the color of the text layer. Text is initially created horizontally - it can be 

rotated later.  

3) Type in the text. The <Enter> key can be used to create multiline text.  

When finished with the current text,  

• Press <Esc> or select a different command from the menu or toolbar to finished entering the text  

     OR  

• Left-click at another location to insert another text.  

Once unattached text has been entered, it can be rotated and moved as any other text.  

Notes:  

• A degree symbol can be entered while typing in text by holding down the <Ctrl> key and then 

pressing the <D> key.  

    

The Command Line  
The status bar in the various windows does double duty as a command line echo. This means that, 

when you type in commands from the keyboard, the command will appear in the status bar, 

replacing the information that is normally there. The advantage of using the command line is that 

many functions are much faster to execute since it is generally faster to type in parameters as a 

series of values separated by a space or comma than to call up a dialog box and enter the data in 

the various edit boxes, checkboxes, et. al.  

The program commands are, for the most part, alternative ways to execute the functions in the 

menus. Implementation of command line codes is an ongoing process. An attempt has been made 

to document existing commands within the functions that they pertain to as well as in a summary 

at the beginning of the window sections of the manual. Upgrades to the program may likely have 

additional commands not contained in your copy of the documentation. Call technical support if 
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you have any question or requests for command line implementations that will be of use to you in 

your work.  

Most of the commands are specified as two letter codes followed by a series of parameters 

separated by spaces or commas.  

     Examples: Typing CS 5000 5000 <Enter> 

will create a point at N:5000 E:5000.  

     Typing TR 45, 5, 104 will traverse by turning an angle right of 45 degrees with 

a        horizontal distance of 104.  

The program remembers the most recently used command. The command code does not have to 

be reentered when executing the previous command again. Pressing the <Spacebar> or entering a 

value from the keypad (the number pad on the right of the keyboard) will reenter the previous 

command code on the status line.  

Example: Typing CS 5000 5000 <Enter> creates a point at 5000,5000. Typing <Spacebar> 4500,5000 

immediately afterward will cause the command line to read CS 4500,5000. The CS will appear as 

soon as the <Spacebar> is pressed.  

Notice that spaces and commas are used interchangeably when separating parameters on the 

command line.  

When using the command line in conjunction with the keypad (the group of number keys on the 

right of the keyboard), there is a problem - the keypad has neither a space or comma key. The 

command line has been especially optimized for use with the keypad. Remember, the <Num 

Lock> must be on to use the keypad for entering numbers. The following applies when using the 

keypad:  

•  To enter a comma, press the + key. To enter a +, press the + key twice. •  The 

previous command will be echoed on the line as soon a keypad key is pressed, just as if pressing 

the <Spacebar>.  

Printers/Plotters  
The term “printer” in a Windows environment refers to both printers and “plotters”. The term 

“printer” therefore will be used to refer to both kinds of devices.  

If you don’t have a plotter....  
Unfortunately not everyone owns their own plotter. This section is written with those people in 

mind. Three other ways of printing out a job Include:  

Installing on a computer that has access to a printer:  

Sometimes the owner of a printer will allow you to install the program on the computer with 

access to the printer. In that case just call Soft-Art, Inc. at (615) 230-5745 or (800) 652-7279 for a 

long-term temporary authorization. You can then simply copy the project file onto the printer’s 

computer, open and print it.  
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Printing to a file:  

If you are working with a printing company to plot a drawing sometimes they will allow you to 

give them a  

PRN file. You can make one by installing the driver for the company’s printer onto your system 

and setting its output to “FILE”. When you then print, a dialog will appear asking for the name of 

the file to print to.  

  

Sending a DXF/DWG file:  

DXF/DWG files are so generic that anyone with CAD software can read one in and make a print 

of it. So just Export a DXF or DWG file from the Layout window, and send it to whomever you 

need to print the job. There is one downside to using DXF/DWG files in that that they do not 

support all of this program’s linestyles, or Window’s fonts. The result is that the general 

appearance of the text will usually be different than what you see on the screen, since font 

substitutions must be made.  

If you have a printer, but it does not work.....  
Modern inkjet printers such as the Designjets by Hewlett-Packard aren’t too difficult to 

troubleshoot. However, there are still quite a few of the old pen printers out there, and these can be 

a real pain in the derriere to get working, largely due to the fact that most of them communicate 

through the serial port instead of the parallel (or printer) port.  

Following is a list of some of the most common problems we have run into, but I am sure you will 

come up with a few of your own.  

The printer only prints a part of the drawing...  
If the printer only prints part of the border then the first thing to check is the page margins. If the 

margins are closer than .5 inches, try using slightly larger margins. If that helps then your printer 

is not capable of handling margins that close to the edge of the page. If you use an inch and a half 

or more, and it does not help the problem then the problem probably lies somewhere else.  

Another thing you need to ask is how much memory is in the printer. If it is less than 4 megabytes 

of RAM and you are printing a 24”x36” drawing with a contour map of the Rockies there could be 

a definite memory problem. Some printers have the option of processing the drawing in the 

computer or the printer. If yours is one of them, select the option to process in the computer. This 

setting will generally be in the printer’s setup routines in the Windows Control Panel or Printer 

dialogs. Printing will be slower, but as long as you have plenty of room on your hard drive the 

printer will not run out of memory.  

In some printers the I/O Time-out setting in the printer settings may be too short. Increase the 

setting and try again.  

Sometimes this indicates a discrepancy between the actual plotting area on the loaded media and 

the plotting area understood by your software or, using words people without a Ph.D. in English 
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can understand, “The Page Layout and the Print Setup do not match.” For example, you are 

printing a 24x36 drawing, your page layout is set for 24x36, by default most printers are set to 

8.5x11, so change the printer’s page setup to correspond to Layout’s page setup. If the size you 

want is not available you will need to refer to your printer manual for custom, or more available 

sizes.  

  

The Printer gives no response when told to print...  

If you press “OK” on the Print dialog and the printer just sits and looks at you, one of a few things 

could be happening.  

The printer is not installed correctly and you will need to refer to your printing manual to make 

sure the correct driver is installed and the correct options are being used. Such as using the HP® 

C3190A™ driver when you should have installed the C3191A™ driver, or using LPT2 when the 

correct port was LPT1, etc.  

Another thing that could be causing a problem is if the driver is corrupted or outdated. With the 

constant introduction of new operating systems, updated drivers are often required in order to 

maintain compatibility Most of the time major printer manufacturers have “web sites” that have 

downloadable drivers for their printers, and sometimes that’s all it takes to make a printer work.  

The file may be too big for the printer’s memory. Look on the screen for any error message: some 

drivers allow you to choose a different printing mode change the option and try again. If no other 

printing mode is available, or if your file still does not print, you may need to consider obtaining 

additional memory.  

If the plot is completely blank...  

Check ink cartridges, and memory. See if it prints a test page. This could be caused by a lot of 

other things and you will probably want to refer to your troubleshooting guide in your printer 

instruction manual.  

If the drawing is distorted or unreadable...  

If you are using a serial interface between the printer and your computer, make sure the printer’s 

serial interface settings match the settings and requirements of your hardware. The Windows port 

settings, accessed through the Control Panel, have to correspond to the serial port settings on the 

printer in this situation.  

If the printer seems too slow...  

Possible solutions are:  

• Check the settings in the “Print Setup/Options” dialog box, where some of the settings impact 

speed. If in doubt refer to the on-screen help provided in the dialog.  

• Increase the computer or printer memory.  

• Get a faster computer.  

• Try switching to Windows NT.  
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If the entire plot is on one corner of the page...  

• Check the Page Layout settings in the Layout Project menu. Make sure that your paper settings in 

the Printer Setup correspond..  

• Try changing the printer’s Graphics Language setting, using the printer settings in Windows  

The printer does not handle “True Type Fonts” correctly...  

• If the printer is placing text all over the place and has no control of size. The problem is once 

again in the driver. With some printers there is an option to use a vector language (such as 

HPGL™) or raster language, Raster (essentially means bitmap) is a much better way to print 

anyway so pick it and see if it makes a difference. •  If you are using a pen plotter you generally 

cannot print “True Type Fonts” anyway so you will have to make sure that all your text is set to 

Modern, Roman, or Script (the standard Windows plotter fonts).  

The printer does not print curves with a large radius...  

As much as we hate to admit it this is a bug that is more noticeable in earlier versions of the 

program, but we do have a “work-around” and a fix for the problem. The “work-around” is to go 

into the Environment | Options, press the Advanced button, and check Print curves as chords. 

There are also options for chords per curve and degrees per chord leave those as default, unless 

the curve looks broken. The fix is to call us at Soft-Art, Inc., and have us send an update, or you 

can download updates at our website. The address is “http://www.pcsurvey.com."  

  

A note about Windows95™.  
Windows95™ is not our favorite operating system and we have had more troubles with it than 

anything else as far as printing is concerned. Just because a driver works in Windows 3.1™ does 

not mean it works in Windows95™ This is especially the case with most pen printers. Windows 

95™ has some drivers built into it, but if they do not work, or if that driver is not listed you will 

have to contact the manufacturer get a driver specifically designed for Windows 95™. We have 

had better success with Windows NT.  

Before you call us...  

We here at Soft-Art, Inc. do not mind receiving feedback from our customers. If there is a problem 

with our software we want to hear about it. Unfortunately talking long distance costs a lot, and we 

have not had as much time recently to personally walk through a lot of printing problems. Which 

is why this section has been written. So all we ask is that you read through this, and any trouble 

shooting guides that came with your printer, and try two things to determine whether the problem 

is our software, another software, or a hardware issue.  

1. Try to print a test page; most printers have some way of doing that.  

2. Try to print from a Windows based software such as Microsoft Word™ or Word Perfect™.  
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If one of these ideas does not work, refer to the Windows trouble shooting guide for printers, or 

call Tech Support for the appropriate Company. If these work and the program still does not print 

and this section does not help, give us a call at one of our Tech Support numbers.(The only 

number below that applies to us is the one to Soft-Art, Inc.)  

Tech support numbers:  

Soft-Art, Inc. (615) 230-5745  

   Hewlett Packard  (208) 323-2551  

Data Collectors  
The program has the ability to import and export delimited ASCII coordinate files. The ASCII 

formats can be user-defined. Certain raw data formats are also supported. These include SDR 2.x, 

SDR 3.x, TDS RW5 and SMI raw formats.  

Almost all other data collectors can export a delimited ASCII coordinate file which can be read by 

or directly imported to the program.  

SDR 2.x  

SDR 3.x  
The program can import the OBS and POS view data directly from the SDR data collectors.  

TDS  
Direct communication with the TDS data collectors is supported for import and export of the CR5 

(coordinate) data. Direct import of the RW5 (raw) data is also supported.  

SMI  
Direct import of the SMI coordinate data is supported through the SPACE and COMM output 

options. The program can read the SMI raw data, but it must first be transferred to the computer 

using the SMI transfer program.  
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The Main Window  

Overview  
This window is the “master” window - all other windows in the program will always remain in 

front of the main window. The main area of the window is used for logging function invocations, 

data information queries and other reporting activities. The menus associated with this window 

include “system wide” functions such as layer definition and the program system options.  

Project Menu  
New  

If a project is already open, New will close the project. An unnamed project will then be created. A 

“new” project is not saved until the Save or Save As command is issued (see below).  

Open  
Open will open a project that has already been created. If a project is already open, Open will first 

close that project after prompting for saving any changes that have been made. In the dialog box 

used for selecting the project to open, the  

Drives and Directories sections specify where the file is to be found.  

File Name is the name of the file. 

Either type in the name in the top 

box or select the file from the list 

box. List Files of Type allows 

limiting the files displayed to those 

with the specified extension. The 

same result is generated by just 

typing <*>. PCS, for example, in 

the File Name box. The file 

extension (the characters after the 

period in the file name) can be 

something other than .PCS.  
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Saving a Project  
Save As  

Save As is used to save a project that either has not been named yet or that needs to be renamed or 

saved as a different type. Refer to Open in this section of the manual for an explanation of the 

Save As dialog box since the two dialog boxes are virtually identical. Unlike the Open dialog, the 

file name is generally not selected from the list but, instead, typed in to the File Name box unless 

it is desired to overwrite an existing file.  

Save  
If the current project has a name, Save will save the project with that name. If the current project 

has not yet been named, Save will behave just like Save As, using the same dialog box in the same 

manner.  

  

Delete Project  
  

  
Delete Project can be used to remove old projects. The dialog box works just the same as the 

Open dialog box. The project file that is selected will be deleted from your hard disk or floppy 

disk. Project files can also be deleted by using the DOS DEL command from the DOS prompt or 

by using the delete function in the Windows file manager. For more detail on the operation of this 

dialog box, refer to the Open function in this section of the manual.  
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Authorize  
As shipped, the program will not 

allow the surveyor to export data, 

print or save files. To enable these 

functions, the program must be 

”authorized”. This is a form of copy 

protection. The process of 

authorization can enable various 

portions of the program selectively. 

If, for example, the surveyor wants 

COGO, drafting, and Contouring but 

has no interest in the Survey 

functions, all but the Survey module 

can be enabled during authorization. 

Portions of the program that are not 

enabled will result in their window options in the View menu being grayed out (disabled).  

1) To authorize the program, start the program and IMMEDIATELY select the Authorize command 

from the Project menu in the main window. A dialog, similar to the one shown, will appear.  

2) At the top of the dialog is a Site Code. This is a code that is unique to your computer. Call Soft-

Art, Inc. at the number shown. They will ask for the Site Code.  

3) If you have paid for the software, an Authorization code will then be given, which you will enter 

into the dialog. Once the Authorization code has been entered, the program will be enabled for 

whatever functions have been paid for.  

If it is desired to move the program to a different location on the computer’s hard drive, do the 

following: 1) Copy the program files to the new location. Do NOT delete the original files yet!  

2) Select Authorize from the Project menu on the ORIGINAL program.  

3) Select Direct Transfer. Enter the FULL path to the new location (i.e. D:\PCS\PCS.EXE).  

4) Select OK.  

Authorization for the program can also be transferred between two different computers. Use the 

procedure given above if transferring between two computers on a network. To transfer the 

authorization by floppy, copy the program to the computer that is to receive the authorization (the 

TARGET computer) use the following procedure:  

1) Run the program on the TARGET computer.  

2) Select Authorize.  

3) Select Direct Transfer and enter the drive name for the floppy drive that is to be used (normally 

A: or B:).  

4) Take the floppy out of the TARGET computer and place it in the computer that currently has the 

authorization (the SOURCE computer).  
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5) Run the program on the SOURCE computer. Select Authorize.  

6) Select Transfer Out and specify the drive where the floppy is located. The authorization will be 

removed from the SOURCE computer and placed on the floppy.  

7) Put the floppy in the TARGET computer.  

8) Select Transfer In and specify the floppy’s drive once again.  

The authorization will now have been removed from the SOURCE computer and placed on the 

TARGET computer.  

About  
The About dialog gives the program version and its date of creation. When 

calling for technical support or software updates, have this information 

available.  

  

  

  

Exit  
Selecting this command terminates the 

program. If there is a current project 

that has unsaved changes, the program 

will prompt for whether the project 

should be saved as shown in the dialog 

to the right. Selecting Yes will save the 

current changes whereas No won’t. 

Cancel will return to the program.  

1, 2, 3, 4  
The bottom section of the Project menu contains a list of the most recent projects edited by the 

program. To open one of these files, just go to the Project menu and single click on the file to 

open or type the number to the left of the project file name.  
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Environment Menu  
Layers  

In the program, a layer associates an object with a set of characteristics that include visibility, 

color, line style, and font. When an object is first created, it is placed or associated with the layer 

that has the object’s type assigned to that layer.  

For instance, there is a predefined layer called Bearings to which all newly created bearing texts 

are assigned.  

The bearing text layer might have a color of blue, a solid single width line style, and the 

modern(plotter) font  

(that’s the name of the font - modern(plotter)) of size 0.10 inches assigned to it. All bearing text 

would then be initially created as blue text with the modern(plotter) font at a 0.10 inch height. The 

line style, in this case, is irrelevant since text does not use line styles.  

Edit Layers  

  
Layer attributes are accessed through the Edit Layers command in the Environment menu of the 

Main Window. This dialog can also be accessed by pressing F9 from anywhere else in the 

program. The top level dialog (the dialog box initially displayed) is a table listing the various 

layers with their Name, along with their visibility, Color, Linetype, Font and Default object type 

(if any)..  
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Layer Sets  
Multiple layer sets can be defined. For instance, one might define a layer set for working with a 

pen plotter and a different layer set when printing to an inkjet because the fonts that are used are 

generally different between these two kinds of printers/plotters. Each layer set has a name, 

displayed in the upper left of the dialog. New layer sets can be created by simply typing in a name 

and pressing the Save button.  

Name  
The Name of a layer is up to the user. By double-clicking in this column, the name can be edited. 

Be sure to use a unique name for each layer.  

Visibility (On)  
The column labeled On displays a cross for all layers that are currently visible. A layer can be 

toggled on or off by clicking on the layer’s row and then clicking on the On column. If the layer is 

"on", it is visible. Layer visibility allows the user to turn off the display of given data types. The 

All On and All Off buttons will toggle the visibility of every layer on or off, respectively. 

Normally a different layer is associated with each basic data type (points, point numbers, bearings, 

lines, etc.) Turning off the point number layer, for instance, will hide all the point numbers on that 

layer -- which would be ALL point numbers unless the user has deliberately moved them to 

another layer. Again, data on invisible layers is not available to COGO functions.  

Colors  
The color of a layer can be changed in the Edit Layers dialog box by clicking on the Color button. 

The standard windows color dialog will appear. Simply select the desired color and then select 

OK.  

Linetype  
Linetype refers to the style used to draw a line. There are several predefined line styles included 

with the program. Among these are solid lines with various widths, lines with various 

combinations of dashes and dots, as well as some special line styles. The surveyor can create his 

own line styles as well. A picture of the current linetype is displayed for each layer. Clicking on 

this picture will display the linetype dialog. Simply pick the desired linetype, optionally modify its 

width and select OK to return to the main dialog.  

Font  
Clicking on the Font button will bring up a dialog box which allows setting font parameters for the 

layer. Any text items created on that layer will use that font unless you specify otherwise. For 

more information on fonts, refer to Fonts in the Data Appearance section of this manual.  

Default  
Every object (line, point, contour, etc.) in the program has a data type. Arcs, for instance, are a 

type of data. Data types normally have an associated layer referred to as the data type’s layer. 

When an object is created, it is placed on its layer. This is configurable by the surveyor and is 
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specified by the layer’s defaults. For instance, the first layer in the picture above is named Arc. It 

also has Arc specified in its defaults column. This means that whenever an arc is created, it is 

placed on the layer named Arc. Another example, a few lines down, is the layer name Dot Layer. 

It is the default layer for Pnt. So all new points that are created will have the point symbol placed 

on the Dot Layer layer. These layer assignments cannot be changed here but must be changed by 

clicking on the Modify button.  

Save  
Pressing the Save button will save the current settings (the layer set) along with its name 

(displayed in the upper left corner). If a new name has been entered, pressing Save will create a 

new layer set and the new name will be added to the list in the upper left.  

  

Write Line Style Set  
Write Line Style Set saves the set of currently defined line styles so that they can be accessed 

again for another project. The function will first prompt for a name for this line style set and will 

store the information in the pcs.ini file.  

Select Line Style Set  
Select Line Style Set will read in a previously defined set of line styles for use in the current 

project. This function will provide a list of the currently defined line style sets from which you can 

select the line style set that you want.  
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Options  

  
The Options dialog is used to access the numerous settings used throughout the program. This is 

what is called a “tabbed dialog” (or “property sheet”) due to the file folder style interface. Various 

kinds of settings are displayed here and further explained below.  

Save  
Selecting Save will save all the settings as the default program configuration.  

General 

Options 
Angle 

Entry 

Format  
Angles can be entered in one of two formats as shown in the dialog above. In the first format, a 

period separates the degrees from the minutes. So 29 degrees, 3 minutes, 26.2 seconds is entered 

as 29.03262. In the second format, the period separates seconds from hundredths of seconds. So 

29 degrees, 3 minutes, 26.2 seconds is entered as 290326.2. When entering a direction as a 

bearing, the quadrant number (1 -4) can be entered followed by a space and then the angle.  

Click Cycle Range  
The click cycle range is associated with selecting data using a single click. When the user clicks 

the left mouse button without moving (dragging) the cursor, the program will find the nearest 
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object to the cursor and select it. If the user clicks the left button again without moving the mouse 

in between, the program unselects the previous object and tries to find the next nearest object -- 

this is click cycling. This process continues with each succeeding click selection until the next 

nearest object is outside the click cycle range. The program then starts all over with the nearest 

object to the cursor.  

Descriptions  
Enable Descriptions are “enabled” when this box is checked. When descriptions are not enabled, 

the edit boxes used for description entry in the various dialogs are disabled. Additionally, no 

description information will be shown in the status bar.  

Auto Insert  

When Auto Insert is checked, entered descriptions are automatically inserted into the description 

file if it is not yet in the file  

Insert Prompt  

Insert Prompt applies only when Auto Insert is on. When Insert Prompt is on and a description is 

entered that is not already in the description file, a message will appear asking whether the new 

description should be put into the description file. The surveyor can then choose to put the 

description in the file or leave it out of the file. A description does not have to be entered into the 

description file to be used as a point description.  

Recording  
The program has the capability of keeping an audit trail of functions performed. Some states 

require keeping such a record. By checking the Record option, the audit trail will be sent to the 

Main window.  

Log File  

To keep a record of the audit trail on disk, select Log File and enter the name of the file in which 

to store the information.  

Minimum Text Size  
When bearing or distance text is created, the program checks the length of the line that the text 

will be placed on. The line length, together with the COGO scale, determines the maximum size of 

the text that will fit on the line. If this size is less than the specified Minimum Text Size value, no 

text will be created. If the user desires to place bearing/distance text on very short lines, it is best 

to use the Add Leader Line function.  
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Advanced  
The advanced options control how curves are both 

displayed and printed. Some plotters don’t support 

the drawing of an arc. In these cases, the option 

Print Curves as Chords should be enabled. The 

Degrees Per Chord setting determines the delta 

used on each chord segment of the curve.  

  

Selecting Save writes the current settings to the  

PCS.INI file so that the next time the program is started, the current settings will be used.  

Cogo Options  
See p.100  

Survey Options  

See p. 63  

Geodesy Options  
The Geodesy options are used for selecting state plane/UTM zones and datums for use in geodetic 

transformations. These settings are used when interpreting latitude/longitude coordinate 

conversions in the Project:Import Points from…:File (see p.104) function of the COGO window.  

  

  

There are three currently supported systems. The following guidelines apply:  

• State Plane Coordinate System of 1927 (SPCS 27)  

The only allowable Datum is NAD83. The Current Zone data will include all applicable state 

plane zones. • State Plane Coordinate System of 1983 (SPCS 83)  

Warning: A small value for 

Degrees Per Chord can 

result in slow screen 

redraws!  
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The only allowable Datum is NAD27. The Current Zone data will include all applicable state 

plane zones.  

• Universal Transverse Mercator (UTM)  

Any of the listed datums are supported. The Current Zone data will include all applicable UTM 

zones consisting of 6 degree longitudinal increments.  

Directories Options  
When opening or saving files of various types, the program uses the directory paths specified in 

this dialog as initial directories in the Open or Save dialogs.  

The Project directory is used for opening or saving the program files.  

The Components directory is where the program initially looks when attempting to place 

components.  

  

The Field Data directory is used when importing raw or ASCII point files.  

The Export Point Files directory is used for ASCII point file export, including stakeout point files.  

The DXF Files directory is used for importing and exporting DXF files.  

The Forms directory is where the Layout Forms are normally stored.  
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Units Options  

  
The units dialog controls the input measurement units and the annotation used.  

Angle  
As can be seen, angles can be entered in DMS (degrees, minutes and seconds) or decimals 

degrees, grads, mils or radians. If the angle unit selected is something other than DMS, the 

annotation used can be altered by enabling the Annotation checkbox and selecting or entering the 

annotation desired. Disabling the Annotation checkbox will result in NO annotation being used. 

The default Angle setting is DMS.  

Angle Display  
Angles can be annotated as either Bearing-Quads or Azimuths. Select the format you prefer. The 

default is Bearing-Quad.  

Azimuth  
Select North Azimuth or South Azimuth according to your area’s convention. 

The default is North Azimuth. Text Units  

When specifying text font sizes, three options are available - Inches, Millimeters, and Points. 

There are 72 points in an inch and 25.4 millimeters in an inch. The default is Inches.  

Distance  
Distance units include the US 

and International foot as well 

as meters (metric).  

If the Distance unit is 

changed, the program will ask 

if you want to update the 

database.  
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If you say yes, the data that was stored will be translated to the new units. So, if you entered the 

data in feet and you want to change it to metric, selecting Yes will transform the job to use metric 

units. If you entered some metric data in the program but didn’t realize that the program was set 

up for US Feet, then you would 

not want to update the 

database.  

Survey units can also be 

updated, if desired.  

Stationing  

If using Metric units, stationing 

of alignments (see p.156) can 

be either in the 1000 meter or 100 meter format. That is, 1381 meters would be 1+381 in 1000 

meter stationing or 13+81 in 100 meter stationing.  

Annotation  
The suffix used for distance, area and square area are all user-definable like angle annotation 

(except DMS). Disabling the checkboxes will result in NO annotation being used. In other words, 

only the numerical value will be displayed. To change the default suffix values, just type in a 

different text string. Annotation is not used for Data, Status, or Readout values but only for 

Display values. Changes made to the units values or annotation will not affect strings that have 

already been created until the strings are reset.  

Precision  
Display precision refers to the number of digits after the decimal point displayed for most types of 

data. Another way to think of it is as a rounding function. Angular data is somewhat different as 

will be explained below. The six types of data which can have separately controlled levels of 

precision of output are Angle, Area, Square Area, Distance, Elevation, and Coordinate, each 

representing a different unit of measurement.  

A summary of each measurement type follows.  

Angle  

When angle data is in a format other than DMS (degrees-minutes-seconds), the display precision 

value is as described above. When the angular units are DMS, however, values mean as shown in 

the table below:  

  DMS Roundi ng  

Value  
Rounding to Nearest -  

123°45’59.123” Becomes -  

0  degree  
123°  

1  tens of minutes  
123°50’  
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Area  

Area is measured in either acres (English) or 

hectares (metric). Square area is only 

associated with boundaries and traverses. 

This setting will affect the number of 

decimal digits displayed in such things as 

boundary annotation (when displaying 

square area) and traverse loop reports.  

Square Area  

Square Area is either in square feet or square 

meters.  

Distance  

Distance is also in feet or meters and is seen in the distance strings on lines in the display window 

as well as in various information displays.  

Elevation  

Elevation, if enabled, will be shown in the occupied point's status in the status bar. It can also be 

displayed in the point data in the display window or in various information boxes.  

Coordinate  

Coordinates are either in feet or meters.  

Advanced  

Clicking on the Advanced button will bring up 

another dialog that allows more detailed control. It 

contains some combination of the following types of 

display:  

1) Data - refers to information displayed in 

various dialog or "pop-up" boxes. A good example of 

this is the Inverse function.  

2) Display - refers to data display in the main 

or drawing window. For example, bearing and 

distance strings associated with Cogo lines will use 

Display to determine their precision.  

3) Status - refers to data display in the status 

bar.  

4) Readout - refers to the Coordinate Display 

precision.  

View Menu  
The View Menu in the main window is used for opening (or bringing to the front) the other 

program windows. Clicking on one of these selections will open the corresponding window if it is 

not already open. If it is open, it will placed in front of the other windows. The five different 

windows, other than the main window, are:  

2  minute  
123°46’  

3  tens of seconds  
123°46’00”  

4  second  
123°45’59”  

5  tenths of seconds  
123°45’59.1”  

   etc.    



 

♦ COGO 

 ♦ Layout 

♦ Survey 

♦ DTM  

♦ Component  



 

The Survey Window  

Overview  
The Survey window of the program is designed to handle entry of field data, perform 

desired corrections, and adjust traverse data. Field data is permanently stored (unless 

deleted) with the project. Corrections allowed include atmospheric, curvature and 

refraction, EDM carrier wave adjustments, and correction of constant errors including 

prism offset and constant and EDM offset. Traverse adjustment techniques include 

balancing of angles, compass rule and Crandall rule adjustments.  

The program automatically recognizes and creates closed traverse loops unless significant 

error exists in the entry of the loop (in which case the loops can be manually created by 

graphical selection). Various field techniques are also automatically recognized and 

handled appropriately. These include windings, reciprocal shots, multiply-determined 

sideshots, resections, and turning points. Options that are allowed with a shot include 

bringing the elevation from the foresight to the station, holding either the distance or 

angle constant during adjustments, and specifying the use of a stadia rod. Any shot can 

have a unique equipment, temperature and pressure, and corrections assignment.  

Data entry can be performed through a single shot dialog or a spreadsheet dialog. Shot 

data is displayed graphically as it is created, allowing the user to not only see the 

relationship between entered shots, but also select shots graphically for editing or review. 

Editing of shots results in an automatic update of all dependent shots.  

Survey vs. COGO and the rest of the 

program  
Survey maintains a separate window and a separate set of data. As mentioned, the data 

that is entered is stored with the project until deleted. Survey allows multiple points with 

the same point number to be displayed simultaneously so that the surveyor can see 

differences in measurements. COGO only allows one point per point number.  

COGO points are created from Survey points by the Generate Cogo Points command in 

the Edit menu. In the case of multiple measurements on a point, the point location data 

can be averaged to generate the COGO point or multiple COGO points can be created 

(although with different point numbers). If the point is already in COGO and is connected 

with lines, the lines also will move to maintain their connection. Curves that are attached 

to any of these points are a different matter. The surveyor will need to examine the results 

and probably regenerate the curves.  

Terminology  
The following is a list of the special abbreviations and words or phrases that are used 

throughout this section of the manual:  



 

SD - slope distance  

VA - vertical angle  

HD - horizontal distance  

HA - horizontal angle  

EL - elevation  

HI - height of instrument above ground level  

Prism - height of prism above ground when used in editor dialogs.  

Loop, Traverse Loop or Traverse - a sequence of station points with each successive 

station backsighting the previous station and foresighting the next station in the loop.  

Shot - a measurement.  

Occupy point, Station point or Station - a location from which measurements are taken 

by the surveyor using a theodolite and/or EDM or total station.  

Elevation measurement/shot- a measurement that only records elevation value or SD and 

VA. The HA is not measured.  

Direction measurement/shot - a measurement that only records HA. Used for 

establishing only the direction of a point from some location without concern for its 

distance.  

Distance measurement/shot - can consist of either SD and VA or just HD.  

Survey Options  
The Survey Options dialog gives the surveyor control over point symbols used, plotting 

scale, equipment and corrections defaults and tolerance checking.  

Point Symbols  
There are three types of point symbols 

that can be assigned. The station 

symbol will be placed at all points 

which are used as station points. 

Similarly, sideshot points will be 

marked with the sideshot symbol and 

fixed coordinates points will be marked 

with the coordinates symbol.  

Measurement Tolerances  
Enabling any of the tolerance values by checking the appropriate checkbox will cause the 

program to check repeated measurements to verify that they remain within the tolerances 

specified. Using these options can quickly spot errors from bad field data values or 

entering the data in the wrong fields.  

The Equipment and Corrections buttons allow defining the defaults settings which will be 

used when entering new data. For further information on these functions, refer to the 

Corrections and Equipment Settings sections of this manual.  



 

Project Menu  
Import Raw From…  

The term “raw data” refers to field measurement data, such as vertical angles, turned 

angles, slope distances and stored coordinates. Raw data can be represented in a variety 

of ways, but the most common formats are the SDR, TDS and SMI formats. The program 

can import data in any of these formats. Direct import from the SDR and TDS data 

collectors is supported. SMI data collectors must first be downloaded through the SMI 

transfer program.  

File  
Import Raw From.. File in the Project menu is used to read in a file that contains raw 

data and create the measurements and displayed points and lines. Raw data is field data 

that contains shot information such as azimuths, turned angles, distances, and vertical 

angles.  

   

Raw data can be in the SDR POS View, TDS RW5 or SMI Raw formats. To use this 

function:  

1) Select Project : Import Raw From… : File. A dialog similar to the one shown above will 

be displayed.  

2) Select the desired Format from the list on the right  

3) Using the drive, directory and file name lists, locate and select the file to be imported.  

4) Select OK to complete the operation. A drawing should appear on the screen representing 

the field data.  

The Edit : Fieldbook Editor function can be used to view the field data after the import is 

complete.  



 

Data Collector  

  

If you are using the SDR:  

   •  On the SDR  

1) In Comms Setup, make sure that Speed matches the Baud rate set in the program and that 

Parity is Not Set, Word length is 8, and Format is ASCII.  

2) Select Comms Output.  

   • On the Computer  

3) Set Collector to SDR2x or SDR3x, depending on which type of format your data 

collector uses.  

4) Set Port to the correct COM port.  

5) Make sure the baud rate matches that set in Comms Setup on the data collector.  

6) Select Select File. Set the directory and file name for where to put the file that is coming 

from the data collector and then click the Save button.  

7) Press the Start Transfer button.  

   • Back on the SDR  

8) The Data Collector will ask “Send all jobs?”. Type a N for No.  

9) The Data Collector will then list all jobs it has. Select the job to send, followed by 

<Enter>.  

After the transfer is completed,  



 

Hit the Cancel button in the dialog box.  

   If you are using the TDS:  

   • On the TDS  

1) In File Transfer (menu function S), the following settings should selected:  

     File type: RAW  

     IR/Wire: Wire  

    Baud rate: 9600    Parity: None  

2) Select Send.  

3) Use the up and down arrows to select the file to be sent.  

   • On the Computer  

4) Set Collector to TDS.  

5) Set Port to the correct COM port.  

6) The baud rate should be 9600 (to match the TDS settings).  

7) Select Select File. Set the directory and file name for where to put the file that is coming 

from the data collector and then click the Save button.  

8) Press the Start Transfer button.  

   • Back on the TDS  

9) Press the Select button (the A button if using the HP48).  

10) After the transfer is completed, press the Cancel button in the dialog box.  

  

Import Points From…  
File  

Import Points From… File will read in a delimited ASCII file and create Survey points. 

This function is identical to the COGO Import Points function and is covered in detail in 

the Import Points section of the COGO reference manual (see p.104).  

Data Collector  
Use the same procedure as described in the Import : Points From… : Data Collector 

section of COGO (see p. 104)  

Print  
Selecting Print from the Survey Project menu will print the current view of the data in 

the Survey window. This generates a quick plot. For greater control over the plot, use the 

Layout window to graphically place items on the page and then select Print from the 

Layout Project menu.  



 

Editors - Data Entry  
There are two ways to enter field data - either through the Enter Shot Dialog or the 

Fieldbook Editor. Both editors have the same command set that can be used to accelerate 

data entry by enabling/disabling edit boxes or setting entry mode parameters.  

Mode Command Set  
The following mode commands are available from within both of the survey editors, the 

Enter Shot Dialog and the Fieldbook Editor. These commands turn various data modes 

on or off. Modes that are “toggles” (on or off) have the following convention: the last 

character is an ‘O’ if the command turns the mode on and the last character is an ‘X’ if 

the command turns the mode off. Commands can be entered in any of the edit boxes 

(except the description edit box) by typing the command followed by <SPACE> or 

<ENTER>.  

  

AD  Angle Distance - Horizontal Angle, Distance & 

Vertical Angle (if elevations are enabled)  

AL  Angle Left  

AR  Angle Right  

AZ  Azimuth  

BQ  Bearing-Quad  

DEF  Save current settings as defaults  

DL  Deflection Left  

DR  Deflection Right  

DO  Descriptions On  

DX  Descriptions Off  

EO  Elevations On  

EX  Elevations Off  

HA  Horizontal Angle  

HAO  Hold Angle mode on  

HAX  Hold Angle mode off  

HD  Horizontal Distance  

HSO  Hold Side mode on  

HSX  Hold Side mode off  

NA  Nadir Angles  

NE  Northing, Easting  



 

NEZ  Northing, Easting, Elevation  

RA  Repeat Angle - copies the horizontal angle from 

the previous winding to the current field. 

Especially useful for doubled angles.  

REO  Reverse Elevation mode on - Elevation at the 

FS is used to determine elevation at the station 

point  

REX  Reverse Elevation mode off  

SO  Stadia mode on - slope distances are adjusted as 

stadia shots  

SS  Sideshot  

SX  Stadia mode off  

TR  Traverse  

VA  Vertical Angles  

VD  Vertical Distance - slope distance and vertical 

angle.  

ZA  Zenith Angles  

Entry Modes  
This dialog is accessible from 

within both editors. Most of 

the options contained in this 

dialog are accessible through 

the command set as described 

above. The selected options 

comprise the “entry mode” 

and control which edit boxes 

become enabled as well as the 

format of the entry data in 

both editors. The units used 

in data entry are determined 

by the settings in the 

Environment - Options 

dialog.  

North, East  
When this option is checked, all other options with the exception of Elevation Entry - 

None and Direct become disabled (since all other  

options are meaningless in this mode).  

Horizontal Angle  
Angles can be input as absolute directions (azimuth or bearing) or as turned angles from 

the BS or deflection angles from the FS.  



 

Distance/Vertical Angle  
There are three types of vertical angles - Zenith (referenced from straight up), Nadir 

(referenced from straight down) and Vertical Angle (referenced from the horizontal). 

Together with Slope Distance, they comprise three of the four entry modes in this 

section. If any of these three are enabled, the Elevation Entry mode options are disabled.  

The final entry mode is directly entering the Horizontal Distance in which case 

Elevation Entry mode options are enabled.  

Backsight Entry  
The backsight can be specified as a Bearing, an Azimuth, or a Point. When using an 

absolute angle entry mode (Azimuth or Bearing), the back sight can still be used but this 

only makes sense if you are doing azimuth surveying.  

Elevation Entry  
Selecting Horizontal Distance enables the Elevation Entry modes, allowing the 

surveyor to select whether he wants to input elevations as Direct (absolute elevation 

relative to sea level), Difference (relative to the station elevation) or None (no elevation 

value at FS point).  

Enter Shot  
The Shot Editor has been designed for the entry of a set of measurements from a given 

station and backsight to a given foresight. This is a convenient editor to use for entering 

shots with windings or for leaving as much of the data window visible as possible during 

entry. The Shot Editor can be started by either selecting Enter Shot in the Survey Menu 

or clicking on the  button in the tool bar.  

STN Pt  
Enter the station point number here. If entering a Northing and Easting value, this is the 

point number that will be used for the created point.  



 

Backsight  
This edit box can be toggled to one of three backsight types by clicking on the spin button 

to the left of the text. The three type of backsights are: 1) BS Pt, 2) BS bearing and 3) 

BS Azimuth. These can also be set through the Entry Mode dialog. If the horizontal 

angle mode is Azimuth or Bearing, the backsight mode can also be disabled by setting 

the mode to None. Using an Azimuth with a backsight is only used for azimuth 

surveying.  

FS Pt  
Enter the foresight point number here. This edit box will be disabled in the 

Northing/Easting entry mode. Otherwise this will usually be the number of the point that 

will be created. If, however, you want to do a two point resection, you can enter a known 

point for the foresight point and an unknown point for the station point; The program will 

then calculate the position of and generate the station point.  

HI and Prism  
HI is the height of the instrument above ground.  

Prism is the rod or prism height above ground.  

These boxes will be enabled only when measuring with one of the three types of vertical 

angles - Zenith, Vertical or Nadir. Elevations will also need to be enabled. If elevations 

are not enabled and a vertical angle is being used, the vertical angle/slope distance 

information will be used to figure the horizontal distance but no elevation information 

will be calculated.  

Description  
The description edit box will be enabled only if descriptions are “on”, as set in the 

Environment Options in the main window or command line input. This is the description 

for the point to be created.  

BS Angle  
This is the reading on the instrument when sighting the backsight. The first entry will 

normally be zero but will obviously change in the second and later lines if performing 

certain kinds of windings as explained earlier.  

Horizontal Angle, Vertical Angle, Distance  
These are the first three columns in the dialog . Horizontal angles include azimuths, 

bearings, angles right or left, and deflections right or left.  

Vertical angles include Zenith, Vertical (0° is horizontal) and Nadir angles. The vertical 

angle will be disabled and will not be labeled if the entry mode is set to horizontal angle. 

There may be a column for absolute elevation or elevation difference if one of these 

modes is enabled.  

The distance may be a slope distance or horizontal distance depending on the entry mode.  



 

Traverse  
This check box doesn’t affect the measurement but controls the point numbers that are 

automatically inserted in the dialog if the Continue button is selected. If checked, on the 

next shot entry, the current FS number is inserted into the STN Pt box and the STN Pt 

number is inserted into the BS box. The next available number is used for the FS number.  

Reverse Elevation  
Reverse Elevation means that the FS point elevation, together with the SD and VA 

information (or HD and EL data), is used to calculate the elevation at the instrument 

location (STN Pt). This checkbox is disabled if vertical information is not available.  

Hold Side  
When performing any of the traverse adjustments, measurements that have this option 

enabled will have their distance held constant. The distance will not be adjusted.  

Hold Angle  
When performing any of the traverse adjustments, measurements that have this option 

enabled will have their horizontal angles held constant. The horizontal angle will not be 

adjusted.  

Equip  
Pressing this button brings up the equipment dialog. The equipment parameters can be 

changed for each shot. This allows the surveyor to change, for instance, prisms when the 

prisms have different offsets or constants.  

Corr  
Pressing this button brings up the corrections dialog. Individual shots can have different 

corrections settings. The program will issue a warning if the sea level correction setting 

varies during a job since such a condition is generally not desirable. Use this dialog to 

alter the temperature and pressure settings if correcting for atmospheric conditions with 

the program.  

Entry Mode  

This will bring up the entry mode dialog box explained earlier.  

Continue, OK, Cancel  
When the OK or Continue button is clicked, the shot defined by the current parameters 

will be created. If the Continue button is clicked, the point fields will be updated to 

reflect a traverse or side shot, depending on the state of the Traverse field, and the other 

fields will be cleared to prepare for the input of the next shot. If the  

OK or Cancel button is clicked, the dialog box will be closed.  



 

Fieldbook Editor  
The  Fieldbook  Editor allows the user to see a large number of sequential 

measurements at one time. Data is in a pure tabular format. It is therefore easy to check 

the entered data against field notes as well as to more rapidly enter field notes in quantity. 

Note: the data shown in this dialog will always be the original field data, even after 

adjustments have  been performed. This way, if you find a mistake after 

adjusting a loop, you  can just edit the value in here and then readjust the loop.  

Clicking on a field in the spreadsheet will “select” the row that the field is in. The header 

information for the columns of the spreadsheet will show the types of the data fields for 

that measurement. The upper left and center sections contain information about the 

station point for the current measurement, while the right upper section contains 

information on the backsight for that measurement.  

When a field is selected, the corresponding measurement in the display will be 

highlighted. If the measurement is a coordinate store, the point will be highlighted. 

Otherwise, the line representing the shot will be selected. It also works the opposite way. 

If you click near a line in the display, the line will be highlighted and the spreadsheet 

cursor will move to the row that represents that shot.  

Each winding for a shot will be placed on consecutive lines and they will have the same 

background color. Also, other multiple shots which create a single point, such as a 

reciprocal shot, will also be placed together and shown in the same color. This helps to 

see at a glance which spreadsheet lines are combined to create a single Survey point.  

Changing the spreadsheet size or column widths  
To alter the size of the dialog, move the cursor to an outside edge until it becomes a pair 

of arrows - the Windows sizing cursor. Click and drag the edge to change the size of the 

dialog. The spreadsheet will resize with the dialog. To alter the width of the individual 

columns within the dialog, move the cursor to the top (header) row over one of the 

vertical lines separating the columns. The cursor will become two vertical lines and a 

couple of arrows at this point. Click and drag the column divider to the desired width.  



 

Delete/Insert  
The Delete button will delete the current measurement while the Insert button will create 

a new row immediately before the current row to allow the entering of a new 

measurement.  

Equip and Corr  
 Selecting the equipment or corrections button will bring up the dialogs described in the 

Equipment and Corrections sections of this manual. The settings in these dialogs will be 

applied to all subsequent measurements if these buttons are selected while the last row is 

selected. Selecting a row with measurement data already in it and selecting either button 

will show the settings for that particular measurement and allow editing of the 

equipment/corrections settings for that measurement.  

Options 
This will bring up the entry mode dialog box explained earlier.  

Measurement types and 

techniques  

Sideshot vs. Traverse  
When a measurement is made on a foresight that is not subsequently used as a station 

point, the foresight is considered a sideshot. Conversely, foresights that are subsequently 

used as station points are called traverse points. Traverse points should be measured with 

high precision techniques since they will be the foundation of later measurements, 

especially when part of a control loop.  

Windings/Repeating Angles  
Survey can handle several of the methods used in taking multiple readings on a foresight. 

Multiple measurements are an error-reducing technique that is effective in removing 

collimation and other errors.  

1) In one approach, the forward and reverse pair approach, the surveyor zeroes on 

the backsight, turns to the foresight and records the data. The scope is then reversed 

(flopped) and turned again to the backsight where the backsight angle is recorded (it will 

be approximately 180°). Another measurement is recorded after turning to foresight 

again. Any number of measurements can be taken in this manner within the spreadsheet 

dialog. The surveyor can choose to zero or not to zero the backsight on each 

measurement.  

2) Another approach sometimes used starts by taking a normal first measurement. 

Then, with the upper motion locked, the lower motion is loosened and the scope is 



 

centered on the backsight point. The lower motion is then locked and the upper motion is 

loosened. A measurement is taken on the foresight at this point. Like the first method, 

this procedure can be repeated many times.  

Reciprocal  
Reciprocal measurements are useful for reducing distance errors. The procedure is best 

explained by example: The surveyor stations on point A and takes a foresight 

measurement on point B. He then stations on B, foresights A and records the distance. 

The distance from A to B is averaged with the distance from B to A to determine the 

distance used in generating point B.  

Resection  
When the surveyor stations on an unknown location (a point not previously measured as a 

foresight) and then takes measurements on previously determined or known points, he is 

performing a resection. For example, if you have a point 1 and 2 but not 3 and then you 

station point 3, backsight point 2 and foresight point 1, a resection shot will be created to 

calculate the location of point 3.  

Reverse Elevation  
This term applies to the technique of using the elevation of the foresighted point to 

determine the elevation at the station. This is a toggle in the shot and spreadsheet dialogs. 

Taking a full or elevation measurement from a station with an elevation value on a 

foresight with an elevation value will cause the program to prompt for whether the station 

elevation should be updated.  

Multiply-determined Sideshot  
Multiply-determined sideshots occur when the surveyor foresights and measures a given 

point from more than one station point. The results are averaged to determine the 

generated COGO coordinates.  

Turning Points  
On-Line  

An on-line turning point occurs in this manner: the surveyor stations on point A and 

foresights point B, recording the turned angle. The rod/prism is placed on the line 

between A and B at some intermediate distance. This is the turning point, TP. The 

surveyor then measures and records the SD and VA from A to TP. He then stations on 

point B and again measures the SD and VA from B to TP. The data is reduced to 

determine the location and elevation of point B.  



 

Off-Line  
Off-line turning points are used to determine the elevation at a existing point B when the 

elevation at another existing point A is known, and it is not possible or desirable to obtain 

the elevation directly by taking a measurement on B from A.  

Instead, the surveyor foresights a point, TP, that is visible from both A and B. Such a 

point, for instance, could be a nail in a tree. An elevation measurement is made from A to 

TP followed by an elevation  

measurement from B to TP. The elevation at B can then be calculated, based on the 

elevation at A and the turning point measurements.    

Corrections  

Atmospheric  
The EDM uses an electromagnetic 

signal to measure distance. 

Atmospheric temperature and 

pressure affect the propagation of the 

EDM and can introduce a small 

amount of error in the EDM distance 

reading. This error is quite small - 

about 1/10.000 of the measured 

distance or less. For larger distance 

measurements, however, this error 

can become significant. Modern total 

stations contain an atmospheric correction system. If the EDM used doesn’t have an 

correction  

system or the system is not used, the  

correction can be optionally performed by the program. Do not use this correction for a 

taped measurement! The program currently doesn’t support temperature corrections to 

taped measurements. This  

correction is automatically disabled for stadia 

measurements.  

  
The following formula is used in making 

atmospheric corrections where:  

SD = slope distance  

Ka= correction factor in ppm (parts per million)  

RI = group refractive index for EDM’s carrier wave  

Ccw = EDM carrier wave constant  

P = pressure (in mmHg)  

T = temperature (in °Celsius)  



 

Curvature & Refraction  
Curvature and refraction errors become more appreciable as longer distances are 

measured. Curvature errors occur due to the curved surface of the earth, resulting in 

larger horizontal and vertical distance values than are actually present. Atmospheric 

refraction offsets the curvature affect to some degree, causing the EDM carrier wave to 

bend slightly towards the earth as it travels. Modern EDMs correct for these effects 

internally. If internal correction is either not available or disabled on the EDM for a given 

measurement, the program can be used to correct for these effects. Curvature & 

refraction corrections are only applied to slope distance measurements. They will not 

be applied to measurements that are entered as horizontal distances and/or elevations.  

Sea Level  
Enabling Sea Level corrections will result in the adjustment of horizontal distances to sea 

level values. This is simply a mapping onto a sphere whose radius corresponds to sea 

level elevation. The following equation is applied:  

HD = horizontal distance  

= Mean spheroid radius at sea level 

= 6372.2 km  

EL = station elevation  

EDM/Prism constants and offsets  
A prism’s center can have both a vertical prism offset as well as an offset along the 

direction of sight. The offset in the direction of sight is specified as the prism constant - 

the offset in millimeters towards (a negative value) or away from (a positive value) the 

telescope. The EDM may also have an offset in the vertical direction. Instead of an EDM 

constant, there is generally an error specifying the range of error in the sighting direction 

and an error that is proportional to the distance being measured. For example, one might 

see an entry in the instruments manual like this:  

Measurement Accuracy: ±(2 mm + 2 ppm) m.s.e.  
The first value, 2 mm, is the EDM constant error. The second value, 2 ppm (2 parts per 

million), is the EDM proportional error. m.s.e. is an abbreviation for mean standard 

error. To fully understand what this means, refer to a text on probability on statistics. 

Explained crudely, a distance measurement of 100 meters with this particular EDM 

means that the real distance can be somewhere between  

 100m ± .(2 mm + 100m × .000002) or 100m ±2.2mm     

    

    

    

    

R   sl    



 

Equipment Settings  

The equipment settings are used for curvature & refraction,  

atmospheric, and  

EDM/Prism  

Offsets corrections if such corrections are enabled. The equipment settings also contain 

error values used in least squares adjustment routines.  

Equipment Name  
Clicking on the down arrow to the  

 right of the edit box will display a list of the currently defined equipment 

types. This list is maintained in the PCS.INI file. The surveyor can select an item from 

this list or type in a new name to create a new equipment definition.  

EDM values  
The EDM has several parameters that must be defined in order to process atmospheric 

and offset corrections as well as perform a least squares adjustment that will take the 

EDM deviation into account.  

Refraction Index and Wave Constant  
This is a “lumped” value that can be obtained from the EDM’s specifications. Look for a 

section on atmospheric corrections in the EDM’s manual.  



 

Offset  
The EDM offset is its vertical offset from the telescope’s line-of-sight axis. Modern 

instruments normally have a zero offset for the EDM.  

Constant Error and Propagation Error  
These values should be contained in the EDM’s specifications. They are generally 

specified in a format similar to: ±(2 mm + 2 ppm) m.s.e. In this example, the constant 

error is 2 mm (2 millimeters) and the propagation error is 2 ppm (2 parts per million)  

Prism values  
The prism values are used if the EDM/Prism offset corrections option is selected. The 

prism constant is the prism’s offset in the direction of the line-of-sight. The prism offset 

is the prism’s vertical offset from the measured center. If your prism is a tilting prism, 

check the Tilting option. This is the default. Non-tilting prisms can introduce an error that 

increases with increasing vertical deflection from the horizontal axis. The program will 

correct for this if Tilting is NOT selected.  

Miscellaneous Errors  
Centering  

Centering errors occur when attempting to precisely place an instrument above a station 

marker.  

Pointing  

Pointing errors result from the finite thickness of the telescopes crosshairs.  

Target Alignment Horizontal Circle  
The Horizontal Circle error is a measurement of the instrument’s accuracy in 

measurement of angles. A 10 second instrument, for example, has a 10 second horizontal 

circle error.     



 

Adjustments  
The program has a variety of adjustment 

procedures. They include Angle Adjust, 

Compass Rule, and Crandall Rule 

adjustment.  

Measurements that have the “Hold Side” 

and /or “Hold Angle” option set will not 

have their distance and/or direction 

altered during these procedures.  

Angle Adjust (or Angle 

Balance)  
Angle adjustment refers to the distribution of total angular error in a traverse among the 

individual angles. Angle adjustment can be performed whenever a traverse exists whose 

first and last legs have known directions or, in the case of closed traverse.  

Compass Rule  
Compass rule adjustment is a standard technique where the total error is distributed 

among the legs of the traverse in proportion to the individual leg length. For example, if 

the length of the leg is 10 feet and the perimeter is 100 feet , then the percentage of the 

total error which is applied is 10%. If the leg were 15 feet with the same perimeter, then 

the percentage of total error would be 15%.. This rule works well in most single loop 

cases. The balancing of the angles is generally done before the compass rule is applied, 

but the angle balance can be turned off if desired.  

Crandall Rule  
The Crandall rule is a type of least squares adjustment. Angle adjustment MUST be 

performed before the rule is applied for correct results. Therefore, the performing of an 

angle adjustment is not an option in this case. Also, the traverse must be capable of being 

angle adjusted.  

Least Squares Adjustment  
The program supports two-dimensional least squares adjustment by observation 

equations. This means that the northing and easting coordinates of points generated by 

angle and/or distance measurements are adjusted such that the adjusted location 

minimizes the sum of the squares of the errors that result from using that location. Since 

least squares adjustment is a high precision technique, the program assumes that 

measurements will be performed with a total station (or EDM and theodolite) and doesn’t 

support least squares adjustment of measurements obtained with a transit and chain.  



 

Least squares adjustment is generally used in cases where the surveyor has obtained a 

network of shots as opposed to shooting a simple traverse loop. Using least squares to 

adjust simple loops generally doesn’t provide any better results than using the compass or 

Crandall rule. Least squares is appropriate when one or more points have been 

foresighted from more than one station when those points lie within a loop or mesh (as 

opposed to a simple resection).  

The advantage of using the program for least squares adjustment is that the same 

fieldbook is used for this technique as well as other adjustment methods. There is still a 

graphical display of the shot data as opposed to systems that use a text file for entry. 

There is also immediate visual feedback of the results through the display of error 

ellipses (more on these later).  

Successful use of least squares adjustment with this method requires accurate values for 

several sources of random errors. These values are entered through the Equipment 

dialog. Read the section on Equipment Settings on p.76 for more information.  

The EDM errors (constant and proportional) and horizontal circle error are of primary 

importance and are usually provided with the instrument.  

  
To perform a least squares adjustment,  

1) Select Least Squares Adjust from the Survey menu. The dialog shown above will appear.  

2) Adjust the parameters as desired.  

3) Select Adjust to perform the adjustment and save the data to a file. The program will use 

the standard file dialog to prompt for a file name.  

  

Least Squares Adjustment Parameters  
 Ellipse Scale - Error ellipses will be generated to graphically show the uncertainty or 

probable error associated with the adjusted location of each point in the network. 

Normally, these ellipses are very small when displayed at a 1:1 scale, so the surveyor is 

given the option of magnifying the size of the ellipses by changing their scale factor.  



 

Max Iterations - Least squares adjustment is an iterative technique - computations are 

performed to calculate new point locations and the new locations are used to perform 

another set of computations and so on. When the difference between successive 

computations is less than some specified value, the adjustment is complete (the results 

have converged). It is possible for conditions to be such that a large number of iterations 

might be necessary to achieve convergence. Since least squares adjustment can take a 

large amount of time for each iteration, the procedure may take too long under such 

conditions. Setting the maximum number of iterations to some small value will force the 

program to terminate calculation after the specified number of iterations.  

Convergence - When the difference between successive computations is less than the 

value specified here, the results are considered to have converged and so the computation 

is finished.  

Confidence - The probability that the true position lies within the area of the error ellipse. 

(If the error ellipse has been scaled, the area.)  

The Report options specify what data to include in the generated report.  

• Observations includes all the angle and distance measurements that were used in the 

adjustment calculations.  

• Adjusted Coordinates includes the new locations for all the points in the adjustment.  

• Error Analysis provides a detailed summary of the errors associated with the points. 

Miscellaneous Controls  

Summary - Shows some basic information after the adjustment.  

Print - Print out the data from the file to the printer.  

Report - Create a separate dialog to display the full report.  

  

Unadjust Least Squares  
This function simply removes any least squares adjustments that have been performed.  

Error Search  
The Linear Error Search function will take the linear error between the first and last 

points and will apply the error to each shot in the loop and will check the resulting loop 

for the resulting linear error, displaying the result in the log window. The shot which, 

when adjusted by the error, produces the smallest resulting error will also be displayed.  

The Angular Error Search function will take the angular error between the first and last 

turned angles and will apply the error to each angle in the loop.. The resulting loop will 

be checked for the resulting angular  

error and the result will be displayed in the logging screen. The angle which, when 

adjusted by the error, produces the smallest resulting error will also be displayed.     



 

Edit Functions  

Generate COGO Points and COGO 

Filter  
To create COGO points from the Survey points, select Generate COGO points from the 

Edit menu of Survey. To configure the Survey to COGO mapping without actually 

generating the COGO points yet, select COGO Filter from the Edit menu of Survey. The 

same dialog box is used in either case.  

This dialog box behaves similarly to the Fieldbook Editor. As the current row changes, 

the headings at the top of the columns may change as well to reflect the kind of data that 

is in each column of the current row. The checkboxes in the first two columns are the 

only fields which can be edited. The other fields are provided for reference only. Any 

points which have the same point number or are ‘very’ close together will be listed 

together to show that they can optionally become the same COGO point. The Use column 

tells whether the point will be transferred to COGO or not. If it is not checked, no COGO 

point will be created. The Mult column is used when multiple points are grouped 

together. Any point that is not checked in this column and is checked in the Use column 

will be directly transferred to COGO. When both columns are checked, the position will 

be averaged in with any others which are also checked in both columns to become a 

single Cogo point.  

 

Just as in any other dialog which contains a spreadsheet, the size of the columns can be 

changed by moving the mouse to the line in the header row which separates that column 

from the next column. The cursor will change to a || with arrows on each side. Click and 

drag with the mouse will then resize the column.  

Inverse, Next Number, Modify Line 

Text, Set Font  
These functions are identical to their counterparts in COGO and are explained in the 

COGO section of the manual.  

Inverse - see p.177  



 

Next Number - see p.190  

Modify Line Text - see p.115 Set Font - see p.200  

Delete Objects  
Delete Objects will delete all selected objects. If the object is a part of a mapcheck, the 

entire mapcheck will be deleted. If the object is a shot, any shots which are dependent on 

it will be also be deleted. In other words, if you delete the shot which created point #3, 

then any shots which stationed at point #3 will also be deleted. So use this function with 

care.  

Save to Overlay  
To move Survey objects to a specific overlay, select Save to 

Overlay from the Survey Edit menu. A dialog box will appear 

allowing you to select which overlay to save the data on. For 

more information about Overlays, refer to the discussion of 

overlays on p.114.  

Create Loops  
Most of the time, loops will be created automatically as the data is entered. If the program 

has failed to create a loop, select the lines which represent the shots that constitute the 

loop. Then select Create Loops from the Survey Edit menu. A loop will be created if it is 

possible using all of the selected shots and only the selected shots.     



 

Survey Functions  

Occupy/Back Sight  
This dialog is identical to the dialog used in the Cogo window but sets the station and 

backsight points in the Survey data. For more information, refer to Occupy/Back Sight in 

the Cogo section.  

In the Shot Editor and the Fieldbook Editor, the occupy and backsight points for a given 

shot are explicitly stated.  

Loop Report  
To display information about a loop, select the loop and then select Loop Report from the 

Survey menu. The following information will be displayed:  

      



 

Mapcheck Functions  
Mapcheck routines are for the entering and error checking of existing plat data. The user 

can optionally create COGO objects (points, lines, arcs, etc.) now or later for further use. 

Lines are entered as distances and directions (azimuths or bearings). Curves can be 

entered with a variety of parameters. The mapcheck report contains a summary of the 

boundary data, and the closure, area, and perimeter values.  

Create  
The MapCheck - Create dialog allows the input 

of a name, optional COGO data creation, overlay 

assignment and starting point data. The Name and 

Overlay fields are optional; defaults are assigned 

for the POB fields.  

If more than one mapcheck will be created within 

a given project, assign unique names to each one 

so as to distinguish between them.  

• The Overlay list allows the generated COGO data 

to be placed on a separate overlay. This feature is 

useful when the surveyor wishes to be able to 

easily turn the mapcheck data on or off.  

• The POB data is simply the point number, 

northing and easting for the starting 

point in the mapcheck.  

 

When you click OK, another dialog will 

be opened for entering information for 

the first time from the plat. 

 

Line Entry 
The information is entered as an angle and a distance. The angel can be entered as either a 

bearing or an azimuth. To change the angle mode, click on the down arrow for the 

Options list and select the desired angle mode. 

 

• To enter a mapcheck curve, click on the Curve button which will open the mapcheck 

Curve dialog.  

  

Mapcheck Creation Dialog 



 

Curve Entry  
• The first two parameters are selected from Radius, 

Tangent, Length, Chord, Delta, PI-PT (angle from the  

Point of Intersection to the Point of Tangency) and RP- 

PT (angle from the Radius Point to the Point of 

Tangency). PI-PT requires that the other parameter be 

the Tangent distance. RP-PT requires that the other 

value be the Radius distance. Otherwise, any 

combination of two of these parameters will work.  

• The third edit box is used for specifying the PC-PI 

angle. If the curve is tangent to the incoming line or 

curve, just enable Tangent at PC. This will disable the  

  

PC-PI edit box and will set the curve tangent to the  

incoming line or curve (assuming of course that this curve is not the first segment of the 

mapcheck in which case there is no incoming line or curve and so Tangent at PC is 

disabled). CW or CCW are selected to specify clockwise or counter-clockwise, 

respectively. To return to line mode, select Line.  

  



 

Edit (Mapcheck)  
Editing a mapcheck is very similar to editing fieldbook data, but a lot simpler. The first 

line will always be the point number, northing, and easting for the starting point. The rest 

of the lines will be either lines or curves and the headers for the column will reflect the 

data which is in the current row. The Point information in the upper left of the dialog box 

shows the information for the point which was created by that line of the mapcheck.  

• To change from Line to Curve mode, click on the appropriate radio button in the upper 

right corner of the  

dialog.  

• For Lines, the first column is the angle and the second column is the distance. To change 

the angle mode for the current line, click on the top spin button which, in this example, 

says Bear/Quad.  

• For Curves, the first two 

columns are selected from 

Radius, Tangent, Length, 

Chord, Delta, PI-PT (angle 

from the Point of Intersection 

to the Point of Tangency) and 

RP-PT (angle from the Radius 

Point to the Point of 

Tangency). PI-PT requires that 

the other parameter be the 

Tangent distance. RP-PT 

requires that the other value be 

the Radius distance. Otherwise, 

any combination of two of 

these parameters will work. 

The third column is the PC-PI 

angle. If the curve is tangent to 

the incoming line or curve, just 

enable the checkbox in the last 

column which is Tangent at 

PC. This will disable the PCPI 

column and will set the curve 

tangent to the incoming line or 

curve (assuming of course that 

this curve is not the first 

segment of the mapcheck in 

which case there is no incoming line or curve and so Tangent at PC is disabled). The 

fourth column specifies whether the curve travels clockwise or counterclockwise.  

Report  
To create a report of the mapcheck, select Report from the Mapcheck menu. The report 

will include the starting and ending coordinates, error of closure, and information for 

each leg or curve of the mapcheck. A dialog containing the report will appear, similar to 

the one shown below.  



 

Once the report is displayed, the surveyor has the option of printing and/or logging the 

report by selecting either the Print or Log buttons. If multiple mapchecks are selected, 

their reports can be viewed one at a time in the dialog. The surveyor can then view and 

optionally print each of the mapchecks in turn. The following additional buttons become 

available to allow this:  

Log - send the selected mapcheck reports to the session log Print - send the selected 

mapcheck reports to the printer. 

As usual, select OK to leave this function or Help to invoke the online help.  

To COGO  
If you didn’t generate Cogo points when the 

mapcheck was created, you can generate 

them later by selecting To Cogo from the 

Mapcheck menu. This is a simplified 

version of the dialog box used for creating 

the mapcheck. Match Numbers, Overlay, 

and POB all mean the same as they did 

when creating the mapcheck. Match 

Numbers will create Cogo numbers that are 

the same as the numbers used in Survey. 

Overlay will place the numbers on the 

specified overlay.  

POB will set the Cogo point number and location  

for the start of the mapcheck. When OK is selected, a copy of the points, lines, and curves 

will be created in Cogo and a boundary will also be created consisting of the entire 

mapcheck.  

GPS Functions  
The GPS functions are for processing GPS receiver data. To process a baseline, the order 

of steps to follow is:  

Example of a Mapcheck Report  



 

1) Transfer the receiver files to the computer.  

2) Load the receiver files for the desired points using the Load GPS Files.  

3) Select a control point with the mouse.  

4) Select Add Control Point.  

5) Select Process This Session.  

  

Load GPS Files  
The first step in GPS processing is to load the receiver data files. GPS data collected with 

the GMS data collector will have the suffix .CES. There will be at least one file for each 

receiver that can contain one or more points. The receiver files should already have been 

transferred to the computer before this point. To use this function:  

  

1) Select Load GPS Files from the GPS menu. The standard Windows file dialog will 

appear. The current folder (or “Look In” folder) will default to the GPS directory 

specified in the Options | Directories settings.  

2) Select each of the receiver files, by left-clicking on the file name followed by pressing the 

OK button.  

3) After all files have been loaded, select Cancel to finish.  

  

At this point, the points with their associated baselines should appear on the screen for 

static sits. For kinematic mode, a series of gray dots will appear showing the path 

traveled while in kinematic mode.  

  



 

Add Control Point  
Once the GPS files have been loaded, one point 

must be selected and designated as the control 

point. This point will not be adjusted during 

processing and is typically a GPS station point 

that is a geodetic monument with known state 

plane and/or lat/long coordinates. To use this 

function:  

1) Select the desired control point by left-clicking 

and dragging a selection box around the point. 

Baselines associated with this point will be  

  
selected as well, but that will not affect this function since Add Control Point is only 

concerned with selected points.  

2) Select Add Control Point from the GPS menu. A dialog will appear, displaying the 

coordinates for the selected point along with the options of Ellipsoid or MSL and Feet or 

Meters. The default values will be shown as Ellipsoid and Meters and are the 

approximate geodetic coordinates as derived from the GPS receiver data.  

3) If the selected point is a geodetic monument, modify the data to reflect the correct 

information.  

4) Select OK to close the function.  

The selected point’s symbol will change to a triangle to reflect the fact that it is now a 

control point. The displayed position may also shift somewhat.  

Process This Session  
  
After the GPS files have been loaded and a control point 

has been designated, the baseline processing may be done. 

To use this function:  

1) Select Process This Session from the GPS menu. A status 

window will appear, displaying information on how many 

baselines have been processed, how many total baselines 

are to be processed and how much of the processing has 

been completed, as a percentage, on the current baseline.  

When the processing is done, the colors of the baselines will be updated to reflect their 

status. The colors are:  

Green- Good baseline.  

Red- Bad baseline. The data is not considered reliable.  



 

Satellite Planner  
  

  

The Satellite Planner is a critical piece for successful use of GPS equipment. The planner 

displays the number of satellites visible and the PDOP value for specified times at a 

given location. This function, along with the Satellite Viewer (explained next), requires 

an almanac file to be present in the Almanac directory in order to work. (See GPS 

Almanacs on page 239 for more information.)  

The PDOP value (Position Dilution of Precision) is, by far, the most critical information. 

PDOP values are color-coded green, yellow and red depending on their value in order to 

quickly see how good or bad the satellite configuration will be. The numbers on the left 

side of the bar graph indicate the number of visible satellites above 15 degrees vertical 

angle for the blue bars or the PDOP value for the green, yellow or red bars. The bottom 

axis is graduated in military hours.  

Red values represent PDOP values above 5.0 and indicate times that should be avoided. 

In the picture above, this includes the time from about 4:15am toa 4:45am.  

Yellow values represent PDOP values between 3.0 and 5.0 and indicate times that are not 

ideal and should be avoided when performing kinematic GPS sessions.  

Green values represent PDOP values below 3.0 and indicate times suitable for either 

static of kinematic GPS sessions.  

To use this function:  

1. Set the Time and Date. These will default to the computer’s current time and date 

settings. Use the format shown in the picture above.  

2. Specify the location as a latitude and longitude. When entering these values, use the 

format  



 

(D)DD.MMSS where D = Degrees, M = Minutes, and S = Seconds. The latitude shown in 

the picture was entered as 36.1700, for example. If the value entered is the normal 

location for GPS use, press the Set as Default button to store this as the default value.  

3. Specify the Duration in hours (default is 8 hours).  

4. Specify the sample Interval (default is 15 minutes). As an example, an interval of 15 

minutes will show 4 bars per hour as in the picture above.  

5. Press Calculate.  

Satellite Viewer  
The Satellite Viewer is used to view the satellite configuration for a specific date, time 

and location. This can be useful when trying to acquire GPS points that are partially 

obstructed such as locations next to a line of trees or next to a building. In cases of partial 

obstruction, GPS measurements need to be made at times that have at least 4 (and 

preferably 5 or more) satellites above the elevation mask that are unobstructed from view 

with respect to the receiver.  

Geoid Calculator  
The Geoid Calculator computes the separation between the geoid and the ellipsoid at a 

designated location. The calculation uses the Geoid 96 data as provided by the US 

government and is expressed as a distance.  

The distance is the height/elevation of the geoid with respect to the ellipsoid. Negative 

values, for instance, (which will be the case for all locations within the conterminous 

United States) indicate that the geoid is below the ellipsoid. To use this function:  

1) Select Geoid Calculator from the GPS menu.  

2) Enter the desired Latitude and Longitude values.  

3) Select Calculate. The geoid separation value will be displayed.    

View Functions  
See the section on Common View Functions on p.38 for information about Redraw 

Screen, Full View, Pan View, Zoom In, Zoom Out and Zoom Back.  



 

Visibility  
This controls the visibility of various 

elements in the Survey window.  

Show Graphics, Show Contours, and 

Show  

COGO control whether data created in 

Layout, DTM, and COGO windows 

respectively are to be displayed in this 

window. When one of these is 

checked, the data created in the 

corresponding window will be 

displayed in a light gray color.  

Points, Connected Lines, Texts, and Curves control whether the corresponding Survey 

items  

are displayed in this window. To turn off the  

display of all Survey texts, for example, click on the Text checkbox to remove the check.  

Displayed objects may be visible or hidden. If Visible is selected, only visible objects will 

be displayed. If Hidden is selected, only hidden objects will be displayed. If both are 

selected, all objects will be displayed.  

Find Point  
This function is the same as Find Point in COGO so refer to the COGO section for 

information on this function.  

COGO, Layout, DTM, Component  
These functions will create the window of the specific type. For information on these 

functions, refer to the COGO section.  

  

Misc Functions  

Status Window, Select Status, Tool 

Window  
These functions are the same as their COGO counterparts so for information about these 

functions, refer to the Cogo section.  



 

Close  
 Close the Survey window.    

The COGO Window  

Window Items  
The Cursor  

The cursor is the pointer controlled by your mouse. Normally, the cursor will look like an 

arrow. The program also uses special cursors in some of its functions. The cursor is 

normally used to actuate the menus at the top of the window, select menu items, push 

buttons and operate dialog boxes, select data, and zoom or pan within the project.  



 

Data Window  
This is where your data is displayed. The data window, in conjunction with various 

mouse actions, is also used to manipulate project information. Selection, placement, 

zooming and  

 panning are all done within the data window.  

Title Bar  
The Title Bar is at the top of the window. The name of the program is displayed followed 

by the name of the current project (if any) is displayed in the bar.  

Menu Bar  
The Menu Bar lies directly below the title bar. Clicking on the menu bar with the left 

button of the mouse or using the keyboard accelerators associated with the items in the 

bar (ALT P for Project, for instance) will display a list of various functions associated 

with the COGO window.  

Tool Bar  
The COGO Toolbar is a column of buttons that appears on the left side of the COGO 

window when enabled.  

It is simply a quick way to access commonly used functions that are also available 

through the menu bar.  

From top to bottom, the functions in the first column are: Open(Project), Save(Project), 

Traverse/Side Shot,  

Occupy, Next Number, Point Traverse, Inverse, Text On/Off, Line Style, Color, Font,  

Bearing/Bearing(Intersection), Bearing/Distance(Intersection) and 

Distance/Distance(Intersection).  

The Text On/Off button displays a green "T" when text drawing is enabled. When 

disabled, a crossed out red "T" is displayed.  

The second column of the tool bar are drawing functions. From top to bottom, they are: 

Select, Rotate, Two-  

point Circle, Three-point Circle, Arc, Ellipse, Rectangle, Polygon/Polyline, Text, Line, 

Straight Dimension, Curved Dimension.  

The third column contains buttons that toggle various snapping modes on and off. The 

first seven are absolute snap modes and are, from top to bottom: Grid, Nearest, 

Endpoint, Midpoint, Center, Quadrant, Intersection. The last three are relative snap 

modes and are Angle, Perpendicular, Tangent. These buttons act like radio buttons – 

only one of the absolute snap modes and only one of the relative snap modes can be on at 

a time. To turn off the snap mode that is already on (depressed), press that button again. 

(see p.221 for more information on snapping).  

The Tool Bar can be toggled on or off through the Misc menu.  



 

Status Bar  
The status bar is the gray bar immediately underneath the menu bar. The left box of the 

status bar displays the current back sight and the next number that will be used when a 

new point is created. The back sight can be displayed as either a point number or as an 

azimuth. See the section of COGO options for more information on this feature.  

The right box displays information about the occupied point including point number, 

northing, easting, elevation (if enabled) and description. Elevation display is enabled or 

disabled through the EnvironmentOptions dialog box that can be accessed from the 

Environment menu.  

When commands are entered through the keyboard (the command line - see p.45) they 

replace the occupied point information.  

The Status Bar can be toggled on or off through the Misc menu.  

Select Status Bar  
The Select Status Bar is a series of buttons and boxes containing numbers directly 

beneath the Status Bar. The buttons are used to actuate the selection filters, which are 

discussed in detail in the "Data Selection" section of this manual. The numbers indicate 

how many items of each type of data are selected (see the Data Types section 

immediately following). Additionally, there are three buttons labeled A, N and C on the 

far right of the select status bar. The A button stands ALL. Pushing this button will enable 

all selection types. The N button stands for NONE. Pushing this button will disable all 

selection types. The C button stands for CLEAR. Pushing this button unselects anything 

that is selected.  

The Select Status Bar can be toggled on or off through the Misc menu.  

Coordinate Display  
The Coordinate Display is on the top of the toolbar Normally, the top box of the display 

shows the northing and the bottom shows the easting of the cursor. In the radial select 

mode, this display will show the absolute distance from the occupied point.  

Data Types  
Points  

Points are just a number and location with an optional elevation and description. 

Descriptions are currently limited to 15 characters. Control over displayed points is very 

flexible. Each displayed point has an associated symbol and location for text data. Each 

text value (number, location, elevation, and description) can be individually turned on or 

off. The placement of each point's data is also controllable.  



 

Lines  
There are two basic types of COGO lines -- connected and leader lines. Connected lines 

always start and end at a point. Leader lines are usually used to place text associated with 

a connected line or a curve when the text will not otherwise fit (usually because the 

connected line or curve is very short). A line's color, line style and width are all 

individually definable. Line width can only be defined for solid lines (as opposed to, say, 

dashed).  

Texts  
Texts in COGO can be associated with point data, bearings, distances and curve data or 

placed as unassociated (floating or free-standing) text. Free-standing text may also be 

placed in the project through the Layout part of the program.  

Although some text is automatically created, all text can be manually moved and resized. 

Text will have an associated default font and size. However, when fitting text to a line, 

the program will automatically shrink the text size, if necessary, in order to make it fit on 

the line. It will not automatically increase the text size beyond the default settings. The 

default sizes are controlled through the layer values (see the section on Layers and 

Overlays).  

Curves  
Curves in the program are currently limited to simple (constant radius) curves. Again, 

line type and color are definable, as well as width for solid line style curves. Curves 

always have a starting and ending point. Curve radius and length can be automatically 

placed along the curve. Curve tables can be automatically generated to display other 

curve parameters.  

Alignments & Boundaries  
Alignments and boundaries are sequences of objects that can include points, lines, curves 

and other alignments/boundaries.  

A boundary represents an area and is generally used for things like property boundaries. 

Boundaries have an associated perimeter, area, acreage and precision of closure. The 

precision of closure is the ratio of the perimeter to the distance between the starting and 

ending point of the boundary. This information can be accessed through the 

Alignment/Boundary Info function. Compass Rule and Angle Adjust functions are 

performed on alignments.  

An example of an alignment would be a road centerline. It has a perimeter (or length) but 

no area, acreage or precision of closure.  

Graphics  
Graphics are CAD objects (opposed to “point-based” objects) such as simple arcs, lines, 

texts, etc. However, the Select Status will include the number of selected CAD lines (as 



 

opposed to connecting lines) and CAD curves (as opposed to CAD curves with the Lines 

and Crvs selected count, rather than the Grph number.  

Data Visibility  
There are several ways to control whether or not data appears on the screen. Most of the 

time, data that does not appear on the screen will not appear in a print or plot -- 

exceptions to this rule will be noted.  

Additionally, data that is not visible is also not selectable and therefore cannot be used by 

any of the COGO functions.  

Hiding Objects  
Data can be sub classified as visible or hidden. Individual selected objects can be hidden 

by using the Hide  

Objects command in the Edit menu. In a similar manner hidden objects can be unhidden 

by using the Unhide Objects command. However, to unhide an object, it must first be 

selected. To select it, you must be able to SEE it. Ooh- Catch-22! Hidden objects can be 

made visible (and, ergo, selectable) by using the Visibility command as explained below.  

 Text On/Off   
  

  

This function enables or disables the drawing of ALL text on the screen. It is accessed 

through the Text On/Off button in the toolbar. Turning the drawing of screen text off is 

useful when the user is not currently interested in textual information (like bearings and 

distances) and has a lot of data on the screen. Screen redraws can be much faster when 

text drawing is disabled. When disabled, the Text On/Off button will have a red "T" with 

an X through it. When enabled, the X disappears and the "T" is a bright green.  

Layer Visibility  
Layer visibility allows the user to turn off the display of given data types. Normally a 

different layer is associated with each basic data type (points, point numbers, bearings, 

lines, etc.) Turning off the point number layer, for instance, will hide all the point 

numbers on that layer -- which would be ALL point numbers unless the user has 

deliberately moved them to another layer. Again, data on invisible layers is not available 

to COGO functions.  

Layer visibility is accessed through the Edit Layers command in the Environment menu 

of the Main Window. The top level dialog (the dialog box initially displayed) is a table 

listing the various layers, along with their color, line width and line style. The second 

column is labeled "On". If the layer is "on", it is visible. Clicking with the mouse on this 

column will toggle the state between checked (ON) and unchecked (OFF). This state can 

also be modified from within the next dialog box that is accessed by clicking on the 

Modify button at the bottom of the Edit Layers dialog.  



 

Data Type Visibility  
Yet another way to disable the display of a specific data type is through the Visibility 

command in the View menu. This command explicitly addresses five COGO data types -- 

Points, Connected Lines, Leader Lines, 

Texts, and Curves.  

There is another check box called Show 

Graphics. Graphics are created and 

placed in the Layout portion of the 

program. If Show Graphics is checked, 

these items are visible from within 

COGO. They will normally be drawn in 

gray and they are not selectable. Visible 

and Hidden describe whether objects 

that are normally visible or hidden will 

be displayed.  

The Show Contours is similar to Show Graphics. If you don’t have the contouring 

version of the program, this checkbox will not do anything. However, if you have 

generated contours, this is a quick way to prevent contouring data (including the TIN) 

from being drawn while you’re working in COGO. Since contouring data can be time-

consuming to draw, this option can be valuable.  

At the beginning of this section, the idea of hiding and unhiding objects was discussed. 

To unhide an object, it must first be selected so that the Unhide Objects command can be 

used. Normally hidden objects are not selectable -- this is why there is a checkbox in the 

Visibility dialog box to allow the drawing of hidden objects. Likewise, it is possible to 

turn off the display of visible objects. Both of these actions should be temporary and used 

in conjunction with changing objects from visible to hidden or vice versa.  

Overlay Visibility  
Overlays can also be used to set the visibility of certain objects. Layers can control line 

types and widths, colors, and fonts in addition to visibility, Overlays control visibility and 

the order of drawing. Turning off the visibility of an overlay will hide all objects on that 

overlay.  



 

Overlay visibility is accessed through 

the Edit Overlay command in the Edit 

menu. The top level dialog (the dialog 

box initially displayed) is a table 

listing the various overlays. The 

second column is labeled "On". If the 

layer is "on", it is visible. Clicking 

with the mouse on this column will 

toggle the state between checked (ON) 

and unchecked (OFF). This state can 

also be modified from within the next 

dialog box accessed by clicking on the 

Modify button at the right of the Edit 

Overlay dialog.   

Point Symbols  
Point Symbols are the markers used to represent the actual point. The default symbol is a 

cross but other available symbols include a circle, diamond, cross in circle, and even 

letters in boxes or circles.  

Options in the COGO menu sets the point symbol to use for points yet to be created. 

Click on the  

Symbol button in the Points section which is in the middle of the dialog box to bring up 

the dialog box for editing point symbols.  



 

Clicking on the button with a picture of the desired symbol type will set that type as the 

Current Symbol type. The size of the symbol can be specified in inches. The size of the 

symbol as displayed in the COGO window is a  

function of both this size and the COGO scale (which is also set in the Options dialog 

box). If a letter or number is selected, then Circled or Boxed can also be selected which 

will  

determine if the character is enclosed by a box or a circle.  

Modify Group and Edit Individually in 

the Points menu (see p.125) can change 

the symbol of a point that already exists. 

Select the point(s) to modify before 

calling this function. If only one point 

was selected, click on the Symbol 

button. If multiple points are selected, 

enable Symbol and then click on the 

Symbols button. This uses the same 

dialog box as Options in the COGO 

menu but the changes will only affect 

the selected point(s).  

  
  
  

  

Command Line Functions  
This is a growing list that will be added to with time. If there is a function(s) not in the 

list that you desire a command line interface for, please contact us. We will happily add a 

command line for functions as requested and at no charge.  

Some commands can be issued through the keyboard. Typed in commands appear in the 

status bar (if the status bar is displayed), replacing the occupied point status until the 

<Enter> key is depressed. A command consists of a function name (usually an 

abbreviation) followed by an argument list. An argument list is computerspeak for a 

series of parameters. The type of arguments used is dependent upon the function being 

executed.  

Function entries prefixed with an * denote functions that can be accessed in the menus.  

Arguments can be of the following types:  

Ang - an angle entered as an azimuth.  

Dist - a distance entered as a floating point number.  

Float - floating point number (number with decimals such as 4.52) Pnt - a point number.  

Pnt Range - a range of points entered as a point number followed by a hyphen and then 

another point number. Example: 2-17 is a point range specifying points 2 through 17.  

Modify Group dialog box  



 

Pnt List - a list of points entered as a combination of Pnts and Pnt Ranges separated by 

either spaces or commas. Example: 1,3,5,9-13,52.  

Command  Function  Arguments  

BB  *Bearing-Bearing Intersection  Pnt, Ang, Pnt, Ang  

BS  BackSight a point (also in the Occupy dialog)  Pnt  

BD  *Bearing-Distance Intersection  Pnt, Ang, Pnt, Dist  

CS  *Create Points - by Coordinates (Coordinate Store)  North, East, Pnt*, Elevation*  

DD  *Distance Distance Intersection  Pnt, Dist, Pnt, Dist  

FP  *Find Point  Pnt  

HI  Height of Instrument (also in the Occupy dialog)  Float  

HR  Height of Rod (also in the Occupy dialog)  Float  

NN  *Next Number  Pnt  

OC  *OCcupy a point  Pnt  

PE  *Edit Individually (Point Edit)  Pnt  

PT  *Point Traverse  Pnt List  

SP  Select Point(s)  Pnt List  

UP  Unselect Point(s)  Pnt List  

TR  *TRaverse and *Sideshot  Variable - see page 132  

ZA  *Full View (Zoom All)  None  

ZI  *Zoom In  None/North,East  

ZO  *Zoom Out  None  

ZP  *Zoom Previous  None  

  



 

COGO Options  

  
COGO options are controlled through the Options function found at the bottom of the 

COGO menu. These options have far-ranging effect on the display and creation of data. It 

is therefore important to understand them thoroughly.  

Auto Data Creation  
Aln/Bnd  

When a traverse is performed, the user may optionally create alignments/boundaries. 

Automatic alignment/boundary creation can be performed when doing either a Traverse, 

Point Traverse, or a curve function.  

Line Annotation  
Pressing this button will display the dialog box shown. This function controls how (and 

if) bearing and distance text is to be placed on newly created lines. When a line is 

created, no text is placed on the line unless one or both of these options are NOT None. 

Line text can be placed in either an over/under or right/left orientation. The following 

definitions of these terms are used:  



 

 

• Right/Left - All lines have a starting and ending location. The right/left side is interpreted 

as if the surveyor were positioned at the starting location looking towards the ending 

location. This orientation is independent of drawing rotation.  

• Over/Under - This orientation is dependent upon a reference direction. Initially the 

reference direction is due north. Text is placed Over (above) the line or Under (below) 

the line relative to the reference direction. In the case of vertical lines, Over/Under is 

considered to be to the left/right of the line.  

Text will read either left to right except in the case of vertical lines, when it will be placed 

in a bottom to top direction.  

Text can be added later through the Modify Line Text (see p.115) function, so if a user 

wants to draw a lot of lines without annotation, these options should both be set to None. 

The reference direction for placement of Over/Under text is also controlled through the 

Modify Line Text function. Alternatively, the surveyor may wish to annotate created 

lines with just a distance text or just a bearing text. In this case, selecting None for just 

Bearing Text or Distance Text is appropriate.  

Back Sight Display  
The back sight can be displayed in the status bar as either an angle referenced to north 

(azimuth) or as a back sight point number. If Point Number is specified, the back sight 

point number will be displayed in the status bar unless no number is available. The back 

sight azimuth will then be displayed. Specifying Back Azimuth as the display mode will 

result in the back sight azimuth always being displayed in the status bar. The back sight 

point number, if available, will still appear in some cases. The Stake Tools, for instance, 

will always list the back sight point number if one exists.  

COGO Scale  
The default scale is used when initially placing the data in layout (after the data is placed 

in layout, the scale can be "over-ridden"). Also, the scale combines with both point 

symbol sizes and point font sizes to determine the size of a point symbol and a point font 

relative to the rest of the drawing.  

Example: if the COGO scale is 1 inch = 100 feet and the point symbol size is 0.125 

inches, then points which use that point symbol will appear to be 12.5 feet wide on the 

drawing. With the same scale and a font size of 18 points, the point number will appear to 

be 25 feet high. (There are 72 points per inch so 18 points = 1/4 inch and 100 feet/inch * 

1/4 inch = 25 feet).  

Save  
Settings made in the Options dialog can be saved by clicking on the Save button. Saved 

options will remain in effect for this project and for new projects subsequently created. 

Therefore, do not save the options if you wish the changes to apply only to this project.  



 

Default Point  
The default point symbol determines which point symbol to use for all newly created 

points and for assigning a symbol to imported point data. Point symbols can always be 

modified after creation. The other options in this section control what annotation to use 

and where to place it upon initial point creation. All of these display characteristics can 

be altered after the point has been created.  

Symbol  

For more detail, refer to Point Symbols on p.98.  

Number, Location, Elevation, Desc, Position  
These options control the Position in which the chosen parameters (Number, Location, 

Elevation,  

Description) are displayed. This initial annotation is placed in one of four quadrants 

relative to the point  

symbol, but can be moved to any desired position and/or rotation through the point 

editing function Modify Group (see p.125)  

Background Color  
The screen background color defaults to black, but can be toggled to white. A white 

background is primarily useful when using a computer with an LCD display such as a 

laptop or notebook. For CRT displays, most users will find a white background visually 

irritating when working. As an aside, Layout uses a white background, but forces all 

objects to black so as to best approximate the appearance of the data when printed or 

plotted.  

Closure Threshold  
Closure Threshold determines when a created alignment/boundary is labeled as an 

alignment or a boundary. The value of the closure threshold is the minimum value of the 

precision of closure for an alignment/boundary to be considered a boundary when 

created. The default is 25 so, with this value, an alignment/boundary that has a perimeter 

of say, 40 ft (or meters) and a distance between the first and last points that is greater than 

10 ft (meters) will be labeled as an alignment.  

Miscellaneous  
Lead. Bearing space  

If checked, a space will appear between the leading N or S and the angle in a bearing text.  

Int. Bearing space  
If checked, a space will be inserted after the degree symbol and the minutes symbol.  



 

Trail. Bearing space  

If checked, a space will appear before the trailing W or E in a bearing text.  

Numeric commas  

If checked, commas will be used to delimit numeric texts (i.e. 1,000 vs. 1000).  

Auto Resize Text  
When enabled, line and curve text will be reduced in size, if necessary, to fit the line or 

curve that the text is being placed on. If the font size necessary to allow the text to fit 

decreases below the Min. Text Size setting  

in the Environment Options dialog (see p.55), the text will not be created. The surveyor 

may wish to use a leader line when such conditions occur (see Leader Line on p.135).    

Project Functions  
New, Open, Saving a Project, and Close have already been discussed in the Main 

Window section of this manual. See p.50 for more information.  

ASCII Formats  
The ASCII Formats dialog is 

shown on the right. This 

command allows the user to 

customize the import and export 

formats for point data by creating 

new format definitions of 

modifying existing ones.  

The Format Name must be a 

unique name (one of a kind 

among  

the format definitions). In the 

example shown, the name PNEZD 

is being used (meaning Point,  

North, East, Elevation (Z) and 

Description). Picking a name 

from the drop-down list will 

display all the parameters for that format. To  

create a new name, type a new name into the text box, set all the parameters as desired 

and select Save.  

Up to six fields can be defined (even though we can’t imagine a reason for more than five 

at this time). Each field has a type, a width and a precision (Prec). The types of fields 

currently allowed are PNUM (Point number), NORTH (Northing), EAST (Easting), 

ELEV (Elevation), DESC (Description), and NONE (not the flying kind).  

Width refers to how many total characters are in the field, including the decimal point.. 

Prec refers to how many decimal places are to be used. When importing data, Width and 



 

Prec have no relevance EXCEPT when the file is Column delimited. When exporting a 

file, the specified precision will be used in creating the point data (except for fields of 

type PNUM and DESC, obviously).  

Delimiter refers to the separator used between fields. A Comma delimited file will have a 

comma after each field, whereas a space is used for Space delimited files. Column 

delimited files are a little different - fields are position-dependent. That is, they are 

aligned in columns with each column being of the character width specified by the Width 

value for the field  

If Pack Data on Write is NOT enabled, some of the above needs to be amended. Not 

enabling Pack Data on Write has no effect when importing files or when exporting 

column delimited files. However, when exporting Comma or Space delimited files, data 

is aligned in columns, much like in a column delimited file. In fact, Space delimited files 

will appear the same as Column delimited files. Column delimited files will still have a 

comma immediately after each field, but spaces will also be inserted to pad the fields so 

as to column align them.  

The Elevation and Coordinate Invalid Indicators are values which the program will 

interpret as NO VALUE. Fields that are left blank have a similar effect.  

Save will save any changes made to an existing format or create a new format if a new 

name has been entered. Close will exit the dialog box.  

Import  

Points From…  
File  

This function reads in a point 

file and inserts the points into 

the current project. The dialog 

box works similarly to the 

Open dialog box except for the 

addition of the Format and 

Filter controls. For more detail 

on the operation of this dialog 

box, refer to the Open function 

on p.50. Currently the program 

will only allow importing 

delimited ASCII files. The 

allowable formats are ASCII 

files - text files that contain point information such as northing, easting, elevation, and 

description. The format for the ASCII file is defined by the ASCII Formats command 

(see p.103). For example, in the dialog shown, the ASCII format PNEZD has been 

selected. This is the name of a format that might contain point number, northing, easting, 

elevation (Z coordinate) and description.  

Example of Import Points Dialog 



 

The Filter button will bring up a dialog box like the one shown on the right. This dialog 

is very similar to the Point Select filter (see 

p.111). The surveyor can control which 

points are imported based on any 

combination of the criteria shown (point 

number, elevation and description). The 

imported point numbers can also be shifted to 

a different starting number by enabling the 

Change starting number to: option and 

specifying some number.  

If a point in the file being imported has the 

same number as a point in the current project, 

the conflict is resolved using the options set 

in the Next Number command. Refer to the 

Next Number command on p.190 for a 

detailed description of these options.  

Data Collector  
The program can import coordinate files 

directly   from the SDR 2.x, TDS and SMI 

data collectors. 

The methods used for transferring are 

described below.  

   If you are using the TDS:  

   • On the TDS  

1) In File Transfer (menu function S), the following settings should selected:  

File type: CRD  

IR/Wire: Wire  

Baud rate: 9600  

Parity: None  

2) Select Send.  

3) Use the up and down arrows to select the file to be sent.  

   • On the Computer  

4) Set Collector to TDS.  

5) Set Port to the correct COM port.  

6) The baud rate should be 9600 (to match the TDS settings).  

7) Set the Format to PNEZD  

8) Press the Start Transfer button.  

   • Back on the TDS  

9) Press the Select button (the A button if using the HP48).  

10) After the transfer is completed, press the Cancel button in the dialog box.  

Import Points Filter Dialog  



 

   If you are using the SMI:  

   • On the SMI  

1) Select TOPC  

2) Select COMM  

   • On the Computer  

3) Set Collector to SMI  

4) Set Port to the correct COM port.  

5) The baud rate should be 9600  

6) Set the Format to PNEZD  

7) Press the Start Transfer button.  

   • Back on the SMI  

8) Select the job to send  

9) After the transfer is completed, press the Cancel button in the dialog box.  

Base Map (GMS Survey only)  
A base map is a bitmap that is geo-referenced; in other words, it has a 

predetermined location in the real world. An example would be a bitmap 

that is a part of a quad. To read in a base map:  

1. In the Cogo Window, in the Project menu, select Import... | Base Map.  

2. Set Files of type to the type of bitmap that will be read in. PC Survey can 

read in Tiff, BMP, DIB, RLE, FLF, CUT, PCX, DCX, PCT, GIF, JPEG, 

TGA, RAS, and IM8.  

3. Select the bitmap file to read in and then click Open.  

If there is a .TFW file with the same prefix as the bitmap file, the 

bitmap will be placed using the georeferencing information in the file.  

If there is no .TFW file:  

1. The hourglass will stay up and the status bar will display the message 

Click first point. Click on the bitmap at a location which you know the 

northing and easting for. A coordinate dialog will be displayed.  

2. Enter the northing and easting and any other information that you want 

and click OK.  

3. The status bar will now display Click second point. Click on the bitmap at 

a location of a second point.  

4. Again, enter the northing and easting and any other information and click 

OK.  

5. This time, the status bar will display Click third point. Click on the bitmap 

at a location of a third (and final) point.  

6. One last time enter the northing and easting and any other information 

and click OK.  



 

The bitmap should now be displayed at the appropriate location with the 

appropriate orientation.   



 

Export  

Points To…  
File  

Use this function to create an ASCII delimited coordinate file. This function will only be 

accessible when at least point exists in the project. Selecting this function will display a 

dialog similar to the following:  

  
To use this function:  

1) If exporting less than all the project’s points, select the desired set of points to be 

exported.  

2) Select Project : Export : Points To… : File.  

3) Enter a File Name and select the desired destination directory. The default file extension 

is ASC, though this may changed by entering the file name with a different extension. 

The default directory will be whatever is specified in the Options - Directory settings. 

(see p.56) 4) If exporting a selected set of points, enable Selected Only.  

5) Select the desired Format. This is one of the user-defined formats. See the ASCII 

Formats command on p.103 for more information.  

6) Select OK to create the points file.  

Notes:  

• The most common format is what the program installs as PNEZD (Point number, 

Northing, Easting,  

Elevation, Description), a comma-delimited format. Consult your target software’s 

documentation if this format doesn’t work. Just about any ASCII-delimited format can be 

defined.  

• Avoid exporting directly to a floppy drive. This is sage advice for any export. Floppy 

drives have a nasty tendency to run out of room with unpredictable results.  

Data Collector  
If you are using the TDS:  

   • On the Computer  



 

1) Select Data Collectors/DC Transfer In the Misc menu of the Cogo window.  

2) Set Collector to TDS.  

3) Set Port to the correct COM port.  

4) The baud rate should be 9600 (to match the TDS settings).  

   • On the TDS  

5) In File Transfer (menu function S), the following settings should selected:  

     File type: CRD  

     IR/Wire: Wire  

  Baud rate: 9600 Parity: None 6) Select Recv (the B key on the HP48).  

   • Back on the Computer  

7) Press the Start Transfer button.  

After the transfer is completed, press the Cancel button in the dialog box.  

Export DXF (All or Selected)  
This function saves either everything (All) or just the Selected objects (except boundaries 

and alignments) in a DXF-format file. All relational information is lost (bearing and 

distance text, for instance, becomes unattached DXF texts instead of texts that are 

associated with a parent line), so the main purpose of this function is to allow the 

surveyor to send a “picture” to another CAD program for further drawing after Survey, 

COGO and Contouring operations have been completed.  

  

To use this function:  

1) If wishing to send just selected objects, select everything that you want to send to your 

DXF file.  

2) Select Export DXF. A dialog similar to the one shown will be displayed. This is just the 

standard Windows file dialog.  

3) Specify a file name and location and select OK.  



 

Notes:  

•  The Options - Directories settings control what directory is initially used. See p.58 for 

more information.  

Base Map  
A base map is a bitmap that is geo-referenced; in other words, it has a predetermined 

location in the real world. An example would be a bitmap that is a part of a quad.  

To export a base map:  

1. In the Cogo Window, in the Project menu, select Export... | Base Map.  

2. The only type of file that this function will export is a monochrome BMP file. Type the 

name for the bitmap file and then click Save. A file with that name will be written out as 

well as a file with the same prefix but ending with .TFW. The .TFW file will have the 

geo-referencing information.  

3. Printing/Plotting  

Printing or plotting from the COGO window involves the same steps that are used in 

other Windows programs. Using the Print function in COGO is only good for generating 

screen prints. If a more finished appearance is desired, use the Layout Window functions 

(see the section on the Layout Window beginning on p.193). The first step is to install 

your printer/plotter by connecting it to either a serial or parallel port on your computer.  

Make sure that you have installed the 

printer you want to use and that the 

Windows control panel has set the 

printer as the current default printer 

before executing Print. When Print is 

selected from the Project menu, a 

dialog similar to the one shown on the 

right is displayed:  

At the top of the dialog is shown the 

current target printer on your system. 

Ignore the Print Range settings - The 

program doesn’t use them for COGO 

printing and we’re too lazy to get rid of 

them right now (maybe later, after 

about a zillion other “enhancements” are made). Refer to your Windows user manual if 

the other settings don’t make any sense to you. (and ignore the Collate Copies checkbox - 

this belongs in la-la land as well).  

If you wish to use a different printer that has been configured and is connected to your 

system or to change the current printer’s settings, select Setup.  



 

  
You get this really ugly dialog to play with. You can enable Specific Printer and select a 

printer from the list. Some printers provide more control through the Options button. 

Again, this is better left to the realm of the Windows user manual since dinner is on the 

table and my fingers are cramping.  

Data Selection  
Many of the functions operate on what will be called the select list. The select list is just 

a collection of points, lines, curves, texts and/or alignments/boundaries. As talked about 

in the User's Guide, selecting is done by drawing a select box (clicking and dragging with 

the left mouse button from left to right). Any objects within the box or intersecting the 

box will be selected UNLESS they are 1) not visible or 2) excluded through the select 

filters. Objects that are selected will be highlighted; that is, they will be drawn in 

magenta and lines and curves will be thicker.  

For instance, the user can exclude points with numbers in a certain range from selection. 

In a more complex scenario, the user can select points based on their number, elevation 

and description. Similarly, the other data types also have filters that operate based on the 

data type's attributes.  

Selection of a given data type can be completely disabled by graying the number next to 

that type's filter button. There are five numbers in the select status bar, one for each of the 

five basic data types -- Points, Lines, Texts, Curves, and Alignments/Boundaries. The 

number indicates the number of objects of the associated data type that are currently 

selected. Normally these numbers are black, indicating that the data type associated with 

that number is selectable (though possibly filtered). By clicking with the left button in the 

number box, the number will toggle between black and gray. When the number is gray, 

selection of the associated data type is disabled. So, to select (or unselect) just lines, 

disable all other types of data by graying the numbers for Points, Texts, Curves and 

Al/Bd.  

Unselecting is done in a similar manner to selecting -- only instead of drawing the 

selection box from left to right, the box is drawn right to left.  

Radial Select  
There is an additional mode for selecting called Radial Select. This is done by selecting 

the Radial Select command from the View menu. In this mode, when a click-and-drag is 

performed with the left button, a circle will be displayed around the occupied point 



 

instead of a box. This circle is currently not visible until the mouse is moved. The objects 

inside the circle will be selected or unselected depending on whether the cursor is moved 

to the right or the left. This function is generally used with the Stake Tools functions and 

is useful for getting all points within a desired radius. In the Radial Select mode, when a 

click-and-drag is performed, the coordinate readout shows the word Radial in the left 

box and the radial distance in the right box.  

Clear select  
Unselects all selected data.  

Select Status bar  
This section describes the various parameters in the COGO selection filters. These filters 

are accessed by clicking on the appropriate button in the select status bar located at the 

bottom of the screen (when enabled). The select status bar can be turned on or off by 

toggling the command Select Status Bar in the Misc menu.  

The left side of the select status bar is the coordinate readout. To the right of this readout 

are five buttons, each with a number displayed to the right of it. Finally, at the far right 

are three buttons: A, N, and C. The A button stands for ALL. Clicking on this button will 

enable the selection of all types of data. The N button stands for NONE. Selecting this 

button disables the selection of all data. Finally, the C button stands for CLEAR. 

Clicking this button unselects everything that is selected -- it is provided as a quick way 

to reset the select list. Clear Select in the Edit menu performs the same function.  

These three buttons allow one to quickly set the selectability of a given type of data. For 

instance, if it is desired to allow only the selection of point data, one could turn off the 

other four types by clicking once in each of the four boxes to the right of the buttons for 

lines, texts, curves and alignments/boundaries.  

However a faster method is to click once on the N button to turn all five data types off 

and then clicking once on the points selection number to enable points filtering.  

Points Filter  
The Points Filter allows filtering the selection 

using the attributes Point Numbers, Elevation, 

Description and/or Symbol. The filter can be 

used to include or exclude points with that 

attribute.  

Each of these attributes has a checkbox in front 

of it. The checkbox must be enabled before the 

attribute will be used as a filter. In this manner 

any combination of attributes is allowed. If, for 

example, filtering is desired using only Point 

Numbers, then check the Point Numbers 

checkbox while leaving all the others 

unchecked.  

The Include and Exclude radio buttons (one 

and only one can be selected) specify whether 

to select only points that include the enabled 

(checked) and specified attributes.  



 

Point Numbers can be entered as a series of values that include range values. Commas or 

spaces can  

be used to separate values. For example, entering  

1,3,5-7 will specify points 1, 3, 5, 6 and 7. “5-7” is a range value. If Include is selected, 

only these five points will be selectable. If Exclude is selected, all points EXCEPT these 

five will be selectable.  

The Description can be a regular expression (see p.192) so that the surveyor can use a 

string pattern such “Iron Pin ?” to find all points with descriptions that start with “Iron 

Pin” followed by a space and some other character (Iron Pin 1, Iron Pin B, etc.).  

Example: Suppose that when you draw your selection box you only want to select points 

between 15 and 40 whose description is anything other than "Iron Pin". To do this, click 

on Point Numbers to enable filtering based on point numbers. Set the point number range 

to 15 to 40 by typing in 15-40 and click on Include so that only those points will be 

selectable. Leave Elevation alone so that it will not affect the filtering. Click on 

Description to enable filtering based on description, type Iron Pin in the description box, 

and click on Exclude so that points with these descriptions cannot be selected.  

Lines Filter  
The Lines Filter allows filtering the selection of lines by using the type of line and/or a 

range of line lengths. Connected, Leader, and Polyline refer to the type. Has Leader 

refers to connected lines which have leader lines. The Length Filter allows including or 

excluding lines with a length within the specified range.  

  

  

  

  



 

Text Filter  
The Text Filter allows filtering text selection by the type of parent, the drawn angle of 

the text, and the text font size. For instance, text selection can be limited to only distance 

texts that have a point size between 8 and 12 points.  

  

  

  

  

  

  

  



 

Curves Filter  
Curves Filter allows filtering the selection of curves by using the type of curve and/or a 

range of arc lengths. Has Leader refers to connected curves which have leader lines. CW 

is  

clockwise while CCW is counterclockwise. The Angle Filter allows including or 

excluding curves with an arc length within the specified range.  

Al/Bd Filter (Alignments & Boundaries)  
The Al/Bd Filter allows filtering the selection of alignments/boundari es by many 

features. Boundary and  

Alignment control whether to include boundaries and/or alignments. w/  

Vertical Control and w/o Vertical Control decide whether to include alignments with and 

without vertical controls. w/ curves and w/o curves control  

whether to include alignments/boundaries with and without curves. Length/Perimeter 

controls whether to include or exclude alignments/boundaries whose length is in the 

specified range. Number of Segments controls whether to include or exclude 

alignments/boundaries whose number of segments falls in the specified range. Area 

controls whether to include or exclude boundaries with an area within the specified range. 

Description controls whether to include or exclude alignments/boundaries with the 

specified name.  

    



 

View Functions  
See the section on Common View Functions on p.38 for information about Redraw 

Screen, Full View, Pan View, Zoom In, Zoom Out and 

Zoom Back.  

Find Point  
Find Point will prompt for a point number. When you click Zoom, the view will change 

so that it is centered on the point you  

specified. Successive clicks on Zoom will cause the display to  

“zoom in” (hence the button’s name, Zoom. Bet you didn’t get that one, huh?) on the 

specified point. Select Done when you’ve had  Find Point Dialog  

enough and the function will terminate. (Wish I could do that with certain politicians).  

Command: FP Pnt  
The FP accepts a single point number as an argument. The command can be repeated to 

zoom in closer to the desired point by either typing entering the command without an 

argument or pressing the spacebar followed by the <Enter> key.  

Example:  

1) Type FP 13 <Enter> to center the display point 13 (assuming point 13 exists).  

2) Type FP<Enter> OR <Spacebar><Enter> to zoom in on point 13.  

3) Repeat the above step to zoom closer.  

View Areas  
View areas are helpful when there are specific areas of the data to which you will refer 

often. They are also used in layout for placing a view of a specific portion of the data. 

Refer to the View Area function in the Data section of the Layout portion of this manual 

for more information.  

Add  
Add View Area will first ask for the name to assign to the 

view area that you are about to create. Then the cursor will 

become a P-cross to show that the program is waiting for a 

button press. Draw a box around the view just as you 

normally do for zooming in. After pressing the left button, 

the cursor will change to an R-cross. After releasing the left  

button, the cursor will return to normal and the view will zoom in to the view specified. 

The view will also be saved as a view area that can be referred to later.  



 

Select  
Select View Area will display the list of defined view areas. 

Upon selecting an item from the list, the view will be set to 

the selected view area.  

Delete  
Delete View Area will also display the list of defined view 

areas. This time, after selecting a view area from the list, it 

will be deleted from the list of view areas in this project.  

  

Overlays  
Whereas layers can control line types and 

widths, colors, and fonts in addition to 

visibility, Overlays control visibility and the 

order of drawing. Turning off the visibility of 

an overlay will hide all objects on that 

overlay. (Precedence or order of drawing has 

not yet been implemented.)  

Overlay attributes are accessed through the 

Edit Overlay command in the Edit menu. 

The top level dialog (the dialog box initially 

displayed) is a table listing the various 

overlays, along with their visibility and order 

of precedence.  

Visibility  
The second column of the Edit Overlay function dialog box is labeled "On". If the layer 

is "on", it is visible. Clicking with the mouse on this column will  

toggle the state between checked (ON) and unchecked (OFF). This state can also be 

modified from within the next dialog box accessed by clicking on the 

Modify button at  

the right of the Edit Overlay dialog.  

Order (Precedence)  
The precedence number refers to the order in which the overlays are 

drawn.  

The larger the number, the earlier the items on that overlay will be 

drawn. Think of an overlay as a transparent sheet on which are 

drawn various objects. Overlays are like transparent sheets stacked on top of each other. 

The larger the number, the lower the sheet is in the stack and the more likely it is to be 

obscured by data on sheets with lower numbers. An overlay number of zero means that 

no other overlays can obscure it. This is used when you want an object to appear to be 

behind another object.  



 

Extracting to Layers and Overlays  

  
Extract Objects to Layer and Extract to Overlay are used to move data items from one 

layer or overlay to another. Both operate on the select list. Extract Objects to Layer will 

ask for the destination layer and will move all selected objects to the specified layer. 

Similarly, Extract to Overlay will ask for the destination overlay and will move all 

selected objects to the specified overlay.  

Edit Functions  
Modify Line Text  

 

Modify Line Text in the Edit menu alters the appearance and placement of bearing and 

distance text. All selected lines are affected.. The direction of the selected lines can also 

be reversed from within this dialog.  

If you have one or more lines selected, you can set all bearings for the lines Over, Under, 

Right or Left, remove them (None), or leave them unchanged. The same applies to the 

distances. To change the current text placement, enable the appropriate check box and 

select one of the five options. Leaving the  

Bearing/Distance Text checkboxes disabled (unchecked) leaves the bearing/distance text 

unchanged.  

When using the Over or Under options, the Orientation Angle is used to determine the 

placement of the text. The Orientation Angle defaults to 0° so the Over is towards the top 

of the screen and Under is towards the bottom. However, when placing the data on sheet 

in Layout, it is often desirable to rotate the view in order to better fit the sheet. In such 

cases, it will also often be desirable to adjust the up/down orientation of the 

    

    



 

bearing/distance text. When data has been placed in the Layout window, the Use Layout 

Orientation checkbox will become enabled IF  

1) There is one data view placed, or  

2) There are more than one data views placed but all with the same rotation angle  

Checking the Use Layout Orientation box will set the Orientation Angle to the rotation 

of the data view. If the Bearing Text and/or Distance Text options are enabled, as well as 

the Over and/or Under options, the text will be placed with respect to the rotation of the 

data view’s rotation in Layout.  

Checking Reset Position will reset the bearing and/or distance texts back to their original 

positions.  

Checking Reset Units has an effect only if the system units have been changed. For 

instance, if the system units have been changed from US Foot to Metric (see the Units 

dialog on p.59), distance text that has already been created will remain in US Foot units.  

Checking the Reverse Direction box will cause all selected lines to change direction by 

180°. The bearing text will updated accordingly.  

Notes:  

• If you are sitting on the starting point of a line and facing the next point, Right means the 

text is on the right side of the line and Left means the text is on the left side of the line.  

• The default bearing/text placement is controlled by the Line Annotation (p.100) dialog in 

the COGO Options function.  

Trim  
The Trim function is used to clip off pieces of graphics (lines, curves, polygons, etc.) at 

the intersections with other graphics. To use this function,  

1) Select both the objects to trim AND the objects to the trim at.  

2) Select Edit | Trim in the COGO window. A dialog will be displayed similar to the one 

shown.  

3) Move the cursor near the pieces of the selected objects that you wish to delete and left-

click. The piece will be highlighted. This action is a toggle. Left-clicking near a piece that 

has already been highlight will unhighlight that piece.  

4) When all the pieces that are to be trimmed have been highlighted, select OK from the 

Trim dialog.  

  



 

  

  

Example:  

The simple drawing shown consists of an 

arc and two lines. Assume that one wishes 

to trim off all the end pieces. First, select 

everything (both lines and the arc). Then, 

left-click near each end piece.  

  

  

  

  

  

 

  

Line Style  
The Line Style command can be used to quickly modify the line style of selected lines 

and/or curves. Lines and curves are given the line style of their layer when they are first 

created. However, any given line or curve's line style can be modified with this function. 

At least one line or curve must be selected in order for Line Style to be accessible. 

Selecting Line Style will bring up a dialog box containing several buttons as shown.  

  

At this point, all the end pieces should    

be highlighted, similar to the picture    

shown . Finally click on the    OK   button    

to complete the function.    

    

    

    

    

The final result would be this.       

    

    



 

  
Simply click on the button that contains the desired line style, followed by OK to change 

the line style of all selected lines and curves or Cancel to abort the function.  

Set Color  
The Set Color function in the Edit menu allows the surveyor to set the 

displayed color for all applicable selected objects. This includes points, 

lines, texts and curves. Since objects use the layer color settings when 

created, using this function will override the default color attributes. See 

the section on Layers on p.27 for more information.  

To use this function:  

1) Select all the objects that are to have their color altered.  

2) Select Set Color from the Edit menu. The dialog shown will be displayed.  

3) Select the desired color from the dialog or select Reset to default to change 

the objects’ color back to the objects’ default layer color. 4) Select OK to 

complete the function or Cancel to abort.  

•  

Set Layer  
The Set Layer functions in the Edit menu allow the surveyor to set the layer for all 

applicable selected objects. This includes points, lines, texts and curves. Set Layer has a 

submenu with two entries - Default and Other.  



 

Set Layer - Default will set the layer of all selected objects 

to their default. When using the layer definitions as provided 

with the program, for instance, selecting Default will change 

selected bearing texts to the Bearing layer, selected distance 

texts to the Distance layer, selected arcs to the Arc layer, etc.  

Selecting Set Layer - Other will display a dialog box similar 

to the one shown to the right. Select the desired layer from 

the list that the objects are to be moved to. Select OK to 

finish the operation or Cancel to abort the function.  

  

See the section on Layers on p.27 for more information.  

Select Layer - Other Dialog  

Delete Objects  
Delete Objects in the Edit menu will delete all selected objects from the project.  

Undo  
Undo in the Edit menu will undo the last command executed. Currently, there is not a 

one-to-one correlation between the command invoked and the undo command. Suppose, 

for example, that you delete three points.  

 Undo will only add them back in one point at a time.    

Point Functions  

Create Points - Array  
This function is generates a two 

dimensional array of points. The 

array doesn’t have to be square. To 

use this function:  

  

1) Select Create Points - Array from 

the Points menu.  

2) Specify an origin (corner of the array) either by  

• Selecting Point, followed by entering the point number or selecting the desired point 

from the screen with the mouse.  

         or  

• Selecting North/East and entering the North and East coordinate values.  

3) Enter the Angle of the 1st Direction. This angle specifies the direction of one of the sides 

of the array where one end of the side is the array’s origin.  

4) Enter the Distance between each point in the 1st Direction.  



 

5) Enter the # Pts (number of points) to insert in the 1st Direction.  

6) Repeat these steps for the 2nd Direction.  

7) Select OK to generate the array or Cancel to abort the function.  

  

Create Points - Array Example  
In the example shown, a 1st Direction of 90° with 7 points and a 2nd Direction of 225° 

with 4 points is used. The Distance values were the same (25 feet, in this case).  

• Notice that the point numbers along in the 1st Direction and then skip down to the next 

“row” in the direction of the 2nd Direction.  

• When using the Point origin option, the point number defaults to the current occupied 

point.  

Create Points - Box Corner  
Given three points representing the three corners of a box (actually a parallelepiped), this 

function will create a point at the remaining corner. To use this function:  

1) Select three points in the map. EXACTLY three must be selected - no more or less.  

2) Select Create Points - Box Corner from the Points menu.  

The fourth point will be created.  

Notes:  

• A parallelepiped is a four-sided figure with opposite sides parallel (and therefore of equal 

length) to each other. A rectangle (box) is simply a parallelepiped with 90 degree corners.  

• The Next Number settings will be used for the fourth point’s point number. The elevation 

will be set not be set.  



 

Create Points - By Coordinates  
Create Points - By Coordinates in the 

Points menu allows creating points 

by specifying the northing and 

easting values. The Elevation and 

Description are optional fields. 

Elevation will not be enabled 

(editable) unless elevations are 

enabled in the Environment Options 

dialog. The default point symbol, 

shown to the right of the Symbol 

button, will be used unless a different 

symbol is chosen. Symbols can be 

chosen by selecting one from the 

symbols dialog that is displayed when 

clicking on the Symbol button. If you 

want to create more than one point at 

a time, click Continue after each 

point. Click OK to create this point but no others. Click Cancel to stop creating points, 

including the current one.  

Command: CS Northing Easting {Pnt} {Elevation}  

Create Points - Random  
Create Points - Random in the Points menu can be used for rapidly 

creating a set of points to play with or for use with a digitizing pad 

to enter points from an existing plot. The  

 dialog 

box allows you to just create points or to create both points and lines. To use this 

function:  

1) Select Create Points - Random from the Points menu. The dialog box shown to the right 

will appear.  

2) Select Points Only if it is desired to just created random points without connecting each 

succeeding point with a line from the previous point. Leaving this option unchecked will 

result in connecting lines being drawn (and annotated with bearing/distance text if 

automatic annotation is enabled in the COGO - Options dialog - see p.100).  

3) Enter a value for Elevation if it is desired to create points with an elevation value. 

Leaving this value blank will cause all created points to be essentially two-dimensional 

(no assigned elevation). The Elev value affects only points created after the Elev value 

has been altered.  

4) Left-click in data view window to create a point at (or near, if the snapping options are 

enabled - see p.33) the cursor location.  

5) Select Done to exit the function.  

The following notes apply:  



 

• Each new point will become the occupied point.  

• The options (Points Only and Elev) can be altered at any time.  

• This function can be used in conjunction with the Grid/Snapping functions to create 

points at intersections, midpoints, endpoints, etc. by clicking near the desired object(s).  

Create Points - Station/Offset  
This function creates points at 

specified station and offset values 

relative to all selected 

alignments/boundaries. Points can be 

created at regular station intervals or 

 offset  locations.   

 Individual station/offset 

values can be specified at the same 

time. To use this function:  

1) Select a alignment(s)/boundary(s)  

2) Select Create Points - Station/Offset 

from the Points menu. A dialog 

similar to the one shown will be 

displayed.  

3) To create the points, an offset(s) must be specified. Enter the offset  

value(s) in the Offsets edit box.  

Multiple values can be separated by spaces or commas. Positive values specify offsets to 

the right, while negative values specify offsets to the left of the alignment/boundary.  

4) Select Mirror to create points at the negative of all specified Offsets values. For instance, 

entering an offset value of 10 and enabling Mirror will result in the creation of points at 

offsets of 10 AND -10.  

To create points at regular station intervals,  

5) Enter the station value to begin creating points at in the Start at: edit box.  

6) Enter the station increment value in the Increment by: edit box. If point creation at 

regular station intervals is NOT desired, enter 0 (if not already 0).  

7) Enter the station ending value in the End at: edit box. An empty or 0 value will cause 

points to be created up to the end of the alignment/boundary.  

Individual Stations values are station values that are not included in the Multiple 

Stations specification. Individual Stations would be used when specifying a single 

station/offset pair, for instance.  

8) Enter Individual Stations values (if any) in the Individual Stations edit box. If entering 

multiple values, separate them with either a comma or space.  

9) Select OK to create the points or Cancel to abort the function.  

Notes:  



 

   • Station values can 

entered as either floating point values (i.e. 25.5) or in station format (i.e. 00+25.5).  

Create Points - Digitize  
Use this function to input points from an existing drawing using a digitizing tablet. This 

approach is viable when only a relatively rough approximation to the original data is 

necessary. Digitizing from a drawing with a 1”=100ft scale, for instance, can easily 

produce location errors of 5 feet, assuming a point error of 1/20” in aligning the tablet’s 

point device (puck, stylus or whatever).  

To use this function,  

1) Place the plat on the digitizer. The area to be digitized must lie within the area of the 

tablet that is used for the Windows cursor control. Attach the plat with tape or use some 

other method that will prevent the paper from shifting during the digitizing process. 

Placing brick over the center of the paper is probably not a good idea since you’ll 

probably obscure the area you’re trying work with. Avoid using Super Glue as well.  

2) Select Create - Digitize from the COGO Points menu. A “Click first point” message will 

appear in the status bar, prompting for the first reference point.  

3) You now must provide three reference points from the plat along with their coordinates in 

order to calibrate the Digitize function. No two of the three points can lie along either the 

horizontal or vertical axis of the digitizer.  

4) Left-click on the first reference point. A dialog will appear, prompting for the point’s 

coordinates. This is the same dialog as used in the Create - By Coordinates function (see 

p.120). Enter at least the Northing and Easting values. The elevation value and other 

settings can optionally be modified at this time Select OK to continue.  

5) Continue this process for the second and third reference points. The status bar will 

prompt for each point with a “Click second point” and “Click third point” message.  

6) After entering the third point, the select status bar will be replaced with a series of edit 

boxes that allow for the insertion of point number, elevation and description data. The 

data that is entered in these boxes will be applied to every subsequent point that is 

digitized. Enter the values that you wish to use for the points you are about to digitize.  

7) Left-click with the tablet’s pointing device at the desired points on the map. If the point is 

within the viewing range of the screen, it will be displayed. If not, it will still be created, 

but you won’t see it appear on the screen until you finish and zoom out.  

8) Continue digitizing until done. The point number, elevation and description information 

can be altered at any time.  

9) Press the <Esc> key or left-click on the X button in the status bar area to exit this 

function. The select status bar will reappear at this time.  

  

Notes:  

• When digitizing contour data, digitize the points of each contour sequentially and avoid 

the necessity of constantly changing the elevation value.  



 

• The Digitize function will automatically handle the rotation angle of the plat on the sheet, 

so it is not necessary to perfectly align the plat with respect to rotation angle. Just slap the 

thing on the digitizer any old way that is convenient.  

Points Inverse  
This function inverses between points and generates 

a report.  

1) Select Points Inverse from the Points menu. A 

dialog similar to the one shown will be displayed.  

2) Type in the sequence of point numbers to inverse 

between.  

Point In Direction  
Point In Direction in the COGO 

menu will create a new point that is 

a given distance along a given angle 

away from another point. To use 

this function,  

1) Select Point In Direction from the 

COGO menu. The first dialog that 

will appear is the Line Define 

dialog, used to establish the 

direction for this function. See the 

section on Line Define on p.31.  

2) After defining the angle, click on OK and the 

dialog box will be replaced with another one in 

which you specify the Distance of the new 

point from the source point as well as the New 

Point #, Elevation, and Notes for the new 

point. Iterations will default to 1. Increasing 

this value will add one point for each iteration 

at the Distance value from the previous  

point. Enabling Connect will result in  

 lines being 

created between each successive point.  

3) To create the new point(s) and quit, click on the OK button. To quit without creating this 

point(s), click on the Cancel button. To create the new point(s) and then continue to 

create another point, click on the Continue button. After selecting Continue, the values 

can be changed while maintaining the same defined direction. Additional points will be 

placed relative to the last created point.  

Each new point will continue in the same direction and the direction will be from the 

previous point. The distance for each successive point will default to the same value as 

for the previous entry, but it can be  

changed.  



 

Copy/Renumber  
This function can be used both to create a copy of 

all points that are selected as well as to move a set 

of selected points to another point range (a 

renumbering function). When trying to create the 

new point numbers, the Next Number (see p. 190) 

settings are used.  

The Overlay field, if empty will default to the Base 

Overlay. Optionally, the surveyor can select a 

different overlay, if other overlays have been 

created, from the drop-down list.  

The Starting Point Number defines the first point 

number to use as the destination of the copy. If for 

instance the Starting Point Number is specified as 25 and the lower number of the 

selected points is 4, then point 4 will be copied to point number 25.  

Enabling Keep Point Number Spacing will maintain any numbering “gaps” that may 

exist in the selected point numbers. Example: points 2, 5, 6 and 8 are selected. If the 

Starting Point Number is 25, the new point numbers (assuming they haven’t been 

already used) will be 25, 28, 29 and 31 if Keep Point Number Spacing is on. If it is off, 

the new point numbers will be 25, 26, 27 and 28 (again assuming that those numbers are 

previously unused).  

The Retain Old Points has the following behavior  

• If enabled, this function is truly a copy function - a duplicate of the selected points is 

made, albeit with different point numbers.  

• If not enabled, this function acts like a renumbering function, moving the points to a 

different set of point numbers.  

Selecting OK executes the function while selecting Cancel will abort the function (as 

usual).  

  

  

Copy Selected Points Dialog 



 

Editing Points  
Edit Individually  

Edit Individually in the Points menu allows the user to change the parameters of all 

selected points the selected points.  

If just one point is selected, a single dialog box will appear.  

If more than one point is selected, the dialog box will appear for each point in order of 

their point number until all the points have been presented for editing or the surveyor 

Cancels the function. The same dialog box as for a single selected point except for all 

points except the last in the list, the OK button is replaced by a Next button. Additionally, 

the title of the box will provide information on the current point being modified and how 

many points are left (by displaying a message of the form "3 of 32" in the title  

bar). Selecting Cancel will keep all changes made except to the current point. The dialog 

box will allow the  

user to set the North, East, Elevation (if enabled), Notes and Symbol. The Display 

checkboxes control which text information about the point will be displayed in the 

COGO window. Any combination of Number, Location, Elevation, and Notes can be 

selected. All of these texts are displayed on the point number layer. The Position refers to 

the placement of the point text (such as number) relative to the point symbol. When 

Default Text on, the point text will appear in whichever quadrant is selected in the 

Position control (relative to the point). Turning off Default Text allows the surveyor to 

move and rotate the point text to any desired position in the drawing. Default Text is 

normally on in order to conserve memory.  



 

Modify Group  
The Modify Group option is useful for applying the same parameters or values to a group 

of points. In this dialog, the positions and elevations cannot be changed. However, the 

notes can be changed by enabling Desc 

and entering the notes in the edit box. 

These notes will be attached to all 

selected points. A symbol can be used for 

all the points also by checking the 

Symbol checkbox and selecting the 

desired symbol. Setting the Display and 

Position are the same as for a single point 

but also apply to all selected points. See 

the Edit Individually section above for 

more information.  

For more information on changing the 

symbol, refer to the Point Symbols 

section on p.98.  

  

Edit Data  
This function is useful for editing the point data - northing, easting, elevation and 

description. Edit Data uses a spreadsheet-style editor with each point’s data occupying a 

separate row of the spreadsheet.  

  



 

To use this function:  

1) Edit Data can edit either ALL the COGO points or just the selected points. Therefore, if 

the surveyor wishes to edit just SOME of the COGO points, it can be easier to first select 

the points that are to be edited.  

2) Select Edit Data from the Points menu. A dialog box similar to the one shown above will 

appear.  

3) Select either All or Selected Only for either viewing ALL the point data or just the 

selected points’ data.  

4) Double-click on the value or description to be edited. The value can then be changed by 

simply typing in a new value or description.  

5) Continue editing until satisfied.  

6) Select Print to send the spreadsheet to the printer, if desired.  

7) Select OK to accept the changes or Cancel to abort the function.  

Notes:  

• The Elevation column will appear only if the Use Elevations option is enabled in the 

Environment - Options dialog.  

• Point numbers cannot be edited in this function.  

Stake Tool - Radial  
Stake Tool-Radial in the Points 

menu creates a list of angles, 

distances, and elevation changes for 

a set of points based on a given 

occupy point and backsight. To 

create the list, select the points that 

will go in the list before calling 

Stake Tool-Radial. The Occupy 

Point will default to the current 

occupy point. This value can be 

changed either by typing in a new 

value or clicking near the desired 

point while the occupy point box has 

the focus. The Back Sight value will 

default to the current back sight point  

The horizontal Angle format can be in one of five formats: Direction, Angle Rt, Angle 

Lt,  

  

Deflect Rt and Deflect Lt. Pick the desired format from the dropdown list box before 

selecting Display or OK.  



 

  

Stake Tool Display Sample  

After setting these initial values, if you click on the Display button, another dialog box 

will be displayed showing each selected point, the angle of the specified type, the 

distance from the point to the Occupy Point, the point coordinates, description (if any) 

and the elevation difference between the Occupy Point and the new point. Click OK to 

remove this dialog box.  

If you want to write this information out to a file, use the Select File button to specify an 

output file. Select either Table or Delimited ASCII for the format of the file to be written. 

The Table format was designed for printouts and the Delimited ASCII format facilitates 

data transfer to other programs. When you click on the OK button, if a File Name is 

specified, a text file containing the stake information will be placed in the same directory 

as the current project if a complete path (file name and directory location) is not 

specified. The file can be viewed and printed from any editor including the NotePad 

application in the Windows accessories.  



 

Stake Tool - Curves  

  
The Stake Tool for Curves allows the surveyor to stake a curve(s) at specific intervals 

along the curve’s length. The output specification is similar to that of the Stake Tool for 

points with one exception. There is an option to allow staking curves By Direction (just 

like points) or by Tangent Offsets (tangent distance and offset distance).  

The Stations section of the dialog allows the surveyor specify a starting offset from the 

PC. For example, if a  

Start at value of 00+10 is used, the first stake point will be placed at an arc length of 10 

feet/meters from the  

PC. The Increment by value specifies the interval for placing stake points. For example, 

if a value of 01+0.00 is used, stake points will be placed every 100 feet/meters along the 

curve after the Start at value.  

If additional stake points are required at some irregular interval, these can be specified in 

the Additional edit box, separating each station by a comma. For example: 00+17.6, 

01+23.6, etc.  

The Stake Tool for Curves will create COGO points at the specified locations if the 

Create COGO points option is checked. The values can be displayed on the screen by 

clicking on the Display button. Selecting OK will create the file specified in the Select 

File dialog, while Cancel returns to the program without creating the file.  



 

  

Station/Offset Report  
Use this function to calculate the station and offset values of a set of selected points 

relative to a selected alignment.  

To use this function:  

1) Select the alignment that will be used to calculate the station/offset values from.  

2) Select the points whose station/offset values are to be calculated.  

3) Select Points - Station/Offset Report. A report dialog similar to the one below will be 

displayed.  

4) Select OK to close the report. Select Print to print the report or Save As to save it to a file 

for later use. Select Log to save the report in the log file.  



 

  

Related Subjects:  
Creating alignments - see p.155  

Line Functions  

Traverse/Side Shot  
Traverse and Side Shot in the COGO menu create both points and lines at a given angle 

and distance from the current occupied point. If automatic boundary creation is enabled, 

then the new lines will be inserted in boundaries by Traverse but not by Side Shot. 

Changing from Traverse to Side Shot mode is as simply as clicking on the button labeled 

Side Shot if you are in Traverse mode or on the button labeled Traverse if you  

 
are in Side Shot mode. The type of data expected by the dialog box for positioning the 

new point depend on the mode selected which is explained in the following section on 

Options. Notes for the new point can also be entered. To create the new point and quit, 

click on the OK button. To create the new point and then create another point, click on 

the Continue button. To quit without creating this point, click on the Cancel button.  



 

Options  
Clicking on the 

Options button 

brings up a dialog 

box that allows 

selecting the 

modes to use for 

entering the angle 

and distance. To 

use the current 

modes for other 

projects, enable the 

Save as Default 

feature.  

The angle modes 

are  

Azimuth, Angle 

Right,  

Angle Left, Deflection  

Right, Deflection Left, and Bearing/Quad. Azimuth mode will traverse an angle that is 

the number of  

degrees clockwise from  

north. Angle Right and  

Angle Left mode will traverse an angle that is the specified number of degrees clockwise 

or counter clockwise, respectively, from the backsight. Deflection Right and Deflection 

Left will traverse an angle that is the specified number of degrees clockwise or counter 

clockwise, respectively, from the foresight. The foresight is just the 180 degree reverse of 

the backsight, so a backsight of 270 degrees will mean a foresight of 90 degrees. 

Bearing/Quad mode will traverse an angle that is the specified number of degrees from 

north or south in the specified quadrant.  

The distance modes are Zenith/Slope Distance, Nadir/Slope Distance, Vertical 

Angle/Slope Distance, and Horizontal Distance. For Zenith/Slope Distance, a distance 

and a zenith angle need to be entered. The zenith angle is the number of degrees from 

vertically up. The distance is the distance from the starting point along the zenith angle to 

the new point. For Nadir/Slope Distance, a distance and a nadir angle are entered where 

the nadir angle is the number of degrees from vertically down. For Vertical Angle/Slope 

Distance, a distance and a vertical angle are entered where the vertical angle is the 

number of degrees from horizontal. For Horizontal Distance, the horizontal component 

of the distance is entered. When Horizontal Distance mode is selected the Elevation 

Entry modes become enabled. The surveyor can select whether he wants to enter 

elevations as Direct (absolute values), Difference (change in elevation from station’s 

value), or None (no elevation value at the foresight point). If elevations are not enabled, 

no elevation entry is allowed.  

Horizontal distances are multiplied by the Scale Factor value, so a value greater than 1.0 

will increase the input distance value while a Scale factor less than 1.0 will decrease 

distance values. This can be useful when transforming ground measurement values to 

state plane values. Similarly, any Rotation factor other than 0 will alter the horizontal 

angle value by adding to it the specified value.  



 

The Line Creation settings control whether lines will automatically be created from the 

occupied point to the foresight point. Traverse line and sideshot line creation can be 

individually controlled. For instance,  

enabling Traverses and disabling Sideshots will cause lines to be added for each traverse 

leg will only created points at the foresight for sideshot entries.     



 

The Traverse/Sideshot Command Line  
The command line for the Traverse and Sideshot commands is very involved and 

therefore merits a special section to describe it. Unlike the Traverse/Sideshot dialogs, the 

command line permits the input of curve data as well as normal shot data. The command 

line is a much faster method inputting data than the dialogs, so it is highly recommended 

that the surveyor study this section closely.  

The command syntax for entering traverse and sideshots from the keyboard is: TR Ang 

{Mode} Dist {VA} {Pnt} {Desc}  

The following applies when entering traverses and sideshots:  

• Ang is a horizontal angle. It can be an azimuth, bearing or turned angle with its 

interpretation depending on the current Mode.  

• Mode is an optional digit from 1 to 8 and controls how the command information is 

interpreted. The various mode values are as follows:  

Mode  Ang  Dist  

0  North Azimuth  Normal  

1  Bearing in quadrant 1  Normal  

2  South Azimuth or Bearing in quadrant 2  Normal  

3  Bearing in quadrant 3  Normal  

4  Bearing in quadrant 4  Normal  

5  Angle right  Normal  

6  Deflection right  Normal  

7  Delta of curve  Radius of curve  

8  Arc Length of curve  Radius of curve  

  

• The Dist parameter is either a horizontal or slope distance depending on whether the VA 

(Vertical Angle) parameter is present. Entering a negative value for the distance will 

create a sideshot.  

• VA is the optional Vertical Angle. If no VA parameter is entered, the Dist parameter is 

interpreted as a horizontal distance. With a VA value specified, Dist is interpreted as a 

slope distance.  

• Pnt specifies an point number. This is also an optional parameter and will override the 

Next Number setting when present.  



 

• Desc is the optional point description. If the description includes embedded spaces, 

enclose the description in double quotes. Example: TR 33.2532, 532.23, “I am a 

note”<Enter> When entering curves - modes 7 and 8 - the following applies:  

• Ang is either the delta (mode 7) or the arc length (mode 8) of the curve. Entering a 

negative value will generate a counter-clockwise turning curve. A positive value 

generates a clockwise turning curve.  

• Curves will be tangent to the previous line or curve that was entered. To generate a non-

tangent curve, use the Curve functions in the main menu.  

• Dist is the curve radius.  

  

Connect Points  
Connect Points in the COGO menu creates 

lines between points that already exist. If the 

automatic creation of boundaries is enabled, 

these lines will be added to boundaries. To 

create a line between two points, enter the 

first point in the Occupy Pt box and the 

second point(s) in the Point Number box. The 

Occupy Pt value will default to the currently 

occupied point but can be set to any point. 

There are three ways to enter a point number into the Occupy Pt edit box:  

1) Type the number into the edit box.  

2) Middle-click (click the middle mouse button) near the point that is desired. The point 

number of the nearest point will be entered into the edit box automatically and the focus 

will be moved to the Point Number edit box. Other dialogs that use an Occupy Point 

should behave the same way.  

3) Make the edit box active (either by clicking the left mouse button in that box or by 

tabbing to it) and then select the desired point from the COGO data window. When this 

method is used, the “old" point number is replaced with the "new" point number 

automatically and the Point Number edit box is activated.  

Either the first or third method can be used for entering a point number into the Point 

Number edit box. Clicking near another point while the focus is still in the box will erase 

the old point number and replace it with the new point number.  

If you want to create several contiguous lines, there are two methods possible.  

1) The first is to enable the Continue on mouse click feature and set the focus to the Point 

Number field. Then, when you click near a point in the data window, a line will be 

created between the old Occupy Pt and the point nearest the click; then the Occupy Pt 

value will be set to the new point and the Point Number will be cleared. That option 

removes the requirement of clicking on the Continue button to add a line to the next 

point.  

2) A second method that can be used to connect several points in one step is to enter a series 

of points in the Point Number box. If the points are non-sequential, merely list the point 

numbers with a comma or space separating them. For a series of sequential points, enter 



 

the lowest point number followed by a hyphen and then the highest point number. This 

can also be used for alphanumeric points if the part of the name that changes is the 

numbers at the end of the string, such as TREE5-TREE18.  

Example: If you wish to connect from the occupy point to points 3, 5, 7, 8, 9, 10 and 12 

(in that order), you could enter the following in the Point Number box: 3 5 7 8-10 12 or 

3,5,7,8-10,12 or, even, 3,5 7 810,12.  

A semicolon can be used between point numbers to stop line drawing at the point number 

before the semicolon and restart at the point number following the semicolon.  

Example Specifying the point numbers 1-3;4-6 will create lines 1-2 and 2-3 followed by 

lines 4-5 and 5- 

6.  

The command line syntax for this function is:  

    PT Pnt List  

• To create the new line and quit, click on the OK button.  

• To create the new line and then create another line, click on the Continue button.  

• To quit without creating this line, click on the Cancel button. •  To REALLY 

quit, rip the mouse out of the computer and hurl it at extreme velocity towards your 

monitor screen. Don't worry - monitors implode (as opposed to explode), so you’re less 

likely to get caught in any flying debris.  

Offset  
There are two Offset functions in the COGO window. One is in the COGO menu and the 

other is in the Aln/Bnd menu. Both will generate offsets, but they behave somewhat 

differently.  

Offset in the COGO menu can generate offsets of lines and curves. Offset in the Aln/Bnd 

menu will generate offsets to alignments or boundaries. Offset points (relative to the 

curve/line endpoints or the alignment/boundary inflection points) will always be created.  

Line and curve offsets are created in the following manner:  

1) Select Offset from the COGO menu. The dialog shown to the 

right will appear.  

2) Enter the Distance and Offset for the desired offset (formulas 

and screen selections are allowed). The Distance value is the 

perpendicular distance in the case of a line or the distance along 

a radial line in the case of a curve. The Offset distance is a 

distance to offset the new line to the right of 

perpendicular/radial offset direction. Offset defaults to 0. Offset 

does not apply to curves.  

3) A Direction value can be entered instead of an Offset value to specify the direction of the 

offset relative to the perpendicular offset direction (i.e. 0 is the direction of the 

perpendicular to the line). Directions are evaluated as clockwise  

values.  



 

4) How many? defaults to 1. Larger values will create successive offsets - each new offset 

will be generated using the above parameters from the previous offset. The result is a 

“stair-step” appearance.  

5) Once the values have been entered, with the focus (the vertical flashing cursor) in the 

How Many?  

edit box, click on the side of the line/curve that you wish to create the offset at.  

The following occurs for the indicated type of selected object.  

• Line - if the line has endpoints, new points will be placed along a perpendicular(s) to the 

line passing through the endpoint(s) at the Distance from the endpoint(s).  

• Curve - if the curve has an endpoint(s), new points will be created along the endpoint’s 

radial line (line passing through the endpoint and the curve center or radius point) at the 

Distance from the endpoint. If the offset distance is larger than the radius of the curve 

and the offset is on the inside of the curve, no offset will be created.  

Add Leader Line  
Add Leader Line in the Draw menu creates leader lines off of connected lines and curves. 

To use this function,  

1) Select Add Leader Line from the Draw menu. The cursor will be changed to a bent 

arrow.  

2) Move the cursor near the point on the line or curve that you want the leader line attached 

to and press and hold the left button.  

3) Drag the mouse until the line is as long as you  

The program will stay in this mode until you click the right button or type <ESC>, so you 

can continue to add leader lines until exiting 

this mode.  

Adding a leader line will remove the text that 

is currently on the line or curve and place it 

on the tail of the leader line. Currently there is 

no way to put, for instance, only the distance 

or only the bearing text on the leader line - 

both will be placed on the leader line. 

Deleting a leader line will result in moving 

the text back to the object to which the leader 

line was originally attached (if the text will 

fit).  

want it and in the 

direction that you want 

and then  

release the button. The 

leader line will be drawn  

 

and the text on the line or 

curve will be moved to  

the leader line.  

Leader line 

from a curve 
be on  



 

Once a leader line has been added, it can be bent and its head can be relocated. To modify 

a leader line, 1) Select the leader line. A selected leader line has three nibs on it.  

2) Move the mouse until it is over one of the nibs. The cursor will change into a crosshairs 

at this point.  

3) Grabbing and dragging the center nib will result in bending the leader line. The head can 

likewise be dragged, but the head will remain attached to its line or curve. Grabbing and 

dragging the endpoint will stretch the tail of the leader line. The leader line text will be 

placed at the end of the tail.  

Leader lines that are not attached to a line or curve (independent leader lines) can be 

added in the Layout Window with the Straight Dimension and Curved Dimension 

functions. See p.43 for more information on these functions.  

Best Fit Line  
Best Fit Line will fit a line to a set of selected points. To use this function,  

1) Select all the points that are to be used in fitting the line. Be sure that no other points are 

selected. (You may wish to clear all selections first by clicking on the C button in the 

select status bar before selecting the points to use.)  

2) Select Best Fit Line from the COGO menu.  

A line and its endpoints will be created. The endpoints will be created such that the 

selected points that lie at either end of the line are along a perpendicular that passes 

through the endpoints.  

Split Lines  
The Split Line function in the Edit menu is used to “break up” a line at selected points 

that lie along the line. The line will be replaced with a set of lines that will start and end 

at the original line’s starting point and ending point but will also start and end at the 

selected intermediate points along the original line.  

For example, selecting a line along with a point that lies at its midpoint will result in the 

replacement of the original line with two lines. The first new line will start at the original 

starting point and end at the midpoint while the second line will start at the midpoint and 

end at the original endpoint.  

To use this function:  

1) Select the line(s) and point(s) on the line(s) where the line is to be broken.  

2) Select Split Line from the Edit menu. The line(s) will be broken as explained above.  

It’s that simple. Remember that this function can be used to operate on several lines at 

once since all selected lines are possibly affected (if there exist selected points along the 

selected lines).  



 

Line Extend  
The Line Extend function is used to “stretch” an existing line (or lines) till it contacts 

another line or an arc. This function requires selection of objects in two steps and is used 

in the following way:  

1) Select the line(s) that are to be extended. Note that multiple lines can be selected.  

2) Select Line Extend from the Edit menu. A 

dialog similar to the one shown will 

appear.  

3) Select the line or arc that you wish to 

extend the previously selected line(s) to.  

4) Select Extend endpoint(s) if the you wish to move the endpoints of the lines that are to 

be extended. Select Create point(s) at intersection if you wish to add point(s) at the 

intersection of the extended line(s) and the line or arc extended to.  

Select OK to complete the operation or Cancel to abort.  

Auto Draw  
Auto Draw in the Misc menu 

creates lines and curves and 

inserts point symbols based on 

the information in the description 

field. The surveyor must first 

create a set of definitions that 

specify what actions to perform 

when a specified pattern is found 

within the description field of a 

point. The definitions are entered through a  

spreadsheet interface and are stored in the PCS.INI file. When executing this function, the 

program will look at each point’s description field to see if it matches user-specified 

patterns in the Auto Draw definitions. These patterns are called regular expressions. It is 

suggested that you read the section on regular expressions on p.192 before proceeding 

with this section.  

The Map portion of the dialog specifies which actions to perform - whether or not to 

perform the Point Symbols and/or the Lines/Curves mapping definitions.  

Pressing the Do It! button will execute the Auto Draw function. The function will first 

step through the enabled (see below) Point Symbols definitions followed by the 

Lines/Curves functions.  

Pressing the Cancel button will terminate the dialog. Any changes made to the 

Definitions are kept, however, since they are saved at the time their dialogs are exited. 

Press Help for online information concerning this function.  

The Definitions portion of the dialog is used to edit the Auto Draw definitions.  



 

Point Symbol/Annotation Mapping  
Selecting the Point Symbols button will display a spreadsheet similar to the one shown. 

Each row of the spreadsheet contains one mapping definition. The columns Point 

Symbol, Size, Layer, Pattern contain the elements of the definition.  

  

The annotation of the point is controlled with the checkboxes and Position control on the 

left side of the dialog.  

Default Text, if checked, will cause any annotation to be placed in the quadrant (relative 

to the point) specified by the Position control. If Default Text is unchecked, the point 

annotation will be created as a freestanding text which can be moved and rotated (default 

point texts have a fixed location and orientation).  

Number, Location, Elevation and Desc refer to the point’s number, northing/easting 

coordinates, elevation and description. Checking any of these boxes will result in the 

corresponding parameter being displayed at the specified Position.  

The remaining three spreadsheet columns are used as follows:  

The enabling column is unlabeled - it is the one with the check boxes. When checked, the 

definition in the checked row will be applied. Conversely, unchecking the checkbox will 

exclude that row’s point definition when the Auto Draw function is executed (by pressing 

the Do It! button).  

The Layer parameter will default to the layer used for point symbols (the Dot Layer is 

used initially after installing the program). A different layer can be selected by clicking 

on the down arrow button to the right of the edit box and then selecting a name from the 

displayed list of layers. The default layer for points is the “Dot Layer”.  



 

The Pattern must be specified before the definition will be accepted. This is a regular 

expression that is used to search the point number descriptions for a match. In the first 

row of the dialog shown, for instance, the point symbol and annotation specified by that 

row’s Symbol/Anno dialog will be used for all points with descriptions beginning with 

the characters IPF (the % means “beginning with”). Similarly, in the second row, the 

point symbol specified in that row’s Symbol/Anno dialog will be used for all points with 

descriptions beginning with STA.  

Pressing the Add button will insert a new row after the current row (where the cursor is).  

Pressing the Delete button will delete the current row.  

Select the OK button to save the current definitions or Cancel button to discard any 

changes that have been made.  

Line/Curve Mapping  
Selecting the Lines/Curves button will display another spreadsheet. Again, each row 

contains the information for one definition. Each definition is capable of generating a 

connected set of lines and curves with control over the displayed line style, color and 

annotation.  

  

One of the differences between this spreadsheet and the Point Symbols spreadsheet is that 

line/curve auto draw definitions have a Name field. The name can be up to 63 characters 

in length. A recommendation is to use a name that indicates what it is that is being drawn. 

EPL or Left Pavement might be used to designate the left edge of pavement, for instance.  

Start, if entered, specifies the description pattern that will signify the first point of a 

connection sequence.  

End, if entered, specifies the description pattern that will signify the last point of a 

connection sequence. Points with the description pattern specified in Cont. will be 

included in the sequence if they are between the start point and the end point. The points 

in the database will be searched in numeric order. Once one sequence is ended, the 

program will continue to search through the existing points for the next description field 

that matches either the Start or Cont. pattern. 

Example Let's assume a project has the following points and descriptions: 1=PT, 2=PTA, 

3=PT, 4=PT, 5=PTB, 6=PTA, 7=PTB, 8=PT, 9=PTA, 10=PT. If the Start is "PTA", the 

Cont. is "PT", and End is "PTB", Auto Draw will create a line sequence of 2-3-4-5, 

another line of 6-7, and a final line of 9-10. Points 1 and 8 will not be used in any line 

since the function looks for a PTA to start the line. The last line, 9-10, did not have a PTB 

but the end of the list of points automatically ends any unfinished lines. If Start is left 

blank but leave the other fields the same, Mapping will create the lines 1-3-4-5 and 8-10. 



 

The PTA's will not be a part of any line. 7 will also not be a part of any 

alignments/boundaries since you cannot have a single point alignment/boundary. Leaving 

Start and End blank will create the line sequence 1-3-4-8-10. Leaving End blank but not 

Start will create the line sequence 2-3-4-8-10 since the PTA on point 2 will start it and 

there is nothing to stop it. 

 

In the first definition, Example 3, a special pattern is used in the Cont. pattern.  

A # character specifies that an integer number is expected. This value 

specifies an ordering of the points that overrides the point number order.  

Example: Given the sequence of points and descriptions: 1 = A2, 2=A1, 3=A3, 4=A6, 5 

= A4, performing an auto draw with the Example 3 definition will result in the connection 

sequence 2,1,3,5,4 (instead of 1,2,3,4,5). Unused sequence values (such as A4 in this 

case) are ignored by stepping until the next number in sequence is found.  

PI Crv is used when automatically generating curves with a known PI and known points 

on the PC and PT tangent lines. Given these three points, one more parameter is needed 

to fully specify the curve.  

This last parameter must be provided in the PI point’s description field immediately 

following the PI Crv pattern. The parameter must begin with a single alphabetic character 

followed by a number. The alphabetic character must be one of the following:  

E - External  L - Arc Length  

C - Chord Length  R - Radius  

D - Degree of Curve (hwy definition)  T - Tangent Length  

  

Example: If the PI Crv pattern is %PI, the description PIT75.0 specifies a curve with a 

tangent length of 75.0 feet or meters (depending on what units are being used).  

The Layer column allows a layer other than the default (normally Traverse Lines) to be 

specified. Changing this value is optional.  

The Style column can be used to override the default line style for the layer. Again, this is 

optional. Pressing this button will display the Line Style dialog (see p.). Simply select the 

picture of the desired line style and press the OK button to return to the Line/Curve 

dialog.  

The Color button allows for the overriding of the default color. The button will display 

the text Default if no color is chosen. Otherwise, the button will be displayed in the 

selected color.  

The Anno. button is used to select the desired annotation by displayed the Modify Line 

Text dialog (see p.).  

An optional Comment can be entered as a personal reminder of - well, whatever needs to 

be reminded about. This field affects nothing, but is just a possible convenience.  

The Add button will insert a new row after the current row (which is wherever the cursor 

currently resides).  

The Delete button will delete the current row. If you delete something by mistake, use the 

Cancel button to exit without saving the changes.  



 

Press the OK button to save the definitions.  

Text Functions  

Moving & Rotating Text with the Mouse  
Any text in COGO, with the exception of curve text can be easily moved and rotated with 

the mouse.  

Moving text:  

1) Select the text that is to be moved.  

2) Depress the left mouse button while the cursor is over the text. Keep the button 

depressed and don’t move the mouse for about a half second. The text should be 

replaced with an outline box. It is important that the mouse not move until the outline 

box appears.  

3) With the left button still depressed, drag the text outline to the desire location.  

4) Release the button.  

That’s all there is to it. Rotation of text is very similar. Rotation of text works in 

conjunction with the Text Rotation function if angle snapping is enabled (see p.33) to 

allow only certain angles of rotation.  

Rotating text:  
1) Select the text that is to be moved.  

2) While holding down the <Ctrl> key with one hand, depress the left mouse button with 

the other hand while the cursor is over the text. Keep the button depressed and don’t 

move the mouse for about a half second. The text should be replaced with an outline 

box. It is important that the mouse not move until the outline box appears.  

3) With the left button still depressed, move the cursor to rotate the text outline.  

4) Release the button.  

Align & 

Align Texts  
The text Align function is 

accessed through the Shift-

right-click popup menu. (see 

Popup Menus on page 34). 

Align allows the surveyor to 

assign a specific angle to the 



 

selected text. The Align Texts function in the Edit menu performs the same function 

except that it works on ALL selected texts at once.  

  

The dialog that appears is very similar to the Line Define dialog, allowing the 

specification of a text angle by several different methods. See the section on the use of 

this dialog (p. 32) for more information.  

  

Text on Curve  
When you create a curve in cogo, the arc length, delta, and radius are automatically 

annotated along the curve (as long as the text fits). But what if you have some other text 

that you want to be drawn following a curve? Or what if you want curved text as part of a 

component in layout? This is done using the following procedure:  

1. Create the text.  

2. Create the curve.  

3. Select the curve. Make sure that it is the only curve selected.  

4. Position the cursor over the text and <shift-right-click> to get the popup menu for texts.  

5. Select Curve from the popup menu.  

The text will now follow the curve. Specifically, the text will be drawn following the path 

of a circle using the same center point as the selected curve but with a radius extending 

out to the text. This radius may therefore be smaller or larger than the radius of the 

selected curve.  

To remove the curving of the text:  

1. Position the cursor over the text and <shift-right-click> to get the popup menu again.  

2. Select Curve from the popup menu. This will toggle the curving of the text off again.  

In Cogo, PC Survey knows that the curve controls the curving of the text so, as the text 

and curve are moved, the curving of the text will increase or decrease as the text moves 

closer or farther from the center of the curve.  

In Layout, unlike Cogo, PC Survey just remembers the distance from the text position to 

the center of the curve. So, as the text is moved, the curvature of the text will remain the 

same.  

     



 

Edit Text  

 

Edit Text will operate on ALL texts in COGO. This includes both attached and automatic 

texts (such as bearings, distances, and boundary annotations).  

To use this function from the menu,  

• Select the text you wish to edit and select Edit  

Text from the Edit menu.  

    OR  

• Use the Edit function from the object pop-up menu.  

• Select Left, Center, or  

Right to control the justification of the text.  

Notes:  

Degree symbols can be entered by holding down the <Alt> key while typing 248 on the 

keypad and then releasing the <Alt> key.  

Text can be copied to the Windows clipboard by highlighting the desired text with the 

mouse and/or keyboard keys followed by holding down the <Ctrl> key and pressing the 

<Ins> key. This is called a Copy command.  

Once text has been copied to the clipboard, it can be retrieved by placing the cursor in the 

edit box where the clipboard text is to be inserted, holding down the <Shift> key and 

pressing the <Ins> key. This is called a Paste command.  

  

Warning! Changing the value of automatic texts can be dangerous if the numerical values are altered 

since the drawing could then contain erroneous data.  

  



 

Curves  

Curve Info  
  

  

Curve Info in the Curves menu will display the parameters of all of the selected curves. 

When you start this function, all of the selected curves will be temporarily un highlighted. 

If you click on one of the curve lines in the list box, that curve will be highlighted in the 

data window. When you click on another line, that curve will be highlighted and the 

previous one will be un highlighted. If you click on the Deselect button, the currently 

highlighted curve will be unselected and will be removed from the list. When you are 

done, click OK or Cancel.  

Curve Annotation  
Curve Annotation in the Curves 

menu alters the appearance and 

placement of arc length (Length, 

for short) and degree/radius text 

(Radius, for short). All selected 

curves are affected.. The direction 

of the curves can also be reversed 

from within this dialog.  

If you have one or more curves 

selected, you can set all length 

texts for the curves In or Out, 

remove them (None), or leave 

them unchanged. You can also set all  

degree/radius texts In or Out, remove them (None), or leave them unchanged To change 

the current text placement, enable the appropriate check box and select one of the three 

options. Leaving the checkboxes disabled (unchecked) leaves the text unchanged.  

In refers to the inside of the curve while Out refers to the outside of the curve (of course).  

Checking Reset Units has an effect only if the system units have been changed. For 

instance, if the system units have been changed from US Foot to Metric (see the Units 

dialog on p.59), distance text that has already been created will remain in US Foot units.  



 

Divide  
Divide will split a selected curve(s) into a specified number of equal length arcs, creating 

a new point at each junction.  

1) Select the curve(s) that you wish to divide.  

2) Select Divide. A dialog box similar to the one 

shown will appear.  

3) Enter the Number of Segments to split the 

curve into and select OK.  

Fillet  
This function can be used in one of two ways. One method involves selected a set of lines 

that have pairs sharing a common endpoint. An example of this would be an alignment 

consisting of tangents with no transition arcs. In this case, the Fillet function will 

generate tangent arcs with the specified parameter between each pair of lines sharing a 

common endpoint. Endpoints for the arcs will be generated and the tangents will be 

trimmed to terminate at those endpoints.  

A second use is to generate a fillet arc between any pair consisting of two lines and/or 

curves. This applies to a line and a curve, two lines or two curves. In this case, the 

program will display all possible fillet arc solutions and allow the user to pick which arc 

to use. Options are included for trimming/extending objects to the fillet arc.  

To use the first method:  

1) Select all of the lines to use for generating 

transition arcs. Remember that arcs will be 

only be generated where a common 

endpoint exists between a pair of selected 

lines.  

2) Select the Curve | Fillet function. A dialog 

box similar to the one shown on the right 

will be displayed.  

3) Enter a curve parameter by selecting the 

desired parameter and entering its value. 

This parameter can be Radius, Arc Length, 

Chord Length,  

Degree of Curve, Tangent Distance, or  

External.  

4) Select OK to complete the function.  

Example: Suppose the curves are to have a radius of 25 feet (or meters, if the units are 

metric). Select Radius and set the Value to 25. Then click on the OK button to continue. 

Each intersection will be replaced by a curve with the specified parameters.  

To use the second method:  
1) Select two lines, two curves or a line a curve. Check the select status numbers to make 

sure that a total of two lines/curves are selected.  



 

2) Select Curve | Fillet. A dialog box similar to the one shown above will appear.  

3) Enter the desired values in the dialog 

according the to instructions in step 3 above 

and select OK. A set of temporary arcs will 

appear on the screen, representing the 

possible solutions along with a dialog 

similar to the one shown on the  

  

right.  

4) Left-click near the desired fillet – its color will change, indicating that this is the desired 

solution.  

5) Select Trim/Extend Line to automatically trim or extend the selected line(s) to meet the 

fillet arc. Similarly for Trim/Extend Arc for the selected arc(s).  

6) Select OK to generate the fillet.  

  

  

General Curve Creation  
The following curve functions require different parameters but behave similarly. The 

normal starting point (PC, point of curvature) defaults to the occupied point. However, 

this point can be changed once the curve function is invoked. If auto-boundary creation is 

on, changing the PC to a point different than the occupied point will start a new boundary 

that begins at the PC.  

For those functions that require a forward tangent, the starting information defaults to the 

reverse of the backsight and is the angle of the line tangent to the curve at the starting 

point, pointing in the direction that the curve will 

traverse.  

After entering the requested parameters, click OK to 

continue or Cancel to quit.  

If a curve can be created, selecting Info will display 

the curve in magenta in the data window and a Curve 

Information dialog box will show the parameters of 

the curve. You can therefore check to see what the 

curve will look like before actually creating it.  

Both the curve center point and PI can be optionally 

created in those curve functions that don’t use an 

existing center/PI point. In those cases where center/PI 

point creation is optional, enable the corresponding 

checkbox(s) to create the point(s). The point number 

and description can then be modified by selecting the 

Center Pt or PI buttons.  

To modify the description or point number for the PT 

in those functions that create a PT point, the procedure 

is the same - select the PT button, fill in the Desc. box 

and modify the point number (top edit box) if desired. 

Info Dialog Box  



 

If a curve can be created, it will be displayed in the 

data window and a dialog box will show the 

parameters of the curve. If a data point can be created, 

you can enter any notes for the point to be created in 

the Desc. box. To quit without creating the new arc or 

point, select Cancel. otherwise select OK. Selecting 

Continue will create a new arc and point and then 

continue around the circle in the same direction for the 

same distance.  

 

Creating Curves from a PC, Forward 

Tangent and Two Parameters  
The PC, Forward Tangent and ... function is used for creating a curve that has a known 

PC and a known direction for the tangent at the PC (the Forward Tangent). Any 

combination of two of the remaining curve parameters (Delta, Radius/Degree, Arc 

Length, Chord Length, Tangent Length, and External) and specifying whether the 

curve turns counter-clockwise (CCW) or clockwise (CW) completely defines the curve.  

  
To use this function, supply the following data:  

1) PC - defaults to the current occupied point. A different point number can be selected 

from the screen or typed in, if desired.  

2) Forward Tangent - the angle of the tangent to the PC. Can be entered as an angle 

formula (see p.30).  

3) CCW or CW - should the curve turn counter-clockwise(CCW) or clockwise (CW)?  

4) Delta, Radius/Degree(HWY)/Degree(RR), Arc Length, Chord Length, Tangent Length, 

External - TWO and ONLY two of these entries must have valid values before 

generating the curve. This is similar in operation to the Curve Solver function (see 

p.153).  

5) Create Other... - if the surveyor wants to create a Center Point or PI point when creating 

the curve, enable the corresponding checkboxes to the left of the Center Pt and/or PI 

buttons.  

Example of curve point number and 

description modification dialog  



 

6) Center Pt, PI, PT - pressing these buttons will display a dialog that allows the user to edit 

the point number and description. The point number 

will have a valid default value.  

7) Curve- after the data has been entered, the Curve 

button can be selected to display information about 

the curve and display what the curve will look like 

before actually creating the curve.  

8) Select OK to create the curve, Cancel to abort the 

function.  

 

Creating Curves from a PC, Chord Bearing 

and... Curve Parameter  
The PC, Chord Bearing and ... function is used for creating a curve that has a known PC, 

Chord Bearing and some curve parameter (Delta, Radius/Degree, Arc Length, Chord 

Length, Tangent Length, or External). This information, together with specifying 

whether the curve turns counter-clockwise (CCW) or clockwise (CW), completely 

defines the curve.  

  
To use this function, supply the following data:  

1) PC - defaults to the current occupied point. A different point number can be selected 

from the screen or typed in, if desired.  

2) Chord Bearing - the angle of chord. It can be entered as an angle formula (see p.30).  

3) CCW or CW - should the curve turn counter-clockwise(CCW) or clockwise (CW)?  

4) Delta, Radius/Degree(HWY)/Degree(RR), Arc Length, Chord Length, Tangent Length, 

External - ONE and ONLY one of these entries must have valid values before generating 

the curve. This is similar in operation to the Curve Solver function (see p.153) except that 

this dialog uses a single entry instead of two..  

Example of the Number & 

Description Dialog  



 

5) Create Other... - if the surveyor wants to create a 

Center Point or PI point when creating the curve, 

enable the corresponding checkboxes to the left of the 

Center Pt and/or PI buttons.  

6) Center Pt, PI, PT - pressing these buttons will display 

a dialog that allows the user to edit the point number 

and description. The point number will have a valid 

default value.  

7) Curve- after the data has been entered, the Curve button can be selected to display 

information about the curve and display what the curve will look like before actually 

creating the curve.  

8) Select OK to create the curve, Cancel to abort the function.  

Creating Curves from a PC, Center Point 

and...Curve Parameter  
The PC, Center Point and Curve Parameter function is used for creating a curve that has 

a known PC, Center Pt and some curve parameter (Delta, Arc Length, Chord Length, 

Tangent Length, or External). This information, together with specifying whether the 

curve turns counter-clockwise (CCW) or clockwise (CW), completely defines the curve.  

  
To use this function, supply the following data:  

1) PC - defaults to the current occupied point. A different point number can be selected 

from the screen or typed in, if desired.  

2) Center Pt - point number of the center point of the curve.  

3) CCW or CW - should the curve turn counter-clockwise(CCW) or clockwise (CW)?  

4) Delta, Arc Length, Chord Length, Tangent Length, External - ONE and ONLY one of 

these entries must have valid values before generating the curve. This is similar in 

operation to the Curve Solver function (see p.153) except that this dialog uses a single 

entry instead of two.  

5) Create PI... - if the surveyor wants to create a PI point when creating the curve, enable 

the this checkbox.  

6) PI, PT - pressing these buttons will display a dialog that allows the user to edit the point 

number and description. The point number will have a valid default value.  



 

7) Curve- after the data has been entered, the Curve 

button can be selected to display information about 

the curve and display what the curve will look like 

before actually creating the curve.  

8) Select OK to create the curve, Cancel to abort the 

function.  

  

PT Tangent  
The PC, Center Point and PT 

Tangent function is used for creating a 

curve that has a known PC, Center 

Point and a known point on the PT 

tangent.. This kind of curve problem 

generally has two solutions. 

Specifying whether the curve turns 

counter-clockwise (CCW) or 

clockwise (CW) and picking the 

desired solution completely defines the 

curve.  

To use this function, supply the 

following data:  

1) PC - defaults to the current occupied point. A different point number can be selected 

from the screen or typed in, if desired.  

2) Center Pt - point number of the center  

 point of the curve.  

3) Pt. on PT Tangent - the point number of a point that lies on a line passing through the 

PT.  

4) Turn CCW or Turn CW - should the curve turn counter-clockwise(CCW) or clockwise 

(CW)?  

5) 1st Sol. or 2nd Sol. - after choosing either of these, select Curve Info to display the curve 

to see if this is the solution that is desired.  

6) Create PI... - if the surveyor wants to create a PI point when creating the curve, enable 

the this checkbox.  

7) PI Info, PT Info - pressing these buttons will display a dialog that allows the user to edit 

the point number and description. The point number will have a valid default value.  

8) Curve Info- after the data has been entered, the 

Curve Info button can be selected to display 

information about the curve and display what the 

curve will look like before actually creating the 

curve.  

9) Select OK to create the curve, Cancel to abort the 

function.  

  



 

Creating Curves from a PC, PT and ...  
Curve Parameter  

The PC, PT and Curve Parameter function is used for creating a curve that has a known 

PC, PT and one of the primary curve parameters (Delta, Radius/Degree, Arc Length, 

Tangent Length, External). This information, together with specifying whether the curve 

turns counter-clockwise (CCW) or clockwise (CW), completely defines the curve.  

  

  
To use this function, supply the following data:  

1) PC - defaults to the current occupied point. A different point number can be selected 

from the screen or typed in, if desired.  

2) PT - point number of the PT of the curve.  

3) Delta, Radius/Degree, Arc Length, Tangent Length, External - ONE and ONLY one of 

these entries must have valid values before generating the curve. This is similar in 

operation to the Curve Solver function (see p.153) except that this dialog uses a single 

entry instead of two.  

4) CCW or CW - should the curve turn counter-clockwise(CCW) or clockwise (CW)?  

5) Create Other.... - if the surveyor wants to create a PI or Center point when creating the 

curve, enable the checkbox to the left of the PI button or the Center Pt button.  

6) Center Pt, PI- pressing these buttons will display a dialog that allows the user to edit the 

point number and description. The point number will 

have a valid default value.  

7) Curve Info- after the data has been entered, the 

Curve Info button can be selected to display 

information about the curve and display what the 

curve will look like before actually creating the 

curve.  

8) Select OK to create the curve, Cancel to abort the function.  



 

Point on PC or PT tangent line  
The PC, PT and Point on PC/PT 

Tangent function is used for 

creating a curve that has a known 

PC, PT and a point on the either 

the PC or PT Tangent line. This 

information, together with 

specifying whether the curve turns 

counter-clockwise (CCW) or 

clockwise (CW), completely 

defines the curve.  

To use this function, supply the 

following data:  

1) PC - defaults to the current 

occupied point. A different point number can be selected from the screen or typed in, if 

desired.  

2) PT - point number of the PT of the curve.  

3) Pt on Tangent - point number of a point on the specified tangent line.  

4) CCW or CW - should the curve turn counter-clockwise(CCW) or clockwise (CW)?  

5) PC Line or PT Line - Selecting PC Line means that the Pt on Tangent is a point on the 

tangent line to the PC. Selecting PT Line means that the Pt on Tangent is a point on the 

tangent line to the PT.  

6) Create Other.... - if the surveyor wants to create a PI or Center point when creating the 

curve, enable the checkbox to the left of the PI button or the Center Pt button.  

7) Center Pt, PI- pressing these buttons will display a dialog that allows the user to edit the 

point number and description. The point number will 

have a valid default value.  

8) Curve Info- after the data has been entered, the 

Curve Info button can be selected to display 

information about the curve and display what the 

curve will look like before actually creating the 

curve.  

9) Select OK to create the curve, Cancel to abort the function. 

  



 

PT and POC (PT and Point on Curve)  
The PC, PT and Point on Curve 

function is used for creating a curve 

that has a known PC, PT and some 

other point that lies on the curve.  

This information completely defines 

the curve.  

To use this function, supply the 

following data:  

1) PC - defaults to the current occupied 

point. A different point number can be 

selected from the screen or typed in, if 

desired.  

2) Point on Curve - the point number of any point that lies on the curve.  

  

3) PT - point number of the PT of the curve.  

4) Create Other.... - if the surveyor wants to create a PI or Center point when creating the 

curve, enable the checkbox to the left of the PI button or the Center Pt button.  

5) Center Pt, PI- pressing these buttons will display a dialog that allows the user to edit the 

point number and description. The point number will 

have a valid default value. Info- after the data has 

been entered, the Info button can be selected to 

display information about the curve and display what 

the curve will look like before actually creating the 

curve.  

6) Select OK to create the curve, Cancel to abort the 

function.  

  

Example of the Number & Description Dialog  



 

Creating Curves from a PC, PI and ...  
PC, PI and Point on PT Tangent  

The PC, PI and Point on PT Tangent 

function is used for creating a curve that 

has a known PC, PI and a point on the 

line tangent to the PT. This information, 

together with specifying whether the 

curve turns counter-clockwise (CCW) or 

clockwise (CW), completely defines the 

curve.  

To use this function, supply the 

following data:  

1) PC - defaults to the current occupied 

point. A different point number can be 

selected from the screen or typed in, if desired.  

2) PI - point number of the PT of the curve.  

  

3) CCW or CW - should the curve turn counter- clockwise(CCW) or clockwise (CW)?  

4) Create Center Pt.... - if the surveyor wants to create a Center point when creating the 

curve, enable this checkbox  

5) Center Pt, PT Info- pressing these buttons will display a dialog that allows the user to 

edit the point number and description. The point 

number will have a valid default value.  

6) Curve Info- after the data has been entered, the 

Curve Info button can be selected to display 

information about the curve and display what the 

curve will look like before actually creating the 

curve.  

7) Select OK to create the curve, Cancel to abort the function.  

 

Curve by Point on Curve and Tangent Lines  
The POC and Tangent Lines command in the Curve menu allows for the creation of a 

curve that passes through some specified point (the POC or Point on Curve) and is 

tangent at the PC and PT (points yet to be created) to two specified tangent lines. To use 

this function:  

1) Select the POC and Tangent Lines command from the Curves menu.  

2) The Line Define dialog will appear (see p.32). Define the first tangent line and select OK. 

A magenta line will appear on the screen to represent the first line that was defined.  

3) The second Line Define dialog will appear. Define the second tangent line with this 

dialog and select OK. A second magenta line will appear on the screen to represent the 

second tangent line. The PI of the curve lies at the intersection of the two lines.  



 

4) Next, a dialog for defining the Point on Curve will appear 

as shown on the right. Select the Point on Curve from the 

screen or type in its point number and select OK.  

5) After the two lines and the POC are defined the POC and  

Tangent Lines dialog will appear. The two magenta lines 

will be replaced by a magenta curve representing the First Solution to the problem.    

 
Dialog for defining the POC   

The data in this dialog is as follows:  

6) First Solution and Second Solution - There are two solutions to this problem. The 

solution corresponding to which of these two options is selected will be displayed on the 

screen in magenta. The First Solution is initially displayed. To see the second solution, 

select the Second Solution radio button. The First Solution’s curve will be removed and 

the Second Solution’s curve will be drawn in its place.  

7) Create Other.... - if the surveyor wants to create a PI or Center point when creating the 

curve, enable the checkbox to the left of the PI button or the Center Pt button.  

8) Center Pt, PI, PC, PT- pressing these buttons will display a dialog that allows the user to 

edit the point number and description of the corresponding point. The point number will 

have a valid default value.  

9) Select OK to create the curve or Cancel to abort the function.  

Best Fit Curve  
Best Fit Curve in the Curve menu is useful for fitting a curve to a set of points that have 

been obtained along some curve in the field. This function will create a curve along with 

its PC, PT and center point that is the “best fit” to the points that are specified. To use this 

function:  

1) Select the points that are to be used for calculating the curve.  

2) Select Best Fit Curve from the Curve menu.  

The PC and PT are both place along a line connecting the center point and a selected 

point that lies at either end of the curve.  



 

The Curve Solver  

  

The Curve Solver is useful for finding any curve parameter when given any two of the 

following parameters - Delta, Radius or Degree of curve, Arc Length, Chord Length, 

Tangent Length, and External. To use this function,  

1) Enter the two known parameters in the corresponding edit boxes on the left side. The 

second entry  

(shown as Radius) can be toggled by using the spin buttons (the up and down arrows to 

the left) to either Radius, Degree(HWY) (highway definition) or Degree(RR) (railroad 

definition)  

2) Select Calculate to generate the results which will be displayed in the columns on the 

right.  

• Select Erase to clear the edit boxes.  

• Select Done to exit the function.  

The value displayed can be copied into the clipboard and inserted into another edit box in 

a different function, if desired.  



 

Alignments  

Create  
Create Alignment in the Aln/Bnd menu will see 

if there is any way to take all of the currently 

selected lines and curves and form a single 

continuous sequence. If it can, it will create the 

alignment.  

Edit  
Edit Alignment is used to alter the beginning 

station value and/or the direction of all selected 

alignments. To use this function,  

1) Select the alignment(s) that you wish to modify.  

2) Select Edit Alignment from the Aln/Bnd menu.  

The dialog shown to the right will appear.  

  

3) Enter the desired Starting Station Value, if any.  

This value is used when creating station lines (described later in this section) and profiles.  

4) Press Reverse Direction (if desired) to change the start point from one of the alignment to 

the other end. The beginning segment of an alignment will be highlighted as half-white 

and half-yellow.  

5) Select OK to exit the function or Cancel to abort.  

Offset  
Optionally, Offset creates an offset line, curve, alignment or boundary (depending on the 

object selected). Multiple offset distances can be entered (as shown by the example to the 

right).  

To generate an offset(s):  

1) Select all objects that offsets are to be created for. 

If one or more alignments/boundaries are 

selected, the Offset function will ignore selected 

lines and curves. This is to prevent accidental 

offset creation from selected lines or curves that are 

also in a selected alignment/boundary.  

2) Enter the desired offset values in the Offset 

distances text box as positive or negative numbers 

separated by either commas or spaces.  

Example of Offset dialog  
3) If only offset point generation is desired (no lines or curves), disable Auto Linedraw.  

    

    



 

4) If using Auto Linedraw and annotation is desired on the lines/curves that will be created, 

disable No Annotation.  

The following occurs for the indicated type of selected object.  

•  Alignment/Boundary - Alignments and boundaries consist of lines and curves, so an 

offset to an alignment or boundary will also consist of lines and curves. Curves will offset 

according to the curve rule given above. Lines will also offset according the line rule 

above except in the case of adjacent lines (line that have a common endpoint). In this 

case, offset points are created along a perpendicular bisector of the angle between the two 

lines. Positive/negative offset distance values will offset to the right/left of the 

alignment/boundary. When selected, the first half of the first segment of an 

alignment/boundary is drawn in white to indicate its direction.  

Example: In the Offset dialog 

shown, three offsets are 

specified at offset distances of 

50, -50, and 25.5. Three offsets 

will therefore be generated (if 

possible) for every selected 

object. Two offsets will be to 

the right at 25.5 and 50.0, and 

one offset will be generated to 

the left at 50.0. These values 

were applied to an alignment 

with two curves of radii 100 and 25 in the example shown. Notice the “clipping” that  

occurs on the top offset (the -50 value) due to offsetting a curve with a radius smaller 

than the offset distance.  

Offset example  

Angle Adjust  
Angle Adjust in the COGO menu ensures that the final segment of a alignment is heading 

at a specific angle. This angle can be set using either Final Angle or Angle of Error. 

Final Angle specifies the desired angle of the last segment of the alignment and defaults 

to the current angle of the last segment. Angle of Error specifies the angle to rotate the 

last segment by and defaults to the difference between the angles of the first and last 

segments of the alignment. Angle Adjust calculates the amount to rotate the last segment 

by and distributes the change between all of the angles of the alignment.  

If more than one alignment is selected, the function will adjust one alignment at a time, 

prompting for the adjustment values between each alignment.  

Compass Rule  
Compass Rule in the COGO menu provides a means of closing an alignment. Select the 

alignment before calling the function. There are three ways to specify the means of 

closing the alignment.  



 

  

Compass Rule Dialog  
By Angle & Distance will move the last point on the alignment by the Angle and 

Distance specified to reach the new position. To Point will move the last point of the 

alignment to the position of the given point. To Coordinate will move the last point to the 

specified north and east values. In all cases, the default values will move the last point of 

the alignment to the first point. The distance error and angle error will be distributed 

among all of the points of the alignment.  

If more than one alignment is selected, the function will adjust one alignment at a time, 

prompting for the adjustment values between each alignment. Skip will not make any 

adjustments to the current alignment, causing the function to examine the next alignment, 

if any.  

Station Lines  
Station Lines in the Aln/Bnd menu is used to define and generate station lines. Station 

lines are a series of tic marks and, optionally, station texts that are applied to an 

alignment to show the station values at various points along the alignment with respect to 

some user-specified starting station value at the beginning of the alignment.  



 

  
The surveyor has control over both major and minor tic specifications (short lines that 

cross and are perpendicular to the alignment), as well as tic length, width, color, overlay 

and layer. Tics can be optionally annotated with the station value at the tic with control 

over the position and number of decimal places in the station value.  

This dialog can be used to both create new station line definitions and to apply a 

definition to a selected  

alignment(s). The term “definition” refers to the set of parameters and their values as 

shown in the dialog above.  

• To create a new station line definition:  

1) Enter the Station Line Name - this name should be unique (not used by any existing 

station line definitions).  

2) For the Major Tics,  

3) Enter the Interval. This is the separation distance, in the system units, between successive 

tics.  

4) Enter the Length. This is the drawn length of the tic mark. The tic mark will be a line 

perpendicular to, and bisected by, the alignment.  

5) Enter the Width. This is the drawn line width of the tic mark.  

6) Select the Overlay if something other than the default, the Base Overlay, is desired.  

7) Select the Layer if something other than the default, the Traverse Line layer, is desired.  

8) Select the Color if something other than the selected layer’s color is desired.  

9) Select the Font if something other than the selected layer’s font is desired.  

10) Check the Annotation checkbox if station values are to be printed at the tics.  



 

11) If Annotation is enabled, select the annotation position from the list box below the 

checkbox. The options here are  

Straddle - station values will split across the alignment.  

Rt. Perp. - station text will be printed on the right side, and parallel with, the tic marks.  

Lt Perp - station text will be printed on the left side, and parallel with, the tics marks.  

Rt Parallel - station text will be printed parallel to the alignment on the right side.  

Lt Parallel - station text will be printed parallel to, and on the left side of, the alignment.  

12) Select the Precision (the number of digits to the right of the decimal point) from the list 

box if a value other than the default of 0 is desired.  

13) Do the same for the Minor Tics. The Major Tics Interval should be an integer multiple 

of the Minor Tics Interval.  

14) Select Save to save the definition.  

  

• To create a station line:  

1) Select the alignment(s) that is to be stationed.  

2) Select Station Line from the Aln/Bnd menu.  

3) Select the station line definition from the Station Line Name list OR enter the desired 

values into the dialog as explained above.  

4) Select Apply.  

  

• To delete an existing station line definition:  

1) Select Station Line from the Aln/Bnd menu.  

2) Select the name of the station line definition that is to be deleted from the Station Line 

Name list. 3) Select Delete.  

Culdesac  
Given an alignment, the 

Culdesac function can generate 

either a bulb or knuckle 

culdesac with user-specified 

main radius, transition radii and 

entry width. This function is 

also used to modify an existing 

culdesac. Generated culdesacs 

will consist of three arcs.  

The parameters of a culdesac 

consist of the following:  

Bulb - a round culdesac at the end of a street.  

Knuckle - a culdesac at the bend of a road.  

Offset - the perpendicular distance from the centerline to the radius point of the main 

culdesac arc. As with other offsets, a positive offset is to the right and a negative offset is 

to the left.  



 

Width - the entrance width to the culdesac.  

Radii - Main - the main arc’s radius.  

Radii - Transition - the radii of the transition arcs from the road to the main culdesac arc.  

To create a new culdesac:  

1) Select an alignment that represents the road centerline for the culdesac.  

2) Select Aln : Culdesac. A dialog similar to the one shown will appear.  

3) Fill in the desired values.  

4) Left-click near the end of the alignment where you wish to place the culdesac.  

5) Select OK to close the function To modify an existing culdesac:  

1) Select Aln : Culdesac. A dialog similar to the one shown will appear.  

2) Left-click near the culdesac that is to be modified. An Apply button will appear in the 

lower right corner of the dialog and the dialog parameters will change to the selected 

culdesacs parameters.  

3) Fill in the desired values and select Apply.  

  

Profiles and Vertical Controls  
Creating Profiles and Vertical Controls  

1) Select an alignment from the drawing. If you are creating a 

vertical control, make sure that all points on the alignment have 

elevations.  

2) Select Profile/Vert Control from the Aln menu. The Vertical 

Profiles dialog will appear.  

3) If desired, enter a Name for the profile/vertical control. The 

Name is an optional field since the profile or vertical control will 

automatically carry, as a primary name, the name of the selected 

alignment.  

4) Click on the Create button.  

5) Define the characteristics following the steps in the following Modify Profile Parameters 

section. Selecting “Cogo Points Surface” will create a vertical control. Selecting one or 

more tins will create profiles.  

6) Click on the OK button. A window will be displayed showing the profile/vertical control. 

This window is similar to other windows in this program and, for example, allows 

zooming and selecting just like all of the other windows.  

Editing Profiles and Vertical Controls  
  

1) Select Profile/Vert Control from the Aln menu.  

2) Click on the down arrow to the right of the Name edit box. A list of all profiles will be 

displayed.  

3) Click on the profile/vertical control that you want to edit.  



 

4) Click on the Edit button.  

5) Define the characteristics of the profile following the steps in the following Modify 

Profile Parameters section.  

6) Click on the OK button. The Profile Window will be displayed.  

Displaying Profiles and Vertical Controls  
1) Select Profile/Vert Control from the Aln menu.  

2) Click on the down arrow to the right of the Name edit box. A list of all profiles will be 

displayed.  

3) Click on the profile that you want to show. 4) Click on the Show button.  

•  Existing profiles will also be added to the view menu so a faster way to display an 

existing profile is to simply select it by name from the bottom of the View menu.  

Deleting Profiles and Vertical Controls  
1) Select Profile/Vert Control from the Aln menu.  

2) Click on the down arrow to the right of the Name edit box. A list of all profiles will be 

displayed.  

3) Click on the profile that you want to delete.  

4) Click on the Delete button.  

5) A dialog will be displayed asking Are you sure you want to delete this profile? to make 

sure that you will not delete it accidentally. Click on the OK button (or Cancel if you 

don’t want to delete it). 6) Click on the OK button.  

Profiles/Vertical Control selection  
If this is a new profile/vert. Control and there are no other profiles defined for this 

alignment, 1)  
Define the name if you want to or leave it blank.  

2) Click Create.  

If you are creating a profile and another profile already exists for this alignment, 1) 

You must type something in the name field to distinguish this profile from the other one.  

2) Click Create.  

If you want to edit a profile/vert control that already exists, you don’t 

have to first select the alignment.  
1) Click on the down button in the name list  

2) Select the profile that you want to edit 3) Click Edit.  

For another way to edit a profile/vert control that already exists:  
1) Go to the view menu in the Cogo window. At the bottom of the menu will be a list of all 

profiles/vert controls that have been created. Select the vertical control from this menu.  



 

Modify Profile Parameters  
Setting up profile/vert control 

information:  

• Addn. Name  

This is the name, if any, that was 

entered in the preceding dialog 

which can be used to distinguish two 

different profile definitions for the 

same alignment. This can be changed 

here.  

• Start Stn and End Stn  

Initially set to the starting and ending 

station values for the alignment. These can be edited  

if you just want to profile part of the alignment.  

• Start Elev and End Elev  

Initially set to lowest and highest elevations of the points along the alignment. Change 

these values if you want to change the range of elevations displayed along the vertical 

axes of the cross sections.  

• Existing, Proposed, and Other Surfaces  

If you want to display elevation values for one or two surfaces at each grid line, you can 

select the surface for the existing or proposed surface. The elevation of the alignment on 

the surface selected for Existing will be displayed (by default) to the left of the grid line 

and the elevation on the surface selected for Proposed will be displayed to the right of the 

grid line. Both of these surfaces will have their profile shown. If you want to show the 

profile of any other surfaces, select them in the Other Surfaces dialog box.  

Set the axis information by selecting the Horizontal axis button and/or Vertical axis 

button. (When finished, select OK to return to the profile/vert control information dialog 

box.)  

  

Modify Profile Axis Parameters  
The Horizontal Axis and Vertical Axis 

buttons are used to define the display 

characteristics of the axes. They both use the 

same dialog.  

• Scale  

The scale used for each axis can be separately 

controlled.  

• Display  

The Display checkbox is used to turn on and 

off the display of the scale (1”=500’) 

information. To change the font or text size, 

click on the Font button next to the Display 

checkbox. To change to color, click on the 

Color button next to the Display checkbox.  



 

  

• Axis Display controls the display parameters for the tick marks and tick labels. The 

Margin Size is the amount of space to  

reserve in inches between the axis line and the edge of the window to display the ticks 

and tick labels. The major ticks will be half of this size. The Font button controls the font 

used for the tick labels, Linetype controls the linetype used for the axis and the ticks and 

color is used for the axis, ticks and tick labels.  

• Major and Minor Grid  

control whether or not to display the corresponding grid lines. Click on the Info button to 

control the interval  

or spacing between the grid lines as well as the linetype and color to use for the grid lines.  

• Major and Minor Tics  

control whether or not to display the corresponding tic marks. Click on the Info button to 

control the interval  

or spacing between the tic marks, the length in inches of the tic marks, as well as the 

linetype and color to use.  

• Existing Lt/Finish Rt and Finish Lt/Existing Rt  

Controls which side of the 0+00 grid line to place the elevations of the existing and 

proposed surfaces.  

• Annotate Elevations  

Turn on or off the display of the existing and proposed elevations on the 0+00 grid line.  

  

The Profile/Vertical Control window  
In the Profile Window, the 

View menu and the Close 

function are just the same as 

you find everywhere else in the 

program.  

• To turn off the rulers, select 

Ruler from the Misc menu.  

• To edit the grid and label 

parameters, select Edit from the 

Edit menu and then follow the 

steps in the preceding Modify 

Profile Parameters section.  

• To change the color or linetype 

of a surface line in the profile:  

1) Select the line in the profile by drawing a selection box intersecting any part of the line. It 

will be highlighted.  

2) Select Set Color or Linestyle from the Edit menu.  

Notes:  



 

If the profile still does not look quite like what it should, it can be edited further in 

Layout.  

Vertical Controls  
Whenever you create a profile that includes “Cogo Points Surface” for one of the 

surfaces, that is a vertical control although initially it doesn’t look any different from the 

other surface profiles. However, there is a difference in that the individual segments of 

the line are selectable. Also, points are created at the ends of the segments and these 

points are displayed and are selectable. These points are referred to as PVI points since, 

when a vertical curve is created, the point is the PI of the curve. To create a new point,  

1) Select “Insert PVI” from the Edit menu.  

2) Enter the station along the alignment to add the point and enter the elevation of the point. 

If a point already exists at this station, the elevation will be changed. To create a vertical 

curve, 1) Select a PVI point.  

2) Select “Modify PVI/Curve” from the Edit Menu. 3) Set appropriate parameters.  

4) Click OK.  

Edit Vertical Control  

Another way to edit a vertical control is to select “Edit Vertical Control” from the Edit 

menu. This will bring up a dialog box that will allow editing the station and/or elevation 

of a PVI, the grade of the line leaving the PVI, or the parameters of the curve leaving the 

PVI, if there is one. Vertical Curve Solver  

This allows you to enter three parameters for a curve and have it display the other values 

of a curve.  

Create Cogo Points  
Cogo points can be created from the profile and vertical control information.  

To create cogo points at each intersection of a profile or vertical control with the grid 

lines, select one or more profiles and/or vertical control and then select Create Cogo 

Points from the Edit menu.  

To create cogo points at each point of the vertical control (including PVI points), make 

sure that no profiles or vertical controls are selected when calling Create Cogo Points 

from the Edit menu.  

A brief message will be displayed showing the point numbers of the cogo points created.  

Printing Profiles and Vertical Controls  
1) Go to the Layout window.  

2) Select Profile from the Draw menu.  

3) A pink box will be displayed showing the dimensions necessary to display the profile. 

Move the pink box to the appropriate position on the sheet and then click the left mouse 

button.  

4) The profile/vertical control will be displayed on the sheet. If you want to further refine 

the display of the information, you can select the profile/vertical control information as 



 

placed on the sheet and then select Smash from the Components menu. This will break 

down all of the information into individual lines and texts.  

5) Select Print from the Project menu of the Layout window.  

Boundary Functions  

Create  
Create Boundary in the Bnd menu will create every possible boundary using the selected 

lines and curves. The boundaries need to actually start and end at the same point rather 

than meet the precision of closure defined in the Options dialog box in the COGO menu 

(see p.100).  

Edit  
Edit Boundary in the Bnd menu provides a graphical interface for editing a boundary. 

The dialog box allows you to decide whether or not to delete lines that are no longer in 

the boundary (and are not in any other boundaries). With this dialog box up and Alter 

Lines selected, if you press the left button when the cursor is near a point on the selected 

boundary, the lines in the boundary connected to that point will be highlighted. As you 

move the cursor, the lines will rubber band to the cursor position. If you release the 

button near another point in the project that is not on the boundary, the new point will 

replace the old point in the boundary. If you release the button near another point that is 

on the boundary, the old point will be removed from the boundary along with any other 

points between the old point and the new point.  

If you press the left button when the cursor is near a line of the boundary but not near a 

point on the boundary, the line will be highlighted. As you move the cursor, two lines 

will rubber band from the cursor position to the two end points of the line. If you release 

the button near another point in the project that is not on the boundary, the new point will 

be inserted between the two end points of the previous line.  

Selecting Change Origin allows the surveyor to change the origin of the boundary by 

simply left-clicking near the point that is desired as the new origin.  

Selecting Reverse Direction will reverse the direction of the boundary (clockwise to 

counter-clockwise or vice versa).  

When you are done editing this boundary, click on the OK button in the dialog box.  



 

Annotation  
The Annotation function controls the automatic annotation 

parameters of all selected boundaries. This function creates 

a text block containing a list of the desired boundary 

parameters. To use this function,  

1) Select the boundary(s) to modify.  

2) Select Annotation from the Bnd menu. A dialog similar to 

the one shown will appear.  

3) Check those parameters that you wish to display with the 

selected boundary(s).  

4) Select OK to complete the function or Cancel to abort the function.  

The Name can be modified with the Info function (see above). The text block can be 

modified with the Edit Text function (see p.142). However, executing the Annotation 

function after editing the text will remove any changes that are made with the Edit Text 

function.  

Info  
Info in the Bnd menu will display the parameters of all of the selected boundaries. When 

you start this function, all of the selected boundaries will be temporarily un highlighted. 

If you click on one of the boundary lines in the list box, that boundary will be highlighted 

in the data window. When you click on another line, that boundary will be highlighted 

and the previous one will be un highlighted. If you click 

on the Deselect button, the currently highlighted 

boundary will be unselected and will be removed from 

the list. If you click on the Delete button, the currently 

highlighted boundary will be deleted and will be 

removed from the list. To rename a boundary, click on 

the Rename button, enter the name in the edit box, and 

click OK.  

If you want subsequent traverses and point traverses to be appended to the end of a 

boundary, hilight that boundary in the list box and then click on the Set Current button.  

When you are done with Info, click OK or Cancel.  

  

    



 

Inverse (Aln or Bnd)  

  

Example of the output produced by Inverse.  
The Inverse function in the Bnd menu generates a separate report on every selected 

boundary that contains the starting and ending point information, bearing and direction of 

each leg, parameters of any included curves, the perimeter, area, and the precision. The 

report is sent to the main window and the log file (if the log has been opened).  

Predetermined Area  
By Pivot Line  

Predetermined Area by Pivot Line in the 

Bnd menu uses a selected 

alignment/boundary and pivots a line 

about one of the points on the 

alignment/boundary to obtain a specified 

area. Pivot Point in the dialog box is the 

point about which the line will pivot and 

must be on the alignment/boundary. Area 

is the area to create and is initialized to the 

area of the selected boundary or, if an 

alignment, it is the area that would exist if 

a line was added between the first and last 

points. Acres (or Hectares) and Sq. Feet 

(or Sq. Meters) give the units for the area. Point # is the number to assign to the new 

point. Desc is the description to attach to the new point.  

When you click on the Calculate button, the program will calculate all of the possible 

solutions; there are up to two solutions. For each possible solution, a line will be drawn 

from the pivot point to the point that, if in the alignment/boundary, would create a 



 

alignment/boundary of the requested area. The bearing from the pivot point to the 

solution point will be shown in the dialog box next to one of the solution radio buttons. If 

there are no solutions, the solution section of the dialog box will be grayed out. If there is 

one correct solution, it will be displayed as the first solution and the second solution will 

be grayed out. If there are two correct solutions, they will both be displayed. You can 

select between them by clicking on the correct solution in the dialog box or by clicking 

near the appropriate point in the data window. Click on the OK button to create the point 

or click on Cancel to quit without creating the point.  

When working with a boundary, the Area must be smaller than the area of the boundary. 

If working with an alignment, the ending segments are assumed to be of infinite length to 

find possible solutions.  

By Sliding Line  
Predetermined Area by Sliding Line in the Bnd menu uses a selected 

alignment/boundary and will move a line of a given angle through the 

alignment/boundary from both directions to find up to two solutions that would give the 

specified area. Alignments behave exactly as if they are a boundary by inserting an 

imaginary  

line connecting the first and last points. Area is the area to create and is initialized to the 

area of the alignment/boundary. The area cannot be larger than the area of the 

alignment/boundary. Acres (or Hectares) and Sq. Feet (or Sq. Meters) give the units for 

the area.  

The angle of the line can be 

specified as an Azimuth, a 

Bearing/quad, or it can be 

specified to be parallel to a line. 

This line can be a drawn line in 

the data (Select Line), or a line 

defined by two points (Select 

Two Points). This section is 

very similar to the Line Define 

procedure on p.31.  

First Point # and Second Point 

# are the numbers to assign to 

the two new points and Desc is 

the description to attach to each 

point.  

  

When you click on the 

Calculate button, the program 

will calculate all of the possible 

solutions; there are up to two 

solutions. For each possible 

solution, a line will be drawn 

representing the position of the line that would yield the requested area. If there are no 

solutions, the solution section of the dialog box  

will be grayed out. If there is one  

correct solution, it will be displayed as  



 

the first solution and the second solution will be grayed out. If there are two correct 

solutions, they will both be displayed. You can select between them by clicking on the 

correct solution in the dialog box or by clicking near the appropriate line in the data 

window. Click on the OK button to create two points or click on Cancel to quit without 

creating the points.  

Fill Boundary  
You can create a hatched or solid fill with the Fill 

Boundary function. To select one of the preexisting 

fills, click on a pattern in the hatch window and click 

OK. To create your own, click on the New button. 

Select either “solid” or “line”. If solid, you will see a 

color pallet. Choose a color, and click OK. If line, you 

will see a dialog box asking for angle and spacing of 

lines. Click the Linetype button, and you will be able to 

choose any of the predefined or custom line styles in 

PC Survey. Select the Second Line option to create a 

hatch. Click OK.  

  

  

  

Legal Writer  
PC Survey can generate a user-configurable legal description given a selected boundary 

or alignment along with optionally selected lines and/or curves representing a 

commencing course to the boundary/alignment. Therefore, before using this function, a 

boundary or alignment must have been created that represents the property or route that 

you wish to describe. When working with a boundary, one may wish to start the 

description from a point not on the boundary, following some course to the POB of the 

boundary. This is a commencing course. When using a commencing course, all the lines 

and/or curves comprising the course must also be created before using Legal Writer.  

The Legal Writer works by examining each leg in turn of the selected course and 

applying an appropriate userdefinable “phrase” to the leg. Each phrase can contain 

“parameters” which are place-holders for values such as distances, bearings and names. 

The program places the leg’s values into the appropriate parameters and appends the 

phrase to the legal description. A default set of phrases is built into the program, but the 

user can modify these at any time in the Phrases.  

In addition to being able to program the phrases, the user also has control over the 

formatting of the parameters by modifying the settings in the Options portion of the 

function. The system units, precision, and use of parenthetical values are some of the 

things that can be modified.  

Changes to the phrases and options can be stored as a customized user definition. 

Multiple style definitions can be stored if desired.  



 

To create a legal description:  

1) Open the COGO Window.  

2) Select the alignment or boundary that for which you wish to generate the description. If 

working with a boundary and there exists a commencing course to the boundary, also 

select the lines and/or curves comprising the commencing course.  

3) Select Aln/Bnd | Legal Writer. A dialog will appear similar to the one shown above. 

The Create tab will be on top.  

4) Select Generate. The legal description will be generated and will appear in the large edit 

box in the Generate tab.  

Once a legal description has been generated, it can be edited, printed, saved to a file or 

copied to the clipboard. Generally, the surveyor will want to bring the legal description 

into a word processor in order to add additional information such as adjacent lot data, or 

county record details. The legal description created by PC Survey is not formatted (bold, 

italic, right justified, etc.). Importing the file into a word processor such as Microsoft 

Write (one of the Windows “Accessories” programs) allows the surveyor to both format 

and add additional information to the legal description.  

  



 

Phrases  
The Phrases tab allows one to review and edit the phrases that will be applied. There is a 

different phrase for each possible kind of leg. In addition, after describing the legs, either 

the Closed Trav or Open Trav phrase will be applied. In the definitions given below, the 

following terms will be used:  

  
Commencing course - a series of lines and/or connected lines leading to a boundary. If a 

commencing course is selected, the point where the commencing course connects to the 

boundary will be treated as the POB Commencing point - the point at the beginning of a 

commencing course.  

POB - or Point Of Beginning. If a boundary is being described and no commencing 

course has been selected, the POB will be the beginning of the boundary. The beginning 

half of the beginning course of a boundary is highlighted in half-white.  

  

The following are the possible phrase types that appear in the drop-down list of the 

Phrases dialog.  

Start w/Line - Line coming off of the commencing point.  

POB to Line - Line that is the first leg in a boundary  

Line - A line that does not meet one of the other line conditions  

Same Line - A line that comes immediately after another line in the alignment or 

boundary that proceeds in the same direction (has the same bearing).  

Line to POB - A line that is the last in the course of a boundary, therefore terminates at 

the POB Start w/Crv - curve coming off of the commencing point.  

POB to Crv - curve that is the first leg in a boundary  

  

The following apply to curves that are the first leg in boundaries that have a commencing 

course.  

POB to Tan Crv - curve is tangent to the last leg (line or curve) in the commencing 

course.  

POB to Non-tan Crv - curve is non-tangent to the last leg (line or curve) in the 

commencing course. POB to Comp. Crv - curve is a compound curve - tangent to the last 

leg of the commencing course, same rotation, but different radius.  

POB to Rev. Crv - curve is a reverse curve - tangent to the last leg of the commencing 

course, but with different rotation.  

POB to Same Crv - curve has the same radius and rotation direction as the last curve in 

the commencing course.  

  

The following applies to all other curves.  

Tan Crv - curve that is tangent to the previous leg (line or curve).  

Non-tan Crv - curve that is non-tangent to the previous leg (line or curve).  

Comp. Crv - curve that is tangent to the previous leg (curve), has same rotation direction 

but different radius.  

Rev. Crv - curve that is tangent to the previous leg (curve), but has different rotation 

direction.  

Same Crv - curve that is tangent to the previous leg (curve), has same rotation direction 

and radius.  



 

Cusp - not implemented. If interested in recognizing cusps, call to request 

implementation. Crv to POB - curve is last leg of commencing course.  

  

The following phrases are applied at the end of the description.  

Open Trav - used if describing an alignment.  

Closed Trav - used if describing a boundary.  

  

Parameters are various keywords, preceded and followed by a "%" character, that are 

placed within the phrases as placeholders for object values.  

  

An example of how this works is the default phrase for the "Tan Crv" phrase:  

 to the point of curvature of a tangent curve, concave to the %CONDIR%, having a radius of 

%RAD% and a central angle of %DELTA%; thence %ADIR% along said curve, a distance of  

%ALEN%  

When this phrase is actually applied to a tangent curve in a boundary, the following text may result   to 

the point of curvature of a tangent curve, concave to the southeast, having a radius of  

100.00' and a central angle of 91°50'30; thence northerly along said curve, a distance of 160.29'; thence 

N 88°02'45" E, a distance of 110.57'  
The parameters in this phrase are CONDIR (concave direction), RAD (radius length), DELTA (delta), ADIR 

(approximate direction) and ALEN (arc length).  

The following is a list of the parameters that can be used within the phrases:  
ANG    ANGle/bearing of 

line  

DIST    DISTance(lengt) 

of line  

ALEN  Arc LENgth  

DELTA  arc DELTA  

CHBEAR  CHord BEARing  

CHLEN  CHord LENgth  

CLR    Curve to the 

Left/Right  

CONDIR  CONcavity 

DIRection  

RPDIR  Radius Point 

DIRection  

ADIR  Approximate 

DIRection  

RAD    RADius length  

AREA  AREA of 

boundary (Acres, 

Hectare, Cuerdas)  

SQAREA  SQuare AREA of 

boundary (square 

feet, square 

meters)  

PERIM  PERIMeter 

length  



 

BNAME   

 Boundar

y NAME  

PNAME   Point NAME 

(description) of 

"from" point  

PNAME2  Point NAME2 

(description) of 

"to" point  

  

Options  
There are numerous options available for controlling the format of the displayed values. 

Selecting the Options tab will display a dialog similar to the one shown below.  

  
  
There are two main sections to this dialog - Primary Format and Secondary Format. 

Primary format refers to the principal value that is placed in the body of the text. 

Secondary format refers to an optional parenthetical value that is inserted after the 

principal value.  



 

There are three types of values - Angles, Distances and Areas. For each of these there is 

control over how many digits of Precision are displayed. In the case of angles, a 

precision of 4 will display minutes and seconds, whereas a precision of 5 will displays 

minutes, seconds and tenths of seconds, etc.  

Quadrant  
The following options are available for the Quadrant settings. For each setting, an 

example value of S 45°32'18" W (precision of 4) will be used to display the possible 

formats. as azimuth  225°32'18" N.E.xxxx  N.E. 45°32'18"  

NExxxx  NE 45°32'18" NxxxxE  N 45°32'18" E  

NorthEastxxxx NorthEast 45°32'18"
 
 

North-Eastxxxx North-East 45°32'18" NorthxxxxEast North 45°32'18" East The 

values shown are with the assumption that Spaced Quad Text is turned on, resulting in a 

padding space between the quadrant text and the angle values.  

Angle  
The angle formats allowed are shown below - simply pick the desired format from the 

drop-down list. The formats displayed are dependent on the system of units chosen 

(metric or English). The displayed values are for an example angle of 12° 34' 56" in the 

case of English units and 12.345 grads in the case of metric units. As mentioned above, a 

Precision value of 4 will display to the nearest second in the case of English units or to 4 

decimal places in the case of metric units (i.e. 12.3456).  

When English units are selected -  

None (only for secondary formats)  

12 34 56  

12-34-56  

12°34'56"  

12° 34' 56"  

12.3456 Degrees  

12.3456 degrees  

12 Deg 34 Min 56  

Sec" 12 deg 34 min 56 sec 12 Degrees 34 Minutes...  
  

When Metric units are selected -  

None (only for secondary formats)  

12.345 Grades  

12.345 grades  

12.345 Grad  

12.345 grad  

12.345 G  

12.345 Distance
  

The supported distance formats are shown below. Again, pick the style desired from the 

list. There are, again, two possible sets of formats - English or Metric. There is also a 

Precision control for these units. If English units are chosen -  
None (only for secondary formats) Feet feet Ft ft.  

F  

'  
If Metric units are chosen - None (only for secondary formats)  

Meters meters  



 

M 

m Area  
Area formats are straight-forward. Select from the list shown below. Precision control is 

allowed as usual.  
None (only for secondary formats)  

Square Feet  

Acres  

Square Meters  

Hectares  

Cuerdas  
  

Approx. Directions  
The approximate directions are used in describing the approximate direction of curves. 

There are four formats available.  

north  north, 

northeast, 

east, 

southeast, etc.  

North  North, 

Northeast, 

East, 

Southeast, 

etc.  

northerly  northerly, 

northeasterly, 

easterly, 

southeasterly, 

etc.  

Northerly  Northerly, 

Northeasterly, 

Easterly, 

Southeasterly, 

etc.  
  

Cardinal Directions  
This setting controls how angles are displayed when they are exactly in one of the four 

cardinal directions (North, East, South or West).  

 No change      angles are displayed normally (i.e. 

N 90° 00' 00" E)  

 North/South..      North, South, East, West  

 due North/due South..    due North, due South, due East, 

due West  

  

Zero-Pad Angles  
When enabled (the default), 1° 2' 3" is displayed as 1° 02' 03", etc.  

  



 

Spaced Quad Text  
As mentioned above, checking this option (the default) inserts a space between the 

quadrant text and the angle values in bearings.  

  

Intersections  
Bearing/Bearing  

Bearing/Bearing in the Intsct menu creates a new point at the intersection of two lines 

with known angles going through specified points. The Line Define dialog is used to 

define these two lines. If you are not already familiar with this dialog, please review 

its operation on p.32. To use this intersection function, 1) Select Bearing/Bearing from 

the Intsct menu. The first of two Line Define dialogs will be displayed.  

2) Define the first line by filling in the appropriate information for your problem in the Line 

Define dialog. Select OK.. A magenta line will be displayed on the screen representing 

the line you have just defined and the second Line Define dialog will appear.  

3) Define the second line by filling in the appropriate information for your problem in the 

Line Define dialog. Select OK. A second magenta line will appear. The solution lies at 

the intersection of the two lines. A third dialog, as shown below, will appear.  

4) A default Point Number will be shown. 

Enter a new Point Number or leave the 

default. Enter a Description for the new 

point, if desired.. The dialog will also 

display the Distance From First Point 

to the point of intersection and the 

Distance From Second Point to the 

point of intersection. These are the 

points that were specified as the Point on Line in the previous dialog boxes.  

5) Select OK to generate the new point. The magenta lines will disappear at this time.  

The following may be kept in mind,  

• Selecting Cancel in any of the dialog boxes will abort this function.  

• If the intersection point is initially off the edge of the screen, the display will 

automatically zoom to include the intersection point.  

• Like other functions, the dialogs are moveable while in this function. The dialog may 

obscure the intersection point. If such is the case, just move the dialog if you wish to see 

the area. You can also zoom with the right mouse button at any time.  

Bearing/Distance  
Bearing/Distance in the Intsct menu creates a new point at an intersection of a line and a 

circle. To define the line, a dialog box will be used. In this dialog box, enter the point 

number for a point on the line as the Point on Line. Like Point in Direction, the angle 

can be specified as an Azimuth, a Bearing/quad, or parallel to a drawn line in the data 

(Line), a line defined by the source point and another point (Select Second Point), or a 



 

line defined by any two points in the project (Select Two Points). For more detail on 

these options, refer to the Point in Direction function. When you click OK, a magenta 

line will be drawn representing the line you described.  

The circle represents the set of all points that 

are a given distance from a point. In the next 

dialog box, enter that point as the Center 

Point for the circle and then enter the 

Distance from the point that is the radius of 

the circle. When you click OK, a magenta 

circle will be drawn, showing the set of all points that  

are the given distance from the point. The point(s) at which the line and circle intersect 

represent the  

possible solutions.  

The final dialog box allows entering 

the Point Number and Description 

for the new point. It will also display 

the two possible solutions. The 

Distance From Point represents the 

distance from the Point on Line to 

the intersection point. The Bearing 

From Point represents the bearing 

from the center of the circle to the 

intersection point. Selecting a 

solution can be done by clicking on 

First Solution or Second Solution in 

the dialog box or by clicking near the desired intersection in the data window.  

  

Clicking Cancel at any time will abort this function.  

Distance/Distance  
Distance/Distance in the Intsct menu creates 

a new point at an intersection of two circles. 

The circles represent the set of all points that 

are a given distance from a point. In the first 

dialog box, enter one of the center points as 

the First Point and then enter the Distance 

from that point that is the radius of the circle. 

Next, enter the other center point as the 

Second Point and enter the Distance from 

that point for the radius of  

the second circle. When you click OK, two magenta  

circles will be drawn, showing the set of all points that  

are the given distances from the two points. The point(s) at which the circles intersect 

represent the  

possible solutions.  



 

The final dialog box allows entering 

the Point Number and Description 

for the new point. It will also display 

the two possible solutions. The 

Bearing From First represents the 

bearing from the center of the first 

circle to the intersection point. The 

Bearing From Second represents the 

bearing from the center of the second 

circle to the intersection point. 

Selecting a solution can be done by 

clicking on First Solution or Second 

Solution in the dialog box or by clicking near the desired intersection in the data window.  

  

Clicking Cancel at any time will abort this function.  

Tangent Curve  
Tangent Curve in the Intsct menu creates a 

new point that at the intersection of a circle 

and a line tangent to the circle that passes 

through a specified point. There will be two 

solutions. To use this function:  

1) Select Tangent Curve from the Intsct menu. At  

 least two points must already exist in order to use this function. The dialog shown to the 

right will appear.  

2) The Center Point is the center point of the circle. Either click near this point on the 

screen with the left mouse button or enter the point number into the edit box from the 

keyboard.  

3) Enter the Radius of the circle or select a line that has the desired radius as its length from 

the screen with the left mouse button. The Radius value must be less than the distance 

between the Center Point and Pt on Tangent.  

4) The Pt on Tangent is a point outside of the circle that lies on the tangent line. Enter a 

point number into the edit or select a point on the drawing with the left mouse button 

when the cursor is in this edit box.  

5) There should now be values in all three edit boxes. Select OK. If all the values are 

acceptable (the point numbers be those of existing points), a circle and two lines, tangent 

to the circle and passing through the Pt on Tangent, will be drawn on the screen. A 

dialog box will appear, similar to the one shown in the picture below.  

6) The Point Number is for the point that will be created at the intersection. Optionally, you 

can enter a description for this point and/or change the point number. There are two 

solutions. Select the solution  

that is desired either by left-clicking near the desired intersection point (where the circle 

meets the lines) or selecting the solution from the dialog. If you select the intersection 

point from the drawing with the left mouse button, the corresponding solution in the 

dialog will be checked. Select OK to create the intersection point.  



 

Clicking Cancel at any time will abort this function.  

  

Perpendicular Offset  
This function will calculate the perpendicular distance from any selected point to a 

defined line or to an  

 
existing selected object. Optionally, points can be created on the defined line or selected 

object at the point where a perpendicular line passing through the select offset point 

intersects the defined line or selected object (the ..Point at offset). Also, optionally, a line 

connecting the Point at offset and the selected offset point can be created.  

To use this function with a 

defined line:  

1) If anything is currently 

selected, clear the selections 

by using the C button in the 

select status bar or the Clear 

Select function in the Edit 

menu.  

2) Select Perpendicular Offset. 

The standard Define Line 

dialog will appear (see p.32).  

3) Fill in the desired parameters and select  

OK. A purple line will appear on the screen representing the reference line you have 

defined. Another dialog will appear, similar to the one shown below.  



 

4) Enter the Offset Point that is the point whose distance 

you want to check. You can either type in a point 

number or click near the point in the data window. The 

Offset Distance is the distance from the Offset Point to 

the near point on the line. If you were sitting on the 

Point on Line, facing down the line in the direction of 

the Offset Point, the Offset Distance will be positive if 

the point is on your right and negative if the point is on 

your left. The Base Distance is the distance from the 

Point on Line to the point on the line that is closest to 

the Offset Point.  

5) If you want the program to generate a new point on the line  

 where it comes closest to the 

Offset Point, click on Create  

Point at offset. If you click Continue, a new point may be  

created (depending on whether Create Point at offset is enabled or not) and the Offset 

Point will be cleared so that another point can be checked. Continue on click will 

activate the Continue button whenever you click near a point in the data window but only 

if Create Point at offset is enabled.  

6) If it is desired to additionally created line connecting the offset point and the point at 

offset, enable the Auto linedraw option.  

To use this function with a selected object:  

1) Select the object to calculate the perpendicular offset to. There must be only one selected 

object. If more than one object is selected, the function will revert to using the Line 

Define dialog. You may wish to clear the selection list first using the Clear Select 

function and then select the desired object.  

2) Select Perpendicular Offset. This time the Perpendicular Offset dialog will appear 

immediately, instead of the Line Define dialog being first displayed.  

3) Follow steps 4 through 6 from above to complete the function.  

  



 

Data Information  

Inverse  
Inverse in the COGO menu allows checking the bearing and 

distance between any two points in the project. When the 

function is first called, the From Point is assumed to be the 

occupy point but can be changed to any other point by 

typing in the point number, or by middle clicking near the 

desired point in the data window, or by setting the focus to 

the From Point edit box and left clicking near the desired 

point. Setting a point number in the To Point edit box is a 

similar operation except that it will not accept a middle 

click. Whenever there are valid point numbers in both the 

From Point and  

To Point boxes, the lower area of the dialog box will display 

the Distance between the points as well as the Azimuth and 

Bearing from the first point to the second point. If 

elevations are enabled, Elevation will show the elevation 

difference between the two points if the points both have valid elevations.  

To Location  
Clicking on the To Location button will change the dialog to allow inversing between a 

point and a coordinate location as shown. Like the Inverse (To Point) function, the 

distance between the points, as well as the azimuth and bearing from the occupied point 

to the coordinate, will be displayed. The North and East values can be typed in or picked 

off the data window by left clicking the mouse at the desired location. Clicking on the To 

Point button changes back to the first dialog.  

  



 

Tables  
The Tables command in the 

Misc Menu creates point, line 

or curve tables. Although the 

tables are created in COGO, 

they are actually placed on 

the sheet in the Layout 

window (yes, this is a little 

“non-intuitive” - maybe we’ll 

find a way to make it easier in 

a later release).  

 Multiple tables are allowed. 

The table entries, ordering, 

fonts and borders are all user-

configurable. Once created, 

tables can be edited and 

deleted.  

The list box on the left of the dialog displays all the currently defined tables of the type 

selected by the Table Type buttons.  

The Table Dialog  
To create a table:  

1) Select the objects that you wish to place in the table (the points, lines or curves).  

2) Give the table a unique Name. This is an internal name - it does not appear in the actual 

table (unless you title the table with that name), but is for your use when identifying 

which table to use in the various table functions.  

3) Select the Table Type.  

4) Select Create.  

At this point, one of three dialogs will appear, depending on which Table Type was 

chosen, unless a Name was specified that already existed in the list. These dialogs are 

explained in sections immediately following this one. If a Name is selected that is already 

in use, the 

program will 

prompt with 

the message 

shown below to 

make sure that 

an overwrite of 

the table 

previously 

defined with that name is desired. Selecting Yes at this point will replace the previously 

defined table with the new definition and will also cause any tables with this name and 

type in the Layout window to be deleted and replaced with this new definition.  

Select OK in the Tables dialog to finish the operation (or Cancel to abort the operation).  



 

Remember: Tables are created, deleted, defined and modified in COGO with the Misc-

Tables command. Tables are placed and displayed in the Layout window with the Draw-

Table command.  

The following entries are common to all the table creation dialogs (like the one below):  

• Enter the table’s title in the Title box.  

• The Columns section controls which parameters will be displayed in the table. Check the 

items that will appear in the table. Those which are not checked will not appear in the 

table.  

• Selecting Border will put a box around the table.  

• Selecting Column Lines will print lines between the columns in the table.  

• Selecting Headings will display the Fonts dialog (see p.29) to allow specification of the 

font to use for the title and column headings.  

• Selecting Entries will display the Fonts dialog (see p.29) to allow specification of the 

font to use for the actual data lines in the table (bearings, chord length, etc.).  

The following sections are explanations of the properties that are unique to the three types 

of tables.  

Curve  

  
Curve tables use a designator to identify the curve that is referenced in the table. The 

designator is a boxed character that will appear by the curve. The left-hand list box 

shows the designators for all selected curves.  

All designators that are highlighted will be shown in the layout table. Designators that are 

not highlighted will not be included in the table. Since there is currently no easy way to 

know which designator applies to which curve before the table is created, be sure to 

select only those curves that you wish to place in the table.  

When the table is created, the designators will appear by their curves in the COGO 

window. You will generally want to move the designators using the standard left-

click-hold-and-drag operation after they have been created. This is because there is 



 

no way for the program to intelligently place the designators, so they default to a position 

on top of the curve.  

The curve parameters which can be displayed in the table are Radius, Tangent, Arc 

Length, Central Angle, Degree of Curve, Chord, and Chord Bearing.  

By default, curve designators begin with the letter ‘C’, followed by a number (C1, C2, ... 

C21, ..., etc.). It is possible to change the designator by editing its contents with the Edit 

Text command. Changing the designator text will automatically change its value in the 

table as well.  

Line  

  
The left-hand list box shows the endpoint numbers for all selected lines with a dash 

between the starting and ending point numbers. All lines that are highlighted will be 

shown in the layout table. Lines that are not highlighted will not be included in the table. 

Lines can be highlighted or un highlighted by clicking on the entries with the mouse. The 

line parameters that can be displayed are From point, To point, Bearing, and Distance.  

Selecting Use Labels will assign a label to each of the lines in the table. The label values 

default to L1, L2, L3, etc. Similarly to the curve tables, the labels will appear as moveable 

graphics near the center of their line in the COGO window. The labels can be edited with 

the Edit Text function after first selecting the label graphic in the COGO window. 

Changes that are made to the text of the label will be reflected in the table as well.  



 

Point  

  
The left-hand list box shows all selected point numbers. All points that are highlighted 

will be shown in the layout table. Points that are not highlighted will not be included in 

the table. The point parameters that can be displayed are Number, North, East, 

Elevation, and Description.  

Editing Tables  
Once a table has been created, it can be edited. Editing a table allows the surveyor to add 

or delete table entries, modify the display characteristics (fonts, borders, and column 

lines), change the included parameters, sort the entries, and examine the table contents.  

  

    Example of the Edit Curve Table Dialog  
To edit a table:  



 

1) Select the Table Type in the Tables dialog box (see p.178). A list of all tables of that type 

will appear in the listbox on the left.  

2) Select the name of the table that is to be edited from the list.  

3) Select Edit. One of the Edit Table dialogs will appear.  

Once the Edit Table dialog appears, the columns, fonts, etc. can be altered in the same 

way as when the table was initially created. There are some additional features, however.  

The Table Entries section allows the surveyor to Insert, Sort and Delete entries in the 

table.  

To Insert additional or Delete table entries:  

1) Select all objects that are to be added to/deleted from the table before invoking the 

Tables-Edit function.  

2) Select the items in the Edit Table listbox on the left side. Select All will select 

everything.  

3) Select OK.  

  

To Sort the table entries:  

1) Select all entries that are to be sorted from the listbox on the left.  

2) Select Sort by.... The 

Sort Dialog will 

appear.  

The dialog allows 

the surveyor to sort 

the table by up to 

three “keys”. A key 

is a field to order the 

table by. For 

instance, in the 

dialog shown, the First Key is  

Radius in Ascending order.  

This means that selected curves will be placed in the  

 table in the order of their  The Table Sort Dialog  
Radius value. Therefore a curve with a radius of 10 will precede a curve with a radius of 

15. The order would be reduced if Descending was specified.  

The First Key is required, but the second and third keys are optional -that is why they 

have checkboxes next to them. Second and third keys are used only if the value of the 

first key for more than one entry is the same. For instance, if three curves all have a 

radius of 50 and the First Key is Radius, they would appear together in the table. Then, 

specifying a second key of Arc Length would then allow those curves to be further 

ordered accord to their Arc Length, and so forth.  

Select OK when the settings are complete.  

    



 

Data Modification  
Coordinate Transformations  

There are two Coordinate Transformation routines provided within the COGO routines. 

The Standard method allows the surveyor to transform a set of points given specific 

linear and/or angular transformation values. The Best Fit method is a two-dimensional 

least square approach that will find a transformation for a selected set of points given two 

or more control pairs (i.e. point A moves to point B, point C moves to point D, etc.) that 

minimizes the total error (distance) between the control pairs. This second method is 

useful for problems such assembling multiple sets of property data.  

Standard  
Coord. Transformation - 

Standard in the COGO menu 

will scale, rotate, and 

translate a group of objects. 

The original data can be 

retained, in which case a 

different overlay can be used 

to place the new data. If 

keeping the original data, a 

new point range must also be 

specified.  

Rotation and scaling are 

performed around an origin 

point that can either be 

specified as a Coordinate that 

will have a North and East 

value or as a Point that just 

takes a point number. The 

Scale is a multiplication 

factor. Example: a scaling 

factor of 2 will double the 

distance between the point 

and the origin. Set the 

Rotation Angle to the number 

of degrees to rotate the point 

counter-clockwise about the origin.  

Linear Transformation refers to the translation to perform on the point after rotation and 

scaling. An Absolute mode will move each point by the specified North and East  

values. Relative mode will move the points by the amount necessary to move the From 

Pt. to the To Pt. Elevation is the change to apply to the elevations of the points, if  

elevation is enabled.  

To use this function: 1) Select the objects to transform. Objects include points, text, lines, 

and arcs.  

2) Select Coord. Transformation from the COGO menu.  



 

3) Fill in the dialog and select OK.  

The following conditions apply:  

Data Copy:  

• If Retain Original Data is not enabled, entries in this section are disabled  

• When Retain Original Data is enabled, the following apply:  

◊ The Overlay for New Data will default to the Base overlay. To place the translated data 

on a new overlay, a second overlay must first exist. (See the section on Overlays on p.114 

to learn how to create new overlays.) It is recommended that a unique overlay be used so 

as to be able separate the new data from the old.  

◊ The Starting Point Number specifies what number to start at for placing the new data.  

◊ If Keep Point Number Spacing is enabled, newly created points will maintain the same 

point number spacing as the original data. For instance, if the original data points were 

points 3,5,7,8, and 9, the Starting Point Number is 40 and Keep Point Number Spacing 

is enabled, the new points would be numbered 40, 42, 44, 45, and 46.  

Linear Transformation:  

• Linear transformation defaults to “no linear 

transformation”.  

• Specifying an Elevation value other than zero 

will cause all selected points’ elevations to be 

incremented by the given value. An elevation of 5.0 will cause a point with an elevation 

of 20.0 to have a new elevation of 25.0.  

• When Relative mode is chosen, a linear transformation is performed from the first 

specified point to the second specified point. That is, all objects are moved the distance 

from the From Pt. to To Pt. and along the same angle as that from the From Pt. to the To 

Pt.  

• When Absolute mode is chosen, the transformation values become North and East as 

shown to the right.  

Transformation of all selected objects is then the specified distance in the North and East 

directions.  

Rotation:  
• The default rotation value is “no rotation”.  

• Selecting the Absolute rotation mode permits 

specifying the rotation as an absolute angle  

(which can also be a formula). Positive angles are clockwise, negative angles are counter-

clockwise.  

• Selecting the Relative rotation mode allows the angle to specifying as the angle from Dir 

1 (direction 1) to Dir 2 (direction 2) As shown on the right, the Angle text box will 

become disabled. The Dir 1 and Dir 2 buttons are invoke the familiar Line Define dialog 

for defining the directions  



 

Origin:  
• The Origin defaults to North:0.0, 

East:0.0.  

• The Origin values are not used unless 

a rotation other than 0 or a Scale factor 

other than 1 is specified. With a non-zero  

 rotation, all selected data is rotated with the Origin value as the pivot location.  

• In the Coord entry mode (the default), the origin is specified as a Northing and Easting.  

• In the Point entry mode, a point number is either typed into the box labeled Point or 

selected from the screen (see picture on the right).  

Scale:  

• The scale defaults to 1 - no change. •  Scale factors greater than one will increase 

distances while values less than one will decrease distances. Scaling is relative to the 

Origin.  

State Plane to Ground  
This function is used to convert point locations between a state plane and local grid 

coordinate system. The transformation can work in either direction and involves linear, 

angular and scaling transformations. Scale factors are obtained by calculating the centroid 

of the area bounded by the selected points and calculating the combined scale factor at 

that location using standard state plane formulas. Linear transformations are possible only 

if a state plane and ground(local grid) origin are specified. For angular transformations, 

an additional pair of points must be designated. Scaling can be done independently when 

given only state plane coordinates.  

As a reminder, state plane coordinates are, by definition, on the ellipsoid and are, with 

few exceptions, closer together than the same coordinates as measured on the ground 

since the ellipsoid is typically about 100 ft. below sea level.  

To use this function:  

1. Select the points that are to be transformed.  

2. Select COGO-Coord. Transformation-State Plane to Ground.  The 

following dialog will be displayed.  

  



 

  

There are several ways to use this function.  

•  You have state plane coordinates and want to scale them to obtain 

relative positions as would be measured on the ground.  

3. Select State Plane to Local  

4. Check Scale and select an Origin by either typing the number of or 

clicking near a selected point (cursor must be flashing in the Origin edit 

box when clicking near a point).  
  

• The same problem as above but, in addition, you want to rotate the 

system to true north. Remember that state plane north and true north are 

different and that the difference is essentially what is called the 

“convergence angle”. The program can calculate the convergence angle 

and automatically apply it if desired. Apply the same steps as above but 

check Apply Conv. Angle.  
  

• You have state plane coordinates and one corresponding ground 

coordinate and want to put those two points on the same coordinates.  

(Select the state plane points if you wish to translate them to the ground 

coordinates or else the local grid points if you want to translate them to 

state plane coordinates.)  

3. Select State Plane to Local if transforming state plane points else select 

Local to State Plane if transforming local grid points to state plane.  

4. Check Linear Transform and Scale. Uncheck Angular Transform.  

5. Enter or select the origins for the state plane points and the local grid 

points. The selected set of points will be translated so that these two origin 

will be at the same location.  
  

• You have state plane coordinates and two corresponding ground 

coordinates and want to match locations of the first pair of 

coordinates and rotate so that the second pair of of coordinates are in 

the same direction from the first pair of coordinates.  

Apply the same steps as above and add the following steps:  

6. Check Angular Transform.  

7. Enter or select the Reference Pt. values for the state plane and local grid 

points.  
  

Final Step  

8. Press OK.     



 

Best Fit  

  
In the set of points shown above, assume that points 1 through 4 represent data obtained 

from a map. Assume that points 5 through 8 represent data obtained in the field which we 

want to match to the map data. Assume, moreover, that we know that point 8 corresponds 

to point 4, point 6 corresponds to point 2 and point 7 corresponds to point 3. We want to 

find a transformation of point 5 through 8 that will minimize the total distance error 

between the three pairs we just listed.  

Coordinate Transformation - Best Fit is a function that can do this. Given a set of 

selected points and a set of control pairs such as that we just described above, this routine 

will calculate a best fit of the control point pairs through a least squares method and apply 

the transformation to all the selected points. Additionally, the point pairs can be 

individually weighted (assigned higher or lower priority) in the calculation.  

In this example, to use this function,  

1) Select points 5 through 8 either with the mouse or through the command line (by typing 

SP 5-8 < Enter>).  

2) Select Coordinate Transformation - Best Fit from the COGO 

menu in the COGO window. A dialog similar to the one 

shown on the right will appear (it’ll probably be taller, but 

we’re trying to conserve paper). Each line of the dialog’s 

spreadsheet represents one control pair. The From column 

must contain an existing point from the selected points. The 

To point is an existing point that must be unselected. The 

Weight will default to 1.0.  

3) Enter the control pair data. Data can be entered by either 

typing in the desired values or, in the case of the From and To 

columns, selecting a point from the screen with the left mouse 

button. The entries in the picture correspond to the example 

shown above.  



 

4) Select DO IT!. A report dialog will appear, similar to the one shown below, giving a 

report of the results of the transformation. The data can be examined within the report 

dialog, logged to the  

 session log file, printed 

with the Print button, or saved to some specific file with the Save As button.  

  

5) Select OK to complete the function.  The selected points will be 

transformed and redisplayed on the  screen. The picture to the right shows  

the result of the transformation on the  example data.  

  

Notes:  

• The Edit - Undo function can be used to undo the transformation.  

    



 

• This is a two-dimensional transformation - point elevation data is unaffected.  

Other Functions  
Occupy/Backsight  

Occupy/Backsight in the COGO menu 

sets the current stationing or occupy point, 

backsight point or angle (bearing or 

azimuth), the height of instrument and rod. 

When the Occupy/Backsight command is 

selected, the dialog box shown on the right 

displays.  

Occupy Point  
This setting specifies the point that is 

currently occupied/or stationed. The point 

can be selected from the data window or 

entered from the keyboard.  

Command: OC Pnt  
  

  

Backsight Settings  Occupy/Backsight Dialog  

The backsight may be specified by either the point number, the measured bearing and 

quadrant, or the measured azimuth. Each option is described in the  

following section:  

Back Point  This setting sets the backsight by point number. When this option is used, a 

"Point" edit box displays on the right side of the Occupy/Backsight dialog box. 

The point may be selected from the COGO data window, or the 

corresponding point number can be entered in.  

Back Bearing  This setting sets the backsight by specifying the measured bearing and 

quadrant. When this option is used, a "Bearing" edit box will display on the 

right side of the Occupy/Backsight dialog box.  

Back Azimuth  This setting sets the backsight by specifying the measured azimuth. When 

this option is used, an "Azimuth" edit box displays on the right side of the 

Occupy/Backsight dialog box.  

  
Command: BS Pnt  
  



 

Height of Instrument (HI)  
This edit box establishes the instrument height to be used. This is the elevation of the 

optical axis of the instrument above datum (not the height above ground).  

Command: HR Val  

Height of Rod (HR)  
This edit box establishes the rod (prism) height to be used.  

Command: HR Val  
  

Next Number  

  
Next Number in the POINTS menu controls the number that will be assigned to the next 

point created.  

• Enter the number in Next Number that the program should attempt to use for creating the 

next point.  

• Fill will not allow using any point number that has already been used. If the program 

attempts to create a point with a point number already in use, the new point will be 

assigned the next unused number.  

• Overwrite allows using numbers already in use and therefore can overwrite exiting 

points. For that reason (this option can be dangerous), Overwrite has a Prompt and a No 

Prompt option.  

⇒ In Prompt mode, whenever the program attempts to create a point with a number already in 

use, it will ask whether or not to overwrite the old point with the new point.  

⇒ If No Prompt is selected, the program will automatically overwrite the old point with 

the new point.  

The Point Number Report options can be used to generate a report of the used or unused 

point numbers within a project and within a given range of values. The report is sent to 

the Main Window.  

• Enter the beginning and ending point number values in the Start at Pt and End at Pt edit 

boxes.  

• Select Used or Unused according as to whether you want to know which point numbers 

have been used or which point numbers have not yet been used.  



 

• Select Generate.  

Example: if Start at Pt is 25 and End at Pt is 64, only point numbers with values between 

25 and 64  

Triangle Solver  
The Triangle Solver in the View Menu is a calculator that, 

given three triangle side/angle parameters or values, calculates 

the values for the remaining three side/angles. The 

abbreviations used in the dialog are demonstrated in the 

diagram to the right. Notice that angle a is subtends side A, 

angle 

b 

subtends side B and angle c 

subtends side C.  

To solve for a  

triangle, any of the following sets of parameters (or values) can be used:  

• Three sides.  

• Two sides and an included angle (i.e. side A, side B and angle C).  

• Two angles and any side. To use this dialog:  

1) Enter the desired values into the corresponding edit boxes. Use the mouse or the <TAB> 

key to move between edit boxes.  

2) After the third value is entered, press the <TAB> key or left-click with the mouse on an 

edit box other than the one just used. The remaining values will be displayed in their 

corresponding edit boxes.  

3) Select Done to exit the function or Erase to clear the values and start another calculation.  

The following notes apply:  

• After two values are entered into the dialog, certain entry boxes will be disabled in order 

to force the conditions just mentioned. For instance, after entering a value for angle a and 

angle c, the edit box for angle b will be disabled since specifying the three corner angles 

does not provide a unique solution.  

• Distance formulas and distance selection from the screen can be used for entering the 

Sides data.  

• Angle formulas and direction selection from the screen can be used for entering Angles 

data.  

• As with all edit boxes, values can be cut, copied and pasted via the Windows clipboard.  

  



 

Regular Expressions  
Regular expressions are used for specifying a single pattern which can match any 

number of strings. Regular expressions provide a means of specifying many strings using 

a single pattern. The following characters are used:  

*  O or more occurrences of preceding 

pattern.  

%  Beginning of line  

$  End of line  

?  Any character  

[  Beginning of character set  

]  End of character set  

^  Negation of character set if immediately 

follows [  

-  Used for range of characters when between 

[ and ]  

#  integer value - used in Auto Draw  

\  Interpret a special character literally.  

\t  Tab character  

\n  Newline character  

Some examples are:  

%AB matches any string that starts with AB such as AB, ABC, ABCDEFGHI.  

AB$ matches any string that ends with AB such as AB, GXAB, DEFGHAB.  

%AB$ matches only those strings that are simply AB.  

AB*C matches only those strings that have an A and a C with 0 or more Bs in between 

such as AC, ABBC,  

XBYABBBBCDEF.  

A?C matches those strings with an A and a C and any character in between such as ABC, 

WATCH. PT[012] matches any string with PT0, PT1, or PT2 in it.  

PT[0-9] matches any string with PT0, PT1, PT2, PT3, PT4, PT5, PT6, PT7, PT8, or 

PT9 in it.  

PT[^0-9] matches any string with a PT in it that is not immediately followed by a 

digit. APTX, and PT will match but IPT5 will not.  

PT[A-Za-z] will match any string with a PT that is immediately followed by an 

alphabetic character.  

PT[A-Za-z0-9] will match any string with a PT that is immediately followed by an 

alphanumeric character. PT[A\Z] will match only those strings with PTA, PTZ or PT- in 

them.  

The DTM Window  
The DTM (Digital Terrain Model) Window is used for generating the TIN (Triangulated 

Irregular Network), contour lines, TIN-based profiles and calculating volumes. Control 

over contour parameters include the major and minor contour intervals, minimum and 

maximum elevation values over which to generate the contours and the degree of 

“smoothness” for individual contour segments. The TIN can be manually adjusted. Break 

lines can be used to identify local minimums and maximums. The line types and colors of 



 

contours can be altered. Elevation labels can be manually inserted or automatically 

generated at a user-specified interval.  

  

The first step in using the DTM is to define at least one surface. Surfaces are initially 

created through the TIN-Insert Points function after selecting a set of points that 

comprise the surface. Each defined surface must have a unique name consisting of one or 

more characters (Surface 1, Ground Zero, Fido’s Craters, etc.). Once a surface is 

defined, it can be TINTriangulated to create its TIN. Contours can be generated once the 

TIN has been created through the Contours-Generate function.  

Project  
New, Open, Save, Save As, Close, Exit  

These all behave the same as they do in all of the other windows.  

Print  
This will print the current view as shown in the DTM window. The screen view will be 

scaled to fit the printer page, maintaining the aspect ratio. (That just means that the 

relative sizing in both the x and y directions will be the same so that one will not stretch 

more than another. To keep the aspect ratio the same, it may be necessary to include more 

data in either the x or y dimension than is shown on the screen.).  

Edit  
Linestyle  

Set Font  

Set Color  

Set Layer  

Delete  
Delete is a generic function that will delete all selected objects, be they points, segments, 

or breaklines. Just select the objects that you want to delete and only the objects you 

want to delete and then select Delete from the TIN menu.  

Cross Sections  
To create a cross section:  

1. Create alignment  

2. Create tin(s) and/or make sure that all alignment points have elevations.  

3. Select alignment  



 

4. Select Cross Sections in Edit menu in DTM window.  

5. Set up cross section information  

  

To set up cross section information:  

• Start Elev and End Elev  

Initially set to lowest and highest elevations of the points along the alignment. Change 

these values if you want to change the range of elevations displayed along the vertical 

axes of the cross sections. • Offsets  

Be SURE to enter the distance to the left and right that the cross sections will extend off 

of the alignment.  

• Multiple Stations  

Enter the starting station, ending station, and how often between these stations to create 

cross sections.  

• Individual Stations  

Add any other station values at which to create cross sections.  

• Existing, Proposed, and Other Surfaces  

If you want to display elevation values for one or two surfaces at an offset of 0 for each 

cross section (in other words, at the point that is on the alignment), you can select the 

surface for the existing or proposed surface. The elevation of the alignment on the surface 

selected for Existing will be displayed (by default) to the left of the grid line at 0+00 and 

the elevation on the surface selected for Proposed will be displayed to the right of the 

grid line. Both of these surfaces will have their profile shown in the cross section. If you 

want to show the profile of any other surfaces, select them in the Other Surfaces dialog 

box.  

• Horizontal Axis/Vertical Axis  

Set the axis information by selecting the Horizontal axis button and/or Vertical axis 

button.  

  

To set the axis information:  

• Scale  

set the scale in feet/inch  

• Display  

controls whether to display the scale information and, if so, what font and color to use.  

• Axis Display  

control the size in inches of the margin as well as the font to use for the tic annotations 

and the linetype and color to use  

for the tics.  

• Major and Minor Grid  

control whether or not to display the corresponding grid lines. Click on the Info button to 

control the interval or spacing  

between the grid lines as well as the linetype and color to use for the grid lines.  

• Major and Minor Tics  

control whether or not to display the corresponding tic marks. Click on the Info button to 

control the interval or spacing  

between the tic marks, the length in inches of the tic marks, as well as the linetype and 

color to use.  

• Existing Lt/Finish Rt and Finish Lt/Existing Rt  

Controls which side of the 0+00 grid line to place the elevations of the existing and 

proposed surfaces.  



 

• Annotation Elevations  

Turn off the display of the existing and proposed elevations on the 0+00 grid line.  

• Edit Window  

To look at one of the cross sections, click the Edit Window button. This will bring up a 

list of the cross sections that have been or will be created along this alignment. Select the 

appropriate cross section and click OK. A window will be displayed showing the selected 

cross section. This window is similar to other windows in the program and, for example, 

allows zooming and selecting just like all of the other windows.  

If one of the parameters already selected needs to be changed, go to the Edit menu in the 

Cross Section window and select Edit from the menu. This returns you to the same 

dialog you were just in so you can change any of the above parameters. Objects in this 

window can be selected and their colors and/or linestyles changed. They can also be 

deleted.  

  

To print out the cross section:  

1. Go to the Layout window.  

2. Select Cross Section from the Draw menu. A pink box will be displayed showing the 

dimensions necessary to display all cross sections.  

3. Move the pink box to the appropriate position on the sheet and then click the left mouse 

button. The cross sections will be displayed on the sheet. They will be placed as a unit 

and are moved as a unit. If you want to further refine the display of the information, you 

can select the complete cross section information as placed on the sheet and then select 

Smash from the Components menu. This will break down all of the information into the 

constituent lines and texts.  

4. Select Print from the Project menu of the Layout window.  

TIN  
These functions control the points which can be in the TIN, the segments which are in the 

TIN, and the breaklines.  

Insert Points  
Insert Points is used to select which points can be placed in the TIN. The DTM window 

will only allow selecting points which have a valid elevation. Points with an invalid 

elevation will not be selectable. Points that are not currently “in the net” will be drawn in 

gray. To use this function,  

1) Select the points that you want in the TIN. The points which are selected will be 

highlighted, the same as if they had been selected in the COGO window..  

2) Then select Insert Points. The points will be redrawn in their original COGO color. Only 

these inserted points will be used when creating the TIN.  

3) Use the Triangulate function to create the TIN from the inserted points.  

The DTM window has a point filter that is similar to that of the COGO window (see 

p.111). This filter can be used, among other things, to restrict the range of point 

elevations that can be selected.  



 

Insert Segment  
Insert Segment is used to manually create a triangulation segment. This might be used 

when the automatic TIN generator does not create the TIN exactly as desired. To add 

segments, select Insert Segment from the TIN menu. You will first be prompted for the 

TIN in which to insert the segments. Then you can type in the point numbers or click near 

the points in the DTM window. If you just want to create the one segment, select DONE 

after entering the point numbers. To create more, select Continue. To quit without 

creating this segment, select Cancel. More than one segment can be created at once, 

using commas to separate point numbers and semicolons to end one segment before 

starting another. In the example dialog, segments will be created from 4-5, 10-11, 11-12, 

and 12-14.  

Triangle Swap  
Triangle Swap will remove selected segments between two triangles and will replace 

them with a segments that connect the opposite corners of the triangles. For example, 

given the following triangulation,  

 
if you select the segment connecting 108 to 120 and the segment connecting 105 to 107, 

the segment connecting 108 to 120 will be replaced with a segment connecting 107 to 

119 and the segment connecting 105 to 107 will be replaced with a segment connecting 

106 to 108.  

Insert Breakline  
Insert Breakline is used to create a breaklines - segments of the triangulation that will be 

“locked in” during triangulation. Breaklines are usually used for peaks and valleys within 

the surface to force correct contour generation. To use this function:  



 

1) Select Insert Breakline from the TIN menu. You 

will first be prompted for the TIN in which to insert 

the breaklines as shown in the dialog to the right. 

Select OK when done.  

2) A dialog similar to the one on the right will then be  

displayed. This dialog behaves in a similar manner 

to the Connect Points dialog (see p.133). Insert a  

point number into the Starting at edit box 

either by typing in a number or, with the focus 

in the edit box, clicking near the desired point 

on the screen.  

3) Next, enter one or more numbers into the 

Point Number edit box OR turn on the 

Continue on mouse click option and click 

near each point on the screen to enter 

successive breakline segments.  

  

4) Select OK when you are finished. Select  

Continue if you are typing in the Point Numbers and wish to add some more. Select 

Cancel to abort the function.  

Notes:  

•  More than one segment can be created at once, using commas to separate point numbers 

and semicolons to end one segment before staring another, In the example dialog above, 

the segments 2-5, 5-6, 6-7, 7-8, and 4-9 will be created.  

Auto Breaklines  

  



 

Using a system similar to the Auto Draw function (see p.137), breaklines can be 

automatically created by using the point descriptions.  

To use this function,  

1) Select Auto Breaklines from the TIN menu. A dialog similar to the one shown above will 

appear. Each line of the dialog contains a auto-breakline definition that controls how the 

breaklines will be generated.  

2) The checkbox in the second column of each controls whether that line will used in the 

mapping. Check/uncheck all the rows that are to be used/not used.  

3) Select OK to create the defined breaklines. Select Cancel to abort the function.  

To Add a new definition,  

1) Select Add. An empty line will be added to the list below the current line (the line that 

has the focus or cursor flashing in one of the line’s boxes).  

2) Enter a unique Name for the definition in the Name column.  

3) Enter the Start, Continue and End patterns. Remember that these can be regular 

expressions.  

4) The layer, line style, width and color will be that of the default layer for breaklines unless 

changed in the mapping definition. For example, changing the width from 0.00 (which 

tells the program to use the default value) to 0.01 will alter the width of the lines used for 

the breakline generated by that definition, but will leave all other settings the same as the 

default values.  

To Delete an existing definition,  

1) Left-click anywhere in the row that is to be deleted.  

2) Select Delete. The row that currently has the focus will be deleted.  

Alignment Breaklines  
Alignment Breaklines is used to translate cogo alignments into breaklines - segments of 

the triangulation that will be “locked in” during triangulation. To use this function:  

1) If the alignment(s) does not yet exist, create it in COGO.  

2) Select one or more alignments.  

3) Select Alignment Breaklines from the TIN menu. Breaklines will be created for each line 

in the selected alignments.  

Triangulate  
This function triangulates all current contour points within a selected surface.  

1) First, make sure that all desired points have been selected and inserted into the list of 

contour points with the Insert Points command.  

2) Select Triangulate from the TIN menu. If more than one TIN has been defined the Select 

TIN dialog will appear. If so, select the desired TIN from the Select TIN list and select 

OK.  



 

3) The TIN will now be generated. Dialog boxes will appear showing the state of the 

triangulation. Clicking on Cancel in one of these dialogs will abort the generation of the 

triangulation.  

Notes:  
If breaklines are to be used, insert these first, either by using the manual Insert Breakline 

function or the Auto Breaklines function.  

Info  
The Info function is used to obtain general information about all existing TINs. 

Information provided includes the perimeter and surface area.    

Contours  
Generate  

This function creates the contour lines for a specified surface. The Contours-Settings 

function control the major and minor contour intervals, automatic labeling and the 

elevation range over which to contour.  

Settings  
The Contour Settings dialog is used to control which elevation contours are generated as 

well as automatic label generation.  

Major Interval and Minor Interval are used to define the major and minor contour lines. 

Major and minor contours are placed on different layers, so it is possible to use different 

line styles for each type of contour. Generally, minor contours are specified so as to occur 

at some even interval between the major contours. For example, one might place major 

contours at 10 ft. intervals (100, 110, 120, etc.) with minor contours at 2 ft intervals (102, 

104, 106, 108, 112, etc.).  

The surveyor can also specify what Minimum Elevation and Maximum Elevation to use 

for generating the contours. Contours with elevations below the Min Elevation or above 

the Max Elevation values will not be generated.  

Valid Elevation Range is used to specify what point elevation values are useable in 

generating the TIN. If it is blank, all selected points with elevations are inserted in the 

net.  

Valid range strings must start with a number followed by a hyphen. A maximum range 

value is optional.  

Examples: 200-450(all values between 200 and 400, inclusive) or 1-(all values greater 

than or equal to 1)  



 

So, in the example 

from the following 

dialog box, minor 

contour lines will 

be placed for every 

two foot change in 

elevation and they 

will not be labeled. 

Major contour 

lines will be placed 

for every ten foot 

change in elevation 

and they will be 

labeled with the 

elevation value of the line and the labels will be placed every 375 feet along the contour 

line. The contour lines will  

not include elevations lower  

than 243.95 or higher than  

270.32 so, in this case, major contour lines will be created for 250, 260, and 270. Minor 

contour lines will be created for 244, 246, 248, 252, 254, 256, 258, 262, 264, 266, and 

268. Grid points will be placed every 10 feet.  

Add Labels  
Contour elevation labels can be generated automatically through the Contour Intervals 

dialog (see above) or they can be manually placed with the Add Labels function. To use 

this function, 1) Select Add Labels from the Contours menu.  

2) Move the mouse cursor to the point on the desired contour where an elevation label is to 

be inserted.  

3) Left-click the mouse. The contour line will be broken and a elevation text will be inserted 

at that point.  

Notes:  
• The precision (number of decimal places) in the label is controlled by the Precision 

settings in the Environment - Options dialog (see p.60).  

• Once created, elevation labels can be moved and rotated like other texts. Contour lines 

will be broken or repaired automatically.  

Smoothing  
This function allows you to control how much the 

contour lines curve. Before explaining the different 

options for applying the smoothing factor, a couple of 

definitions are helpful:  

  

⇒ Contour Segment: The part of a contour line that crosses from one TIN line to another. 

Each contour segment is separately selectable, primarily to allow this function to apply 

different smoothing factors to different parts of a contour line. Longer contour segments 



 

will curve more than short contour segments and may need to have smaller smoothing 

values.  

⇒ Smoothing: The amount of curvature of a contour line from one TIN line to another. This 

number can be between 1 and 250 where 1 is no smoothing and 250 is maximum 

smoothing. The default value is 50.  

The options for applying the smoothing value to the selected contour segments are:  

• Apply to entire contours: The smoothing value will be applied to the entire contour lines 

for all contour segments that have been selected.  

• Apply to ends of segs: The smoothing value will apply to both ends of all selected contour 

segments.  

• Apply to intersections: The smoothing value will only be applied to the common endpoint 

of adjacent selected contour segments.  

Set Font  
  • This function operates on selected contour labels. See the Fonts section on p.29 for 

more information  

.  

Volumetrics  
Prismoidal  

The Prismoidal volumetrics function is used for volume calculations. It will display the 

following dialog:  

  
To calculate the total volume between two surfaces:  

1. Create the two TINS which represent the existing and proposed (or design) surface.  

2. Select Existing Surface and pick the surface to use.  

3. Select the surface to use for the Design Surface.  

4. Click Calculate. The cut and fill values will be displayed.  

To calculate the volume between a surface and a reference elevation:  

1. Create the TIN which represents the proposed (or design) surface.  



 

2. Select Datum Elevation and enter the elevation.  

3. Select the surface to use for the Design Surface.  

4. Click Calculate. The cut and fill values will be displayed.  

To calculate the volume between two surfaces within a specified area:  

1. Create the two TINS which represent the existing and proposed (or design) surface.  

2. Select one or more boundaries before selecting Volumetrics | Prismoidal. If exactly one 

boundary has been selected before starting this function, the name of the alignment will 

be displayed at the top of the dialog box.  

3. Select the Existing Surface and pick the surface to use.  

4. Select the surface to use for the Design Surface.  

5. Click Calculate. The sum of the cut and fill values within the boundaries will be 

displayed.  

To calculate the volume between a surface and a reference elevation:  

1. Create the TIN which represents the proposed (or design) surface.  

2. Select one or more boundaries before selecting Volumetrics | Prismoidal. If exactly one 

boundary has been selected before starting this function, the name of the alignment will 

be displayed at the top of the dialog box.  

3. Select Datum Elevation and enter the elevation.  

4. Select the surface to use for the Design Surface.  

5. Click Calculate. The sum of the cut and fill values within the boundaries will be 

displayed.  

To get a printed report of the results:  

1. Click Report.  

2. Click Print.  

3. Click OK to return to the Prismoidal Volumetrics dialog box.  

 

 

Average End Area  
The Average End Area volumetrics function is to calculate the volume along an 

alignment that has cross sections. It will display the following dialog:  

  



 

  
To calculate the total volume between two surfaces:  

Create the two TINS which represent the existing and proposed (or design) surface.  

1. Create the two TINS which represent the existing and proposed (or design) surface.  

2. Select the alignment.  

3. Select Existing Surface and pick the surface to use.  

4. Select the surface to use for the Design Surface.  

5. Click Calculate. The volume will be displayed.  

To calculate the volume between a surface and a reference elevation:  

1. Create the TIN which represents the proposed (or design) surface.  

2. Select the alignment.  

3. Select Datum Elevation and enter the elevation.  

4. Select the surface to use for the Design Surface.  

5. Click Calculate. The volume will be displayed.  

To get a printed report of the results:  

1. Click Report. The report will show the area at each station as well as the volume between 

each consecutive pair of stations and the running total of the volumes.  

2. Click Print.  

3. Click OK to return to the Prismoidal Volumetrics dialog box.  

  

View Menu  
See the section on Common View Functions on p.38 for information about Redraw 

Screen, Full View, Pan View, Zoom In, Zoom Out and Zoom Back.  



 

Visibility  
This function behaves just like Visibility in the other windows. You can alter the visibility 

of COGO and Layout objects, of Points, Contour Lines, Segments and Texts as well as 

showing hidden objects.  

  

Options  
Select Status  

Toggle the visibility of the select status bar which shows the mouse position and the 

select status for points, contour lines, texts, and segments.  

Tools  
Toggle the visibility of the tool bar to the left of the viewing area.  

Close  
Close the contour window.     



 

The Layout Window  

  

While COGO is used for editing map data, Layout is used for placing the map on the 

page and adding graphic items such as title blocks, certifications, north arrows and scenes 

from the L.A. riots (the latter is accomplished very simply - just cut out the picture of 

your choice from a copy of Newsweek or Time, apply a sparing amount of Elmer’s glue, 

and - voila!).  

Layout has several powerful features that allow the creation of finished plats in just 

minutes. To make the most of Layout, it is important to understand what components are 

and how they work. By using components, everything from a simple symbol to a 

complete page Form can be created and stored in a library for future use. For instance, a 

component might consist of a border, title block and various certifications that can be 

placed as a single entity on the page. Alternatively, title blocks, certifications, et. al. can 

be stored as individual pieces. Multiple libraries are supported as well.  

Another powerful feature of Layout is the ability to import and export DXF files. 

Drawings imported as DXF files will retain their hierarchy and layers. Blocks that exist 

in a DXF file will be imported as components that can be readily transferred to a library.  

The items in the layout window are similar to the COGO window items (see p.93). To 

open the layout window, select Layout from the View menu or press F3.  

Tool Bar  
The Layout Toolbar is a column of buttons that appears on the left side of the Layout 

window when enabled. It is simply a quick way to access commonly used functions that 

are also available through the menu bar.  



 

From top to bottom, the left side functions are – Open (Project), Save, Grid/Snapping, 

Linestyle, Color,  

Font, Profile, Table. From top to bottom, the right side functions are – Select (normal 

mode), Rotate, Circle, Circle (3 Point), Arc, Ellipse, Box, Polygon, Text, Block Text, 

Line, Rotate, Straight Dimension, and Curved Dimension.  

Use the Misc menu to toggle the Tool Bar on or off.  

Coordinate Display  
The Coordinate Display is in the lower left corner of the window and is part of the Select 

Status Bar. The left box of the display shows the x coordinate of the cursor and the right 

side shows the y coordinate of the cursor.  

Select Status Bar  
The Select Status Bar is a series of buttons and boxes containing numbers. This is just the 

same old thing that you’ve seen before in COGO and Survey - just the names have been 

changed to protect the innocent (at least that’s what I’m going to plead in court).  

So, let’s recap. The buttons actuate the selection filters (although none have been 

implemented yet). The numbers indicate the number of each type of data that are 

selected. Data refers to plot views on the page. Comp (components) refers to the tables, 

scale components, north arrows and groups of primitive graphics. Text refers to.. TEXT 

(wow). Grphic refers to the primitive graphic items -- lines, boxes, arcs, circles, ellipses, 

polygons, straight dimensions, and curved dimensions.  

Additionally, there is a "C" (for CLEAR) button on the far right which is a quick way to 

unselect all selected data.  

Use the Misc menu to toggle the Select Status Bar on or off.  

Data Types  
Data (Dataviews)  

This is the view of the COGO data that is placed on the layout page. A view can be all of 

the COGO data, a collection of selected items, a zoomed in view (screen view) or a view 

area (defined by the Set View COGO function in the View menu).  

Graphics  
Graphics are the primitive elements that are used to make more complex items. These 

primitive elements include lines, texts, boxes, arcs, circles, ellipses, polygons, straight 

dimensions, and curved dimensions. You must be over 18 to use the extra features of the 

adult version.  



 

Texts  
Texts can be just a few characters or very long strings (paragraphs) that are fitted into a 

rectangular area. Long texts wrap (i.e. begin a new line) at the end of each line. Texts can 

be fitted to a rectangular area. They can be resized, stretched, rotated, and of any kind of 

font that your printer/plotter will support (note: put another commercial for inkjets or 

thermals in here).  

Yes, fans, you can squeeze them, twirl them, create them and destroy them with utmost 

prejudice. Amaze your friends and family. Free with proof of purchase.  

Components  
Graphics that were created separately can be grouped into an item called a component. 

This component can then be moved about, placed, and resized as if it were a primitive 

graphic element. There are also special components that include Tables, Scale 

Components, and North Arrows that the program creates or manipulates automatically. 

Layout also supports groups - temporary collections of graphics and components that are 

manipulated as a single unit.  

Tables  
Tables (curve, line, and point) were defined in the COGO section. Layout just allows 

placing them on the page. To look at it another way, a table’s spiritual essence has its 

morphological origins within the swirling chaos of the COGO universe. Over time 

(hopefully not on a galactic scale), the table achieves visible incarnation in the physical 

realm of Layout through the god-like intercession of you, the user. Isn’t that simple?  

Scale Components  
A scale component is associated with a plot view and shows the scale of the view. 

Changes in the view’s scale result in the updating of its scale component (if it has one).  

 

Example of a Scale Component  

North Arrows  
Each north arrow is associated with a plot view and shows the direction of north in the 

plot. The arrow itself is defined by a component.  

Groups  
Several graphic items can be grouped together, without making them into a component, 

and then manipulated as if they are a single item.  



 

Data Selection  
Just as in the COGO window, many of the layout functions operate on a select list. 

Layout’s select list is separate from the select list for COGO and consists of the selected 

layout items. For more information on selecting and unselecting items and on select lists, 

refer to the Data Selection section of the COGO chapter.   

Some items, such as lines, will be highlighted by being drawn in magenta and other 

items, such as dataviews, will be highlighted with a magenta box around the entire item.  

All selected items will have little black boxes on the magenta lines. These black boxes are 

called nibs and are used for altering the item. Opening little black boxes can be very 

dangerous, so we have taken the precaution of disallowing that feature. When the cursor 

is over a nib, it will change to a cross. When you have this cross cursor, if you press the 

left button and drag, some aspect of the item will change. To move the item, press the left 

button when the cursor is on the object at some point other than a nib, hold the button 

down for half a second until the object(s) is replaced with a box outline, drag and then 

release the cursor.  

Forms  
Forms can be used to store commonly used sheet arrangements. A Form can store page 

size, orientation, and border settings. Components and graphics can also be stored with 

the exception of scale components and north arrows.  

Read/Write Form  
To create a Form,  

1) Set all the parameters to the desired values (page size, orientation, borders, margins, rows 

and columns).  

  
2) Place all the components and graphics that are to appear on the Form (title blocks, cut 

lines, certifications, etc.)  



 

3) Select Write Form from the Layout Project menu. A standard file dialog will appear, 

similar to the one shown above, to prompt for the Form name. Form file names have the 

default extension of .PTP (i.e. myform.ptp is a possible Form name). The Form file 

directory is designated in the OptionsDirectories settings (see p.58).  

4) Select OK to save the Form.  

Retrieving a Form is similar to opening a project.  

1) Select Read Form from the Project menu. A dialog similar to the one shown above will 

appear.  

2) Select the Form that is desired and select OK.  

Data functions  
Dataview Placement  

There are three ways to place the COGO data on the layout page: Full View, Screen 

View, and View Area, each in the Data menu. The term, dataview, will be applied to an 

instance of a data placement in layout.  

• Full View will place a view that will include ALL of the COGO data.  

• Screen View will place a view that includes what is currently displayed in the COGO 

window. If the COGO data window is showing a full view of the data, then Full View 

and Screen View will have the same effect.  

• View Area will place a selected view area on the layout page. The perspective will 

depend on the COGO scale set in the COGO - Options dialog box (see p. 100).  

To place one of these dataviews, select the appropriate option from the Data menu. If you 

are placing a view area, the function will first ask which view area to place. The cursor 

will become a box with an x. Place the cursor so that the upper left corner of the cursor is 

where the upper left corner of the plot will be and click the left button.  

A selected dataview has a magenta outline and four nibs that move each side of the 

outline. Changing the size of the outline changes the area of the COGO data that is 

visible on the layout page - it clips the view. It will not change the scale.  

To move a dataview, press the left button anywhere in the dataview, wait a half second 

until the dataview is erased leaving only the outline, move the cursor and outline to the 

new location and release the button.  

Use the Rotate function in the Edit menu or from the toolbar to rotate a dataview (see p.).  

Each dataview placed can have a unique scale setting and, therefore, a unique scale 

component (see p.208) and north arrow (see p.209).  

Dataview Accessories  
Scale Components  



 

Scale Components show what the 

scale of a plot is. To create a scale 

component,  

1) Select the view that the scale 

component will represent.  

2) Select Create Scale Component 

from the Data menu. A dialog 

similar to the one shown will 

appear. The dialog box will show 

the scale of the plot but will not 

allow it to be changed.  

3) Enter the number of Divisions per inch. Select Use Subdivisions if you wish to subdivide 

the first inch into smaller units. If so, Number of is the number of subintervals for the 

first division and Number of sub-intervals is the number of labels for the first division. 

Alternating Fill controls whether to fill alternating boxes in the scale component.  

4) Select OK and the cursor change to look like miniature scale.  

5) Place the upper left corner of the cursor where the upper left corner of the scale 

component is to be and click the left button. A 5" wide scale component will be created 

using the default font for the text.  

  

Notes:  

• If a scale component needs to be changed, select the scale component and then select Edit 

Scale Component in the Data menu. This will bring up the same dialog as that used by 

Create Scale  

Component and will fill the fields with the current values. Make the appropriate 

changes and click OK. •  Scale components can be resized after they have been created. 

A selected scale has a magenta outline and eight nibs for moving each side and each 

corner of the outline. Changing the height of the outline will change the height of the 

boxes in the component. Changing the width of the outline will increase or decrease the 

total number of divisions visible. There will always be at least one division and, if the 

component uses subdivisions, there will always be at least two divisions.  

• Use Set Font to change the font of the numbers at the bottom of the scale component.  

• To move a scale, press the left button anywhere in the scale, wait a half second until the 

scale is erased leaving only the outline, move the cursor and outline to the new location 

and release the button.  



 

Set Scale  
To change the scale of a plot, select the plot and then select 

Set Scale in the Data menu. The current scale value will be 

displayed. Change the old scale value to the desired value and 

select OK. The plot will be redrawn to reflect the new scale. 

Any scale component associated with the plot will also be 

redrawn to reflect the new scale. If the new scale  

value doesn’t match the scale value in COGO, a dialog will appear  

 asking if the COGO scale should be changed to match the new layout scale.  

Note: Changing the scale in layout has a different effect than changing the scale in 

COGO. Changing the layout scale results in the resizing of the entire view. Text that was 

drawn as 0.10 inches high in COGO will no longer be drawn 0.10 inches high in Layout 

UNLESS the COGO scale is reset to match the Layout scale. Changing the scale in 

Layout to a different value than that of COGO is similar to performing a zoom - 

EVERYTHING selected is either shrunk or enlarged.  

Place North Arrow  
To associate a north arrow with a plot, you first need to 

have a component of the north arrow. For more 

information on components, refer to the Components 

section of the Layout chapter.  

Select the plot to associate the north arrow with and 

select Place North Arrow in the Data menu. Select the 

component that you want from the list and click OK. 

Now, as you move the cursor, a magenta box will also 

move, representing the outline of the component that you 

want to place. To place the component, click the left 

button.  

  

When a north arrow is placed, it looks just like any other component as far as selection 

and movement is concerned. However, when a dataview is rotated, associated north 

arrows, if any, will rotate with the dataview so they will always point the direction of 

north for the plot.  

A north arrow is a special kind of component and, with the exception of rotation, is 

handled just like other components. To move or resize a north arrow, refer to the 

Component section.  



 

  



 

Draw functions  
Texts  
Text  

Layout text is very versatile - especially when utilizing TrueType fonts on a raster printer. 

To create text,  

1) Enter Text mode by either a) selecting Text from the Draw window, or b) clicking on the 

Text icon in the toolbar.  

2) Place the text cursor where you want to enter the text and left click.  

3) Type in the text that is desired. If multiline text is desired, use the ENTER key to separate 

lines.  

Existing text can be altered in many ways. To modify existing text, select the text that is 

to modified.  

• The text font can be changed by selecting a different font from the Set Font command in 

the Edit menu. This will affect ALL selected texts.  

• The bounding box for the text can be altered. When changing the bounding box, text will 

automatically wrap to fit inside the box. Changing the bounding box is accomplished by 

left-clicking and dragging any of the nibs.  

• Text can be stretched by holding down the SHIFT key and left-clicking and dragging any 

of the nibs to the desired size.  

• Text can be resized by either a) choosing a different font size or b) holding down the 

CONTROL key and (you guessed it..) left-clicking and dragging to the desired size. Of 

course, text can be moved and rotated like any other Layout object.  

• To move a text, press and hold the left button anywhere in the text, wait a half second 

until the text is erased and replaced with an outline, move the cursor and outline to the 

new location and release the button.  

• To rotate the text select the Rotate tool from the toolbar or from the Edit menu (see 

p.222). Left-click somewhere in the text and hold till the text outline replaces the text. 

Now, drag the mouse to rotate the text. The Angle Snapping function in the View menu 

can be used to help rotate the text to a specific angle.  



 

Edit Text  
To change a text, 

select the text to 

change and then 

select Edit Text in 

the Edit menu. A 

dialog will appear, 

displaying the 

selected text 

similar to example 

shown.  

The text can be 

edited by typing 

characters in with 

the keyboard, 

using the backspace key, etc.  

Text Justification can be Left, Center or Right.  

Text can be imported from a file by selecting File.  

Text files must be in a generic text format in order to be imported. Word processor 

formats, such as Word, WordPerfect, etc. cannot be imported. If using a word processor 

to create text, be sure to save the text in a generic text format (sometimes called MSDOS 

format).  

Block Text  
Block Text in the Draw menu places text within a bounding box, wrapping at the right 

side of the box if necessary.  

1) To define the text, just type it into the large edit box in the dialog box. To force a new 

line in the text, type an <ENTER>.  

2) To set the bounding box, press the left button in the layout data window at one of the 

corners of the desired bounding box. Bounding Box will show the cursor position. As the 

cursor moves, Bounding Box will be updated with the coordinates of the box. When the 

cursor is at the other corner of the bounding box, release the button.  

  
A selected block text has a magenta outline and eight nibs that move each side and each 

corner of the outline.  

• Changing the size of the outline will change the size of the bounding box.  

• Text will “wrap” to the next line to fit the bounding box or when there is a carriage return 

(created by pressing the <ENTER> key).  

• To move a block text, press the left button anywhere in the block text, wait a half second 

until the block text is erased leaving only the outline, move the cursor and outline to the 

new location and release the button.  



 

• If you have an ASCII file with the text in it, select File. The standard File Open dialog 

will appear, allowing you to select a file for importing text. The file will be read in and 

appended to the end of the text in the large edit box.  

Edit Block Text  
To change a block text, select the block text to change and then call Edit Block Text in 

the Edit menu. The current text will be shown in the large edit box and it can be changed 

in the same manner as it was created.  

Default Font  
Default Font in the Edit menu sets the font to be used when creating new texts, block 

texts, scale components, or tables. For more information on fonts, refer to Fonts in the 

Data Appearance section of the COGO reference manual.  

Set Font  
Set Font in the Edit menu changes the font for all selected texts, block texts, scale 

components, and tables. For more information on fonts, refer to Fonts in the Data 

Appearance section of the COGO reference manual.  

Bitmap  
To place bitmaps,  

1. Select Bitmap in the Draw menu.  

2. Select the bitmap from the standard file open dialog that is created. When this is done, the 

cursor will change to a C with a +.  

3. Place the cursor so that the upper left corner of the bitmap will be about where the + is 

and click. The bitmap will then be placed. Depending on the size of the bitmap, it may be 

necessary to zoom in to see the bitmap.  

Since bitmaps can vary in size anywhere from a few bytes to megabytes in size, PC 

Survey gives you the option of storing the bitmap as a part of the job or just storing a link 

to a source bitmap. To change from one to the other, do a Shift-right-click while the 

cursor is over the bitmap to get to the popup menu. (See Popup Menus on page 34). One 

of the options is Linked. If there is a checkmark, the job just stores a link to the original 

bitmap. If not, the entire bitmap is stored inside the .PCS file.  

⇒ Clicking on the Linked menu entry when it is checked will remove the link and will cause 

the bitmap to be stored with the job the next time it is written out.  

⇒ If you click on the Linked menu entry when it is not checked, a dialog box will appear for 

selecting the file name to use for the link.  

  ♦ If the file you specify does not exist, the current bitmap in the job will be written out 

to that file.  

♦ If the file already exists, the program will tell you the file already exists and ask if you want 

to replace the file.  



 

• If you answer yes, the version of the bitmap in the job will be written out to the file.  

• If you answer no, the file version will be read into the job.  

• If you cancel, the link will not be created.  

Cross-Section  

Profile  
• To place a profile view on the sheet:  

1) Select Profile from the Draw menu.  

2) A box will be displayed representing the size of the profile. Move this box to the desired 

position on the page and click with the left button to place it.  

  

• To change a part of the profile that is still not quite right:  

1) Place the profile on the page if that has not yet been done.  

2) Select the placed profile just as you would select anything other graphics object.  

3) Select Smash from the Component menu. This will replace the profile as a single entity 

with the individual lines and texts which comprise the profile. At this point, all of the data 

can be edited separately.  

Tables  

  

Example of a Point Table  
  
To place one of the tables defined in the COGO window, use Tables in the Draw menu.  

1) Select Curve, Line, or Point for the type of table to place. A magenta box will follow the 

cursor, showing the size of the table to be placed.  



 

2) When the box is in the right position, click the left button and the table will be placed 

there.  

When a table is selected, it will be outlined in magenta but will not have any nibs.  

•  Use Set Font to change the table font. •  To move a table, press the left 

button anywhere in the table, wait a half second until the table is erased leaving only the 

outline, move the cursor and outline to the new location and release the button.  

  

Example of a Curve Table with creative font selection  

Straight Dimension  

Curved Dimension  

Edit functions  
Groups  

Groups are used for operating on many graphics items simultaneously. Like components, 

groups are sets of graphics primitives that behave as if they were all one object. Unlike 

components, groups cannot be saved in a library.  

A selected group has a magenta outline but no nibs. To move a group, press the left 

button anywhere in the outline, wait a half second until the inside of the outline is erased 

leaving only the outline, move the cursor and outline to the new location and release the 

button.  

Group  
Group in the Edit menu puts all of the currently selected layout items in a single group to 

be used by the group functions. This function only handles one group at a time. The items 

that go into the group will be unselected.  

Ungroup  
Ungroup in the Edit menu will remove all items from the selected group.     



 

Components  
Sometimes you will create a picture using several things, such as lines and texts for a title 

block, and then handle the picture as a single unit. Sometimes making a group will be 

sufficient but when you want to save the work for use in another project, a better method 

is to use components. Like groups, components are a collection of more primitive items 

that are manipulated as a group. Unlike groups, however, components can have multiple 

copies placed on a page and even be used in more than one job.  

When a component is selected, it will be drawn in magenta and will have eight nibs 

which will move each side and each corner. Moving a nib will change the dimensions of 

the current component but not the dimensions of the original. If you place another 

component, it will still have the same size that it was originally created with. To move a 

placed component, press the left button anywhere in it, wait a half second until it is 

erased and replaced with an outline, move the cursor and outline to the new location and 

release the button.  

Create  
To create a component, use Create in the Component 

menu. Before calling the function, select just those 

graphics that are to be a part of the component. Create 

will ask for a name for the component that can be used 

later to refer to it. The selected graphics that are a part 

of the component will be unselected after the 

component is created.  

Delete  
To delete a component, use Delete in the Components 

menu. It will provide a list of all components associated 

with this job. Select the component to delete from the list 

and click OK. The component will be removed from the 

list of components associated with the job and all 

instances of that component on the layout page will be 

deleted.  

Place  
To place a component on the page, use Place in the 

Components menu. It will provide a list of all 

components associated with this job. A file name in parentheses following the name of a 

component refers to the component library from which the component was read. Select 

the component to place and click  

  

OK. An outline of the component will be drawn in magenta.  



 

Move the cursor and outline to the location to place the component and click the left 

button.  

Smash  
To replace a component with the elements of which it was made, use Smash in the 

Components menu. It will provide a list of all components associated with this job. Select 

the component to smash and click OK. The component will be removed from the list of 

components associated with the job and all instances of that component on the layout will 

be replaced with their constituent elements.  

Update  
If the components in a library have changed and you want all instances of those 

components in this job to reflect the changes, use Updates in the Components menu. The 

dialog box will define the library from which to read the components. Refer to Open in 

the File Functions section of the COGO reference manual for a detailed explanation of 

the fields in this dialog box. After selecting the library and clicking OK, all components 

that are in this job and are also in the library will be updated.  

Get  
To add a component from a library to the list of components associated with this job, use 

Get in the Components menu. The first dialog box will define the library from which to 

read the component. Refer to Open in the File Functions section of the COGO reference 

manual for a detailed explanation of the fields in this dialog box. After selecting the 

library and clicking OK, a list of all components in that library will be displayed. Select 

the component to add to this job and click OK. If a component of that name is already in 

the job, it will be replaced by the new component.  

Put  
To take a component from this job and add it to a library, use Put in the Components 

menu. The first dialog box will define the library in which to write the component. Refer 

to Saving a Project on p.50 for a detailed explanation of the fields in this dialog box. 

After entering the library name and clicking OK, a list of all components associated with 

this job will be displayed. Select the component to add to the library and click OK. If a 

component of that name is already in the library, it will be replaced by the new 

component.  

View Functions  
See the section on Common View Functions on p.38 for information about Redraw 

Screen, Full View, Pan View, Zoom In, Zoom Out and Zoom Back.  



 

COGO View  
Executing the COGO View command is like stepping into a view that has been placed on 

the sheet. We say that you are now “in the COGO View” as opposed to the “Layout 

View”. The COGO View command is a toggle. Selecting the COGO View command a 

second time will return from the COGO View to the Layout page.  

 This is primarily useful when it is desired to add layout objects (components, graphics, 

etc.) that will maintain their position and orientation relative to the COGO data. For 

instance, if a circle is placed while in the COGO View, movement, rotation and/or 

scaling of the dataview will result in the circle being moved, rotated and/or scaled as 

well.  

Any layout objects placed while in this mode are in COGO coordinates and will be 

visible in the COGO data window but cannot be edited from that window. To return to a 

view of the page, select COGO View in the View menu again. Any objects placed will be 

visible in the in the layout sheet views but can only be edited by returning to the COGO 

View.  

• Text placed from Layout in the COGO View is essentially the same as text that is created 

while in COGO with the COGO text tool.  

• Placing a north arrow in the COGO view will insure proper directional orientation of the 

arrow since it will rotate when the view is rotated. Unlike the Layout Place North Arrow 

function, however, the COGO View’s north arrow will rotate about the view’s center 

rather than about the center of the North Arrow component.  

Display Functions  

Set Background Color  
This function in the View menu brings up a dialog box that 

allows choosing the color that to be used for the 

background. This is mainly useful if the white background 

is too much of a strain on the eyes. Just select the color 

that you want by clicking on it in the color list and then 

click OK.  

  

  



 

Set Fill  

  

• This function is used to set the fill type of a boundary or a layout object. To use this 

function:  

1) Select all of the objects to be filled with the same fill type. If in Cogo, select all 

boundaries to be filled. If in Layout, select all of the graphics to be filled (arcs, boxes, 

circles, ellipses, polygons).  

2) Select Set Fill from the Edit menu, or fill boundary in the Aln/Bnd menu if in Cogo. A 

dialog box similar to the one shown above will appear.  

  

• To use a fill type that does not yet exist:  

1) Click on the New button.  

2) Define the characteristics of the fill following the steps in the following Modify Fill 

section.  

3) Make sure that the highlighted button is the desired fill type.  

4) Click on the OK button to leave this dialog.  

  

• To use a fill type that already exists:  

1) Click on the button with the picture of the desired fill.  

2) Click on the OK button to leave this dialog.  

  

• To use the current fill type but change it:  

1) Make sure that the highlighted button is the desired fill type.  

2) Click on the Edit button.  



 

3) Define the characteristics of the fill following the steps in the following Modify Fill 

section.  

4) Click on the OK button to leave this dialog.  

  

• To use a fill type that already exists but change some of the characteristics:  

1) Click on the button with the picture of the desired fill.  

2) Click on the Edit button.  

3) Define the characteristics of the fill following the steps in the following Modify Fill 

section.  

4) Click on the OK button to leave this dialog.  

  

• To delete a defined fill type:  

1) Click on the button with the picture of the fill to be deleted.  

2) Click on the Delete button.  

3) Make sure that the highlighted button is the desired fill for the selected objects.  

4) Click on the OK button to leave this dialog.  

  

• To unfill the selected objects:  

1) Click on the None button  

2) Click on the OK button to leave this dialog.  

Notes:  

• The Arc Fills information will only be displayed if at least one arc is selected.  

• To fill to the center of the circle represented by the arc, select To Center (Pie Slice). The 

result will look like a pie slice.  

• To fill just to the chord of the arc, select To Chord.  

  

Edit Fill  

  

• To create a solid fill  

1) Click on the Windows checkbox.  



 

2) Click on the solid black bar at the top of the Hatch selection box.  

3) To set the color, click on the Color button to bring up the dialog which allows selecting a 

color.  

4) Click OK.  

  

• To create a hatch fill using the Windows hatch types:  

1) Click on the Windows checkbox.  

2) Click on the type of hatch desired from the options displayed in the Hatch selection box.  

3) To set the color, click on the Color button to bring up the dialog which allows selecting a 

color.  

4) Click OK.  

  

• To create a WYSIWYG (What You See Is What You Get) fill with a repeated line 

pattern:  

1) Click on the Line checkbox.  

2) Enter the angle as an azimuth for the lines.  

3) Enter the spacing between lines in inches.  

4) To set the linetype to use for the lines, click on the Linetype button and select the desired 

linetype.  

5) Click OK.  

  

• To create a WYSIWYG fill with hatched lines:  

1) Click on the Line checkbox.  

2) Enter the angle as an azimuth for the first line.  

3) Enter the spacing between first lines in inches.  



 

4) To set the linetype to use for the first line, click on the Linetype button and select the 

desired linetype.  

5) Click on the Second Line checkbox.  

6) Enter the angle for the second set of lines.  

7) Enter the spacing between the second set of lines in inches.  

8) Set the linetype for the second set of lines by clicking on the Linetype button.  

9) Click OK.  

Notes:  

• For WYSIWYG line fills, the scale will determine how many lines per feet will be used 

to fill a boundary. Like text, if the scale changes, the spacing of the plotted lines will not 

change although the apparent spacing relative to COGO coordinates will change.  

Miscellaneous  
  

  Select Status   Tools Ruler  
    Toggles select status bar display.  

    Toggles tool bar display.    Toggles Ruler display.  

Close  
Close in the main layout menu will close the layout window.  

Delete  
Delete in the Edit menu will delete all selected layout objects. This function is also 

mapped to the <DEL> key on the keyboard. Therefore, to delete something(s) (view, 

graphic, component, etc.),  

1) Select the items and select Delete or press 

the <DEL> key.  

2) A dialog similar to the one shown will 

appear, showing the number of objects that 

have been selected. Select Yes to delete the 

selected objects or No to cancel the 

function.  

Oftentimes, deleting objects will leave the 

screen display a little muddled. This is a normal result of erasing things on the screen. 

Selecting Redraw  

Screen from the View menu will clear things up.  



 

Extract Objects to Layer  
Extract Objects to Layer in the Edit menu moves selected layout items to another layer. 

It asks for the destination layer and moves all selected objects to the specified layer. To 

use this function, 1) Select the objects that you wish to 

move to a different layer.  

2) Select Extract Objects to Layer. A dialog similar to the 

one shown will be displayed.  

3) Select the destination layer for the selected objects from 

the list by left-clicking on the name of the destination 

layer. The selection will then be highlighted.  

4) Select OK to complete the operation or Cancel to cancel 

the operation.  

Layers are defined through the Edit Layers function in the Environment menu of the 

main window (see p.54).  

Grid/Snapping  
See p.33 for a description of these functions.  

Page Layout  

  
To control the display of the data on a printout, use Page Layout in the Project menu. 

The dialog box allows selecting a standard Paper Size or specifically setting the page 

Width and Height. The Margins can also be  

set to be a specific distance in from the sides of the page. The Orientation can be Portrait 

(tall) or Landscape (wide). Use Print Settings will use the settings that the current printer 

is already using.  



 

The entries in the Pages section can be used for more than one output page, such as if the 

drawing spans several pages or if you want to have a full view of the plot on one page 

and a zoomed in view of part of the plot on another page.  

Used Area shows the number of inches or centimeters available for printing in based on 

the paper size and margins.  

Print  
Print in the Project menu will 

print either  

All the layout pages or the 

specified Pages (if there are more 

than one) to the default printer. To 

change the default printer, you 

will need to go to the Windows 

control panel and select the 

printer icon.  

Rotate  
This function rotate layout objects. Rotate is a mode - this means you can continue to 

rotate objects until the Rotate mode is exited by either pressing the <Esc> key or by 

clicking on another toolbar button at the top right of the toolbar. The cursor associated 

with Rotate looks like an arc with a cross in the center. To use this function:  

1) Depress the left button over a selected item and wait a half second until the object flashes 

or is replaced with an outline.  

2) Move the cursor - the object will rotate about its origin or center.  

The angles through which the object can rotate are controlled by the Set Angle Snapping 

function (see p.33). When the object has the desired angle, release the button. The 

program will stay in rotate mode until you press <Esc> or execute another command.  

• While in the Rotate mode, objects can still be selected/unselected using the left mouse 

button in the normal fashion.     



 

The Component 

Window  
The Component Window is used for visually accessing the component libraries. 

Components in a given library will be drawn on top of a sheet outline (the component 

sheet) similar to what is seen in the Layout Window. A status bar, located below the 

window’s menu displays the name and dimensions of the currently selected component 

(or current component). The current component will be surrounded by a magenta outline 

box.  

Components can be organized (moved around) on the component sheet. Components can 

also be deleted and renamed.  

There are many different ways to organize component information. Some suggestions 

are:  

1) Store related components in the same library. For instance, one library might have 

nothing but certifications. Another library may contain sheet Forms (a component with a 

border, title block and any other commonly used components that fits a given sheet size 

2) Store components that are used on a given sheet size together.  

3) Store components according to job type usage (i.e. property survey vs. subdivision 

development components).  

Moving Components  
To move a component-  

1) Place the cursor somewhere in the component, press the left button, wait a half second for 

the component to be replaced with an outline and a cross at the origin. Keep the mouse 

button depressed. At this point the chosen component can be moved to another location 

on the component sheet or dragged and dropped onto the layout sheet (IF the layout 

window is open).  

2) Move the component to the new location and release the button. The component can be 

moved somewhere else on the component sheet or onto the layout page. If it is moved to 

the layout page, a copy will remain on the component sheet.  

Dropping a component from the component sheet onto the layout page is the equivalent 

of using Get and the Place commands in the Components menu except that you don't 

need to know that the name of the component beforehand.  

When the component is dragged onto the layout sheet, the outline box will generally 

change dimensions due to the difference between the displayed component sheet scale vs. 

the layout sheet scale.  



 

Library Functions  
New  

If a library is already open, New will first close out the library. The current library will 

then be empty and unnamed. For more detail on closing a library, refer to the Close 

function in this section of this manual.  

Open  
Open will open a library that has already been created. If a library is already open, Open 

will first close out that library. Refer to p.50 for a detailed explanation of the fields in this 

dialog box. For more detail on closing a library, refer to the Close function in this section 

of this manual.  

Save  
If the current library has a name, Save will save the library with that name. If the current 

library has no name, Save behaves just like Save As, using the same dialog box in the 

same manner.  

Save As  
Save As saves a library that either has no name yet or that needs to be renamed. Refer to 

p.50 for a detailed explanation of the fields in this dialog box.  

Delete Component  
Delete Component removes the current component.  

View  
See the section on Common View Functions on p.38 for information about Redraw 

Screen, Full View, Pan View, Zoom In, Zoom Out and Zoom Back.  

Close  
Close will close the current library and the window. If the library has been 

changed since the last time that it was written out, Close will first ask whether or not to 

save the changes.  



 

Appendix A - 

descodes.dat  
The DESCODES.DAT file is a simple text file located in the program’s directory. An 

example of what this file might look like is shown below:  

CB  

CL  

EPL  

EPR  

IP  

SB  

TREE  

  

The file can be viewed or edited with any text editor. The Notepad program supplied with 

Windows is an example of a simple text editor.  

  

It is recommended that descriptions be entered from within the program since entering 

descriptions in the program should be as fast and is safer than using a text editor. If 

descriptions are entered directly into the DESCODES.DAT file with a text editor, use the 

following guidelines:  

  

• Enter each description on a separate line.  

• Don’t leave any blank lines, except the one at the beginning of the file.  

• Don’t insert any non-printing characters such as tabs and spaces.  

• Avoid entering the same description more than once.  

• Descriptions are case-sensitive in the program - ABC is considered to be different from 

ABc.  

  

The program will automatically alphabetically sort the file when it uses it, so don’t worry 

about the alphabetical order of the descriptions.  

  

 Appendix B - Line 

Styles  
  

Line styles are defined in the pcs.ini file. Multiple sets of line styles can be defined. The 

LineStyleSet keyword in the [PCS] section specifies the name of the set of line styles 

currently being used. So, if the [PCS] section includes the line  



 

      LineStyleSet=SurveyStyles then SurveyStyles is the set of line 

styles being used.  

When reading a job in, the line style definitions in the default line style set in the pcs.ini 

will be added to the job. Any line style already in the job that has the same name as a line 

style in the pcs.ini will be replaced with the definition in the pcs.ini file.  

Each section labeled [LineStyleSet,<name>] defines the line styles that are part of the 

<name> set. Each line of this section consists of a keyword which is the name of the line 

style, an '=', the length of the pattern (in inches), whether or not the pattern is scalable, 

and finally the graphic elements which comprise the line. If the length is 0, then only one 

iteration of the pattern is used for each line. Otherwise, the pattern will keep repeating 

from the beginning until the ending of the line. If the style is scalable, then the elements 

of the line will be shrunk or expanded to provide an integral number of repetitions of the 

pattern for the length of the line.  

The different line elements with their parameters are listed below. The <common> 

parameters are an x offset, a y offset, and whether this element is scalable (which only 

applies if the whole line style is also scalable.) The x and y offset are the starting point 

for the element relative to the start of the line segment.  

All sizes are specified in inches, except for line widths where 1 is a regular line, 2 is a 

heavier line, etc.  

• Win(line_type, line_width, <common>) This uses one of the default windows line styles. 

 line_width  line width.   line_type  line style.  

0 solid line  

1 dashed line  

2 dotted line  

3 dash-dot line  

4 dash-dot-dot line  

• Line(width, <common>)  

This is just a solid line. It is no different from a Win line of type 0.  width line width  

• Dash(width, length, <common>) Draw a line segment.  

    width line width  

    length length of the line segment  

• Slash(width, length, angle, <common>) Draw a dash at an angle.  

  width line width  length line segment length  angle  angle relative to 

the line at which to draw the slash.  

• Square(size, angle, width, <common>) Draw a square.  

    size  width of the square  

  angle  angle relative to the line o draw the square  width line width  

• Rect(angle, length, height, width, <common>) Draw a rectangle  angle  angle 

relative to the line at which to draw the rectangle  

  length length of the rectangle  height height of the rectangle  width 

line width.  

• Circle(size, width, <common>) Draw a circle    size  radius of the 

circle.  

• Dot(size, <common>)  



 

Draw a filled in circle  

    size  radius of the circle  

• Arc(radius, start, end, width, <common>) Draw an circular arc.  

    radius radius of the circle  

 start starting angle end  

ending angle width line width  

• Ellipse(angle, major, minor, width, <common>) Draw an ellipse  

   angle  relative to the line at which to draw the  

ellipse major major axis length minor minor axis length width line width  

• Char(c, size, angle, <common>) Display a text character as part of the line.   

 c  character  

  size  height of the character  angle  angle relative to the line to draw 

the character.  

Some default line styles that are installed with the program are: 

[LineStyleSet,SurveyStyles]  

• WinSolid1=0,1,Win(0,1,0,0,1) Draw a regular width, solid line.  

• Solid2=0,1,Line(2,0,0,1) Draw a heavy solid line.  

• DashDot=0.2,1,Dash(1,0.05,0,0,1),Dot(0.025,0.1,0, 

1),Dash(1,0.05,0.15,0,1)  

Draw a dash starting at the beginning of the pattern and extending 0.05 inches, followed 

by a dot with a radius of 0.025 inches centered on the line 0.1” from the start of the line, 

and ending with another dash beginning  

0.15” from the start of the line and extending for another 0.05”. All elements are scalable 

and have a line width of 1. The pattern is 0.2” long so the first dash for the next pattern 

will start right where the dash for the first pattern ended.  

• Fence=0.5,1,Dash(1,0.15,0,0,1),Char(*,0.4,0° 00' 00",0.17,-

0.15,1),Dash(1,0.15,0.35,0,1)  

Draw a fence line which will consist of a line segment starting at the beginning of the line 

and extending 0.15”  

in the direction of the line. Follow this with a ‘*’ character drawn at the same angle as the 

line and with a height of  

0.4” with the left edge of the character placed 0.17” from the start of the line and with the 

baseline of the character 0.15” below the line. End this pattern with another line segment 

starting 0.35” from the start of the line and continuing for 0.15” which ends the segment 

at 0.5” which is the length of the pattern.  

• Fence Post=0.5,1,Line(1,0,0.025,1),Line(1,0,- 

0.025,1),Circle(0.05,1,0.25,-0.1,1)  

Draw a fence post line which consists of two solid parallel lines, one 0.025” above the 

center and the other 0.025” below the center. Place circles of size 0.05”, centering the 

first one 0.025” from the start and 0.1” below the center and placing subsequent circles 

every 0.5”.  

• Power  

Line=0.5,1,Dash(1,0.2,0,0,1),Circle(0.05,1,0.25,0,1 

),Dash(1,0.2,0.3,0,1)  



 

Draw a power line which will consist of a dash starting at the beginning of the line and 

0.2” long. Follow this with a circle of radius 0.05”, centered 0.25” from the start, and end 

with another dash, also 0.2” long, starting 0.3” from the start of the line.  

• Railroad Track=0.2,1,Line(1,0,0,1),Slash(1,0.2,90° 00' 00",0.1,0,1)  

Draw a railroad track consisting of a solid line punctuated by slashes at 90° to the line 

that are 0.2” tall, starting  

0.1” from the start of the line and every 0.2” thereafter.  

• Stone Fence=0.5,1,Dash(1,0.2,0,0,1),Square(0.1,0° 00' 00",1,0.2,0,1),Dash(1,0.2,0.3,0,1)  

Draw a stone fence which consists of a dash of length 0.2” starting at the start of the 

pattern. Follow this with a square starting 0.2” from the start of the pattern, parallel to the 

line, with sides of length 0.1”. Finish with another dash 0.2” long starting 0.3” from the 

beginning.  

  
• Block Wall=0.2,1,Rect(0° 00' 00",0.2,0.1,1,0,0,1)  

Draw a block wall consisting of rectangles parallel to the line. The rectangle dimensions 

are 0.2”x0.1”, starting at the beginning of the line and placed every 0.2”.  

Appendix C - GPS  

Overview  
GPS (Global Positioning System) is a measurement technology that allows a highly 

accurate determination of location through the use of radio signals received from orbital 

satellites. GPS surveying has the advantage of being able to establish positions without 

the need for a series of distance and angle measurements from a known point. GPS has 

the disadvantage of being adversely affected by physical obstructions such as trees and 

buildings. This section will attempt to explain the general concepts behind the use of 

GPS, as well as when and how to use it.  

General Concepts  
Basic Theory  

The US and Russian governments have both set up a number of satellites (or 

constellation) for the explicit purpose of aiding in navigation. The US constellation is 

called NAVSTAR and the Russian constellation is called GLONASS. The satellites 

constantly transmit information that includes their orbital data (ephemeris) along with 

signals that are used by GPS receivers to calculate their distance from each satellite.  

From the exact position of each satellite and the distance from it, a calculation of the 

receiver’s position can be determined by trilateration - such is the basic concept. If one 

had a precise knowledge of the time of transmission and reception of the satellite data, 

the observation of only three satellites would be necessary for the calculation. However, 



 

this information is not available due to various reasons, so an additional satellite is 

necessary, bringing the minimum number of observable satellites to four.  

Additionally, the presence of various errors (including the deliberate introduction of error 

by the government for military reasons) requires that at least two receivers be used to 

simultaneously observe the same set of satellites.  

The satellite data includes information that gives the receiver an immediate rough 

distance measurement. A more precise distance is necessary for surveying purposes. To 

obtain this distance, however, a number of observations (called epochs) must be made on 

each satellite over a period of time.  

IMPORTANT! Satellite reception is primarily LINE OF SIGHT. Like 

the laser beam in an EDM, there generally must be an unobstructed 

line of sight between the receiver’s antenna and the satellite for 

successful reception.  

  

GPS vs. DGPS  
For survey-grade accuracy (1 cm or less), two receivers must be used in order to correct 

for certain errors. An alternative approach, if something less than this order of accuracy is 

needed, is to use a single receiver in conjunction with a second set of data from a source 

that, in effect, substitutes for the second receiver. This approach is called Differential 

GPS or DGPS, for short. The three common sources for the second data source are the 

publicly available government transmitters operated by the US Coast Guard, government 

data downloaded from the Internet after returning to the office, and commercially 

available sources that transmit the information via satellite. When using the government 

transmitters or the commercial satellite sources, the receiver position is calculated in real-

time so that there is no need for further adjustment in the office.  

  

The advantage of DGPS is that only one receiver is necessary. The disadvantage is that 

positions are not accurate enough for most surveying requirements. Using the 

government transmitters will typically yield an accuracy of no better than about a meter. 

Satellite DGPS receiver accuracy can be on the order of a few decimeters. Such 

accuracies might be suitable for applications that require only a crude position, however. 

These include some GIS/LIS projects, percolation test locations, etc.  

  

Another use for DGPS is navigation. The GMS 2x00, with the optional DGPS receiver, 

allows the user to input a desired coordinate and then uses a compass display (along with 

distance to target, cross-track, ground speed, etc.) to guide the user to that location. When 

trying to locate geodetic monuments, for instance, getting within a meter of the 

monument is good enough to find the marker.  

  

General Technique  
Survey-grade GPS requires the use of at least two receivers. One receiver serves as the 

reference receiver which we will call the base station. We will call the other receiver(s) 

rover(s).  

  



 

Selecting a site  
Perhaps the most critical problem in using GPS is in choosing a site for the base 

station that is as clearly unobstructed above a 15 degree vertical angle as possible. 

(Fifteen degrees is the typical mask angle used in GPS surveying. Below this angle the 

satellite transmission has to go through too much atmosphere, with its attendant 

interference and signal delay, to be very useful.) Any obstructions above this angle 

(telephone wires, tree limbs, dirigibles, mutant flying elephants, etc.) can potentially 

interfere with a satellite’s transmission and therefore prevent the software from 

determining the receiver’s position. If the base station location is completely clear 

(“good”), the rover location isn’t as critical. A given position might be partially 

obstructed but, since the satellites are in constant motion, satellite positions will usually, 

given enough time, be reached that give the rover enough data to allow processing. A 

satellite map, such as the one included with the GMS system, can be very helpful in cases 

where there is an obstruction. By examination of the map, one can quickly determine 

where the satellites are currently located. Regardless, it is best to try to pick rover sites 

that are as clear from obstruction as possible.  

  

Setting up the equipment  
Every GPS receiver has an antenna and it is to the phase center of the antenna that a GPS 

measurement is made. The phase center is roughly (within a few millimeters) located at 

the physical center of the antenna and will be centered over the antenna pole. Therefore, 

when making measurements, it is important to know exactly where your antenna is 

relative to the ground. The GMS system uses a fixed height antenna pole in order to try to 

avoid possible confusion in this regard. Additionally, the pole must obviously be kept 

perpendicular to the ground in order to get the correct horizontal position, so a level is 

typically included with the pole.  

  
The GMS receivers can mount to the antenna pole using the included bracket or be placed 

on the ground and connected to the receiver with the longer of the two cables that are 

provided. A common approach is to place the base station receiver in its bag on the 

ground along with an additional battery attached to the auxiliary power connector. The 

rover receivers, on the other hand, are commonly mounted to the pole for easier access to 

the data collector.  

  

Acquiring data  
The base station is generally set up and started first. The rovers are then placed at the 

desired acquisition points. The amount of time spent collecting data is called the sit time. 

Minimum effective sit times are primarily dependent upon the baseline distance (the 

distance between the base station and the rover), the quality of the site with respect to 

satellite visibility, the number of satellites in view above the mask angle and the satellite 

“geometry” (the relative location of the satellites to each other). Shorter baselines, more 

satellites, better visibility and geometry allow for shorter sit times. Sit times for a single 

frequency system are typically about 10 minutes plus one minute per kilometer of 

baseline distance when observing at least 5 satellites.  



 

Limitation

s  
Canopy  
The primary limitation in using GPS equipment is canopy. Canopy refers to overhead 

obstructions and, in particular, trees. Kinematic acquisition is not feasible in the woods or 

in other locations that have frequent overhead obstructions. Static acquisition might 

work, but will probably require long sit times. In areas of frequent overhead foliage, high 

buildings or other such obstructions, it is probably best to set a GPS point in a peripheral 

location that is relatively unobstructed and then use a total station to acquire points in 

obstructed areas, tying into the GPS points.  

  

Multipath  
Multipath refers to signals that reach the antenna after bouncing off of other objects such 

as buildings and vehicles. This is especially a problem in urban environments. The 

problem with multipath is that everything will appear to be working just fine. Real-time 

displays will show coordinates, the number of satellites being tracked will look 

wonderful, etc. However, processing will fail to find an acceptable coordinate. While 

some multipath is acceptable (modern receivers will discard some of it), too much will 

result in a waste of a day - so avoid getting close to metallic objects that are above the 

height of the antenna.  

  

Time  
GPS acquisition can be slow, depending upon conditions and requirements. Static 

processing with good data will get you under 1 cm, but will take anywhere from several 

minutes to an hour or more. Kinematic acquisition may take only a few seconds, but is 

guaranteed to give only about 2-4 cm of accuracy and will often fail completely in areas 

with canopy.  

  

Accuracy  
As commonly used, GPS, in an absolute sense, is not very accurate. A typical static 

accuracy of 1 cm doesn’t compare favorably with what a total station can do for short 

distances. GPS can yield millimeter accuracies, but requires expensive equipment and 

extensive time to do so.  

  

The advantage of GPS is in its relative accuracy over long distances. A single frequency 

system can reliably determine a location within 1 cm at distances of several miles. 

Additionally GPS doesn’t require line-of-sight between the base station and rover, so 

getting locations in areas of rough terrain become much quicker (assuming that you’re 

not in a rain forest).   

Single Frequency vs. Dual Frequency  
Navigation satellites broadcast two signals at two different frequencies, referred to as the 

L1 and L2 frequencies. L1 was designed for civilian use whereas L2 was designed as a 



 

military frequency and is consequently encrypted. Final calculation of position is done 

with the L1 frequency only. One advantage of using L2 is in being able to get closer to 

the final solution more quickly. The second major advantage is in being able to eliminate 

the errors that arise due to the passage of the signal through the earth’s ionosphere. This 

is only a problem for long baselines (in excess of 10 miles).  

  

The disadvantage of dual frequency systems is that they are expensive. One must ask the 

question of whether to spend an additional thirty or more thousand dollars in order to get 

slightly shorter sit times (perhaps 6 - 10 minutes vs. 10 - 20 minutes). For most 

applications, dual frequency, at the time of this writing, can’t be financially justified. This 

will change as the cost of dual frequency receiver boards comes down.  

  

Static vs. Kinematic  
Static GPS refers to processing each baseline independently, requiring sit 

times of several minutes. Static GPS is the most accurate. Kinematic GPS 

allows the receiver to move either continuously or to sit for just a few 

seconds at each point. Positions are calculated by knowing the previous 

position and that the previous position was a very short distance from the 

current position. The software can then search for a solution in a much 

more limited area and requires less data to find it. Kinematic is not as 

accurate as static but is a good approach when acquiring points for digital 

terrain modeling where centimeter accuracy is not required, but accuracy 

within a few centimeters is acceptable.  
  

Real-time vs. Post-processing  
Real-time GPS generates positions immediately and is used in conjunction with 

kinematic processing (thus, RTK or Real Time Kinematic). This requires processing 

software to be located in the receiver system. In a survey-grade system that requires two 

receivers, a radio link between the receivers is also necessary in order to do the 

calculations since the software must have the data from both receivers. This introduces 

another problem - the reliability of the radio link. In the eastern half of the US, where 

ground obstructions are many, varied and weird, RTK hasn’t worked very well. RTK has 

performed much better in areas such as Arizona and Kansas.  

  

Post-processing refers to acquiring the data and then processing it at a later time.  

  

Since real-time GPS is significantly more expensive than post-processing, one must ask 

what advantages there are to having the geodetic coordinates of a point at the time of 

acquisition. Though this might be really nice for stake-out, GPS doesn’t have the 

accuracy necessary for building construction stake-out. Also, a robotic total station is 

probably just as fast and cheaper than an RTK GPS system, as well as being generally 

more reliable.  

  



 

Relative Positions vs. Referencing to State Plane  
GPS processing accurately computes the position of one receiver relative to another when 

both receivers have observed the same satellites over the same period of time. GPS 

processing doesn’t accurately determine the true or geodetic position of a receiver by 

itself. When processing, at least one point is designated the control point. All other 

positions are derived from the control point. If the control point’s position is not precisely 

known, so also the other GPS point positions will not be precisely known except with 

respect to each other. This is perfectly acceptable when the project doesn’t require state 

plane coordinates.  

  

State plane coordinates are derived from geodetic coordinates. If an accurate state plane 

coordinate is desired, one of the GPS receiver positions must be on a known state plane 

location. This point becomes the control point and all other points are referenced to it.  

Practical GPS  
Applications  

• Remote Site Location  

Location of oil wells, cellular telephone towers, percolation test points are all examples 

where GPS might be applicable.  

  

• Traverse Control  

Typical surveying practice requires establishing a control loop. In large projects or areas with 

difficult terrain, this can be a very time-consuming task. By removing the need to shoot a 

closed loop or even remove the need to shoot any traverse at all, the surveyor can 

potentially save vast amounts of time. (An alternative is simply to shoot the customer. 

This eliminates the problem completely.)  

  

GPS allows the surveyor to establish known control points at two ends of a project and shoot 

an open traverse between them that is position adjustable if a single GPS point is 

available at both ends and optionally angle adjustable if two GPS points are established at 

both ends.  

  

In difficult terrain conditions, a one or more GPS points can be established in areas that are 

hard to traverse to and a separate set of points can be measured with the total station and 

tied into the GPS locations.  

  

• Aerial Control  

Flight control for aerial mapping is another prime example where GPS excels since 

mapping control points are generally widely spaced.  

  

• Fence Line Demarcation / Mapping  

If one has a DGPS receiver, positions are accurate in real-time to about 1 meter (3 feet). 

Such accuracy is adequate for marking fence lines and, oftentimes, general mapping of 

features such as road centerlines, power poles, fire hydrants, etc. The advantage of DGPS 

is that it works quite well in canopied areas since a continuous lock is not necessary – any 

satellite lock will suffice since positions are real-time.  

  



 

Selecting Receiver Locations  
Though discussed earlier, it is worthwhile to review this issue.  

• If possible, select a base station site that is completely clear of obstructions above a 

vertical angle of fifteen degrees. A general rule for determining what a fifteen degree 

vertical angle is, is to stretch one arm straight out horizontally and make a fist. Make a 

fist with your other hand and place it on top of the first fist. Do this one more time. Each 

fist represents approximately five degrees. Sighting along the top of the third fist 

therefore is about a fifteen degree angle. (After figuring this out, please don’t contact the 

author and let him know where you would like him to put his fist.)  

• Try to select rover locations that are also free of obstruction. If unable to do so, use the 

satellite map view of the data collector to determine whether there are at least four or five 

satellites completely clear of the obstructions. If not, you may wish to select a different 

site or acquire a different point and return later. If the obstructions are intermittent, such 

as the branches of a tree, you can acquire the point with a lengthier sit time.  

  

General Techniques  
There are several ways in which to use the receivers.  

  

Radial  
In a radial approach, the base station remains fixed for the duration of the project. If using 

this approach, try to find a central location for the base station. If acquiring points in a 

difficult location (partially obscured, traffic congestion, a Democratic convention, etc.) it 

may be desirable to choose a location closer to those points in order to decrease the sit 

time and/or probability of successful processing.  

  

Multiple Rovers  
If using more than two receivers, a couple of possibilities exist.  

  

Simultaneous measurement  

In this case, the rovers are turned on at approximately the same time, requiring that at least 

one person be available to man each rover. This results in an additional baseline(s) being 

obtained between the rovers.  

Alternating placement  

This can be done with just one person. After the first rover is started, the second rover is 

placed and turned on. The surveyor then travels back to the first rover, and moves it to a 

third location and so on.  

  

Both of these cases result in less total time spent in the field. The advantage of the 

simultaneous approach is that additional baselines are created between the rovers 

themselves. These additional baselines serve both as an error check and, in a least squares 

adjustment, allow a more accurate location to be established. The advantage of using 

alternating placement is that it can done by a single individual. (If desired, the rovers can 

be left on long enough to create additional baselines, but that would negate any savings in 

time.)  



 

  

Leapfrogging  
When working with a single-frequency system, baselines should be kept below about 6 

miles. Baselines up to 10 miles are possible, but the probability of such distances 

resulting in a failed processing session begin to increase significantly. In this case, the 

leapfrog method might be employed. Leapfrogging alternates the base station between 

the receivers. The rover on the first baseline becomes the base station for the second 

baseline and so on…. Long distances can be handled in this manner. This method can be 

also be used for creating a network of baselines which can then utilize least squares for 

adjustment and refinement of the positions.     



 

GPS and Coordinate Systems  
GPS processing gives a precise location of one receiver relative to another in terms of a 

change in X, Y, and Z in an  

EarthCentered Earth-Fixed (ECEF, for short) coordinate system. This is not the 

coordinate system used on the ground nor is it any other commonly used coordinate 

system. It is the coordinate system from hell. Consequently, the GPS processing software 

typically reduces the information (the author is tempted to insert a period here) to 

geodetic (latitude/longitude) or state plane grid coordinates.  

  

State Plane is not Ground!  
The problem with state plane coordinates is that they are not easily mapped to ground 

coordinates. State plane coordinates are mapped to the ellipsoid, a mathematical 

idealization whose surface exists at about sea level. If you inverse in the state plane 

coordinate system, the distances are not the same as those that would be obtained 

between the same points on the ground. Similarly, state plane grid azimuth is also not the 

azimuth that would be determined on the ground. Usually, ground distances are longer 

than state plane distances. Consequently, one cannot simply mix measurements on the 

ground with GPS measurements except at altitudes near sea level and over short 

distances.  

  

Adjusting with GPS Data  
To work with GPS data, one must choose a coordinate system and stick with it. If a state 

plane system is to be used, all ground measurements must be scaled and translated to fit 

the state plane grid. Similarly, if a local grid system is to be used, the GPS coordinates 

must be scaled and then translated.  

  

Combined Factor  
To translate coordinates between grid systems, the scale factor relating the two must first 

be obtained. There are, in reality, two scale factors involved. The first is the grid scale 

factor - it relates the distance between points on the state plane grid to the distance 

between the same points on the ellipsoid. The second is the elevation factor - it relates the 

distance between two points at essentially sea level to the distance between the same two 

points at the measured elevation. Multiplying these two together produces the combined 

factor or CF. Multiplying the ground distance between two points by the CF yields the 

state plane distance. Conversely, dividing the state plane distance between two points by 

the CF yields the ground distance.  

  

Moving to a Common Grid System  
When working with both GPS and ground measurements, the following steps are 

followed to merge the two. Both cases assume that at least two points have been used 

both as GPS points and ground points and that all measurements have been reduced and 

the points transferred to COGO.  



 

  

There should be two pairs of points in the project that need represent the same two points 

in field. As an example, suppose that point 1 is the same point as point 101, point 1 being 

a point measured on the ground and 101 being a GPS point. Similarly for point 2 and 

102.  

  

Local Grid to State Plane  

1) If not in COGO, open the COGO window.  

2) Select all the points in the project that are to be moved to state plane coordinates.  

3) Select COGO | Coord. Transformation | Standard.  

4) Using this example, enter 1 into the From Pt. box and 101 into the To Pt. box.  

5) Press OK. Point 1 should now be at the same location as point 101.  

6) Pick two points at opposite corners of the project area.  

7) If there are other objects close to the points turn off the selectability of everything except 

for points. 8) Place the cursor near each point, hold down the <Shift> key and press the 

right mouse button.  

9) Select Info from the popup menu.  

10) Jot down the CSF value.  

11) Add the two values (one from each point) and divide by two to obtain their average.  

12) Select COGO | Coord. Transformation | Standard 13) Put the averaged CSF value into 

the Scale box and select OK.  

14) Select COGO | Coord. Transformation | Standard again. 15) Select Relative in the 

Angular Rotation section.  

16) Press Dir 1. Select Select Two Points in the Angle dialog box that appears. Enter 1 (or 

101) for First Point and 2 for Second Point. Press OK.  

17) Press Dir 2. Enter 1 (or 101) for First Point and 102 for Second Point. Press OK.  

18) Press OK to complete the operation. This last step rotates the ground points to align with 

the GPS points.  

  

State Plane to Local Grid  

1) If not in COGO, open the COGO window.  

2) Select all the points in the project that are to be moved to local grid.  

3) Select COGO | Coord. Transformation | Standard.  

4) Using this example, enter 101 into the From Pt. box and 1 into the To Pt. box.  

5) Press OK. Point 101 should now be at the same location as point 1.  

6) Pick two points at opposite corners of the project area.  

7) If there are other objects close to the points turn off the selectability of everything except 

for points. 8) Place the cursor near each point, hold down the <Shift> key and press the 

right mouse button.  

9) Select Info from the popup menu.  

10) Jot down the CSF value.  

11) Add the two values (one from each point) and divide by two to obtain their average. 

Calculate the inverse of this value  

(divide it into 1.0). We’ll call this the average inversed CSF  

12) Select COGO | Coord. Transformation | Standard  

13) Put this average inversed CSF value into the Scale box and select OK.  

14) Select COGO | Coord. Transformation | Standard again. 15) Select Relative in the 

Angular Rotation section.  

16) Press Dir 1. Select Select Two Points in the Angle dialog box that appears. Enter 1 (or 

101) for First Point and 102 for Second Point. Press OK.  



 

17) Press Dir 2. Enter 1 (or 101) for First Point and 2 for Second Point. Press OK.  

18) Press OK to complete the operation. This last step rotates the ground points to align with 

the GPS points.  

  

GPS monuments  
When working with GPS, it is usually important to tie the system to state plane 

coordinates. To do this, one needs only to station one of the measured points on a state 

plane monument. This leads to the questions of “How do I find the GPS monuments in 

the area where I am working?”. Unfortunately, this is becoming more difficult because 

the people you thought were working for you (your local government officials) 

oftentimes do not want to provide this information because of liability issues. There is a 

source, however. Since the US Government has exempted itself from the laws that you 

and I have to follow by making itself immune to lawsuits, it sees no difficulty in posting 

the information on the Internet. So, get on the web and go to:  

 http://www.ngs.noaa.gov/FORMS/ds_area.html  
  

Sample Monument Document  
Below is a sample of a monument document from the NGS. The important features are 

the following:  

Horizontal Location: Specified typically as NAD83, this is generally specified as a 

precise latitude and longitude. In addition, there may be ECEF Cartesian coordinates 

(XYZ) coordinates given.  

Height: This is where one might get confused. There are three different heights generally 

provided -  NAVD88 - this is the orthometric (or MSL) height, often given in both 

meters and feet.  

 ELLIP HEIGHT - the height above the ellipsoid, usually only in meters  

  GEOID HEIGHT - this is NOT the height of the point in any form - it is the height of 

the geoid with respect to the ellipsoid at this location. The orthometric height can be 

determined as H = h - N where H is the orthometric height, h is the height above the 

ellipsoid and N is the geoid height.  

  LAPLACE CORR - (Laplace Correction) This is the difference between the geodetic 

azimuth and astronomic azimuth at this location.  

  

1  National Geodetic Survey, Retrieval Date = MAY 7, 1999  

 GC0770 

***********************************************************************  

 GC0770 DESIGNATION - INDIAN AZ  

 GC0770 PID   - GC0770  

 GC0770 STATE/COUNTY- TN/SUMNER  

 GC0770 USGS QUAD - HENDERSONVILLE (1983) GC0770  

 GC0770       *CURRENT SURVEY CONTROL  

 GC0770 

___________________________________________________________________  

 GC2195* NAD 83(1995)- 36 18 49.57099(N) 086 35 32.44101(W)  ADJUSTED  



 

 GC0770* NAVD 88  -  150.669 (meters)  494.32 (feet) ADJUSTED  

 GC0770 

___________________________________________________________________  

 GC0770 GEOID HEIGHT-   -29.46 (meters)      GEOID96  

 GC0770 DYNAMIC HT -   150.542 (meters)  493.90 (feet) COMP  

 GC0770 MODELED GRAV-  979,786.9 (mgal)      NAVD 88 GC0770  

 GC0770 VERT ORDER - SECOND CLASS 0  

 GC0770  

 GC0770.The horizontal coordinates were scaled from a topographic map and have 

GC0770.an estimated accuracy of +/- 6 seconds.  

 GC0770  

 GC0770.The orthometric height was determined by differential leveling GC0770.and 

adjusted by the National Geodetic Survey in June 1991.  

 GC0770  

 GC0770.The geoid height was determined by GEOID96.  

 GC0770  

 GC0770.The dynamic height is computed by dividing the NAVD 88  

 GC0770.geopotential number by the normal gravity value computed on the 

GC0770.Geodetic Reference System of 1980 (GRS 80) ellipsoid at 45 GC0770.degrees 

latitude (G = 980.6199 gals.).  

 GC0770  

 GC0770.The modeled gravity was interpolated from observed gravity values. GC0770  

 GC0770;     North   East Units Estimated Accuracy  

 GC0770;SPC TN  - 219,330.  545,790.  MT (+/- 180 meters Scaled) GC0770  

 GC0770       SUPERSEDED SURVEY CONTROL  

 GC0770  

 GC0770 NGVD 29  -  150.76 (m)   494.6 (f) RESET  3  

 GC0770  

 GC0770.Superseded values are not recommended for survey control.  

 GC0770.NGS no longer adjusts projects to the NAD 27 or NGVD 29 datums.  

 GC0770.See file dsdata.txt to determine how the superseded data were derived. GC0770  

 GC0770 MARKER: DD = SURVEY DISK  

 GC0770 SETTING: 30 = SET IN A LIGHT STRUCTURE  

 GC0770 STAMPING: INDIAN AZI 1961  

 GC0770 STABILITY: D = MARK OF QUESTIONABLE OR UNKNOWN 

STABILITY GC0770  

 GC0770 HISTORY  - Date  Condition  Recov. By  

 GC0770 HISTORY  - 1961  MONUMENTED  TNHD  

 GC0770  

 GC0770       STATION DESCRIPTION  

 GC0770  

 GC0770 DESCRIBED BY TN HIGHWAY DEPT 1961 GC0770 0.9 MI E FROM 

HENDERSONVILLE.  

 GC0770 FROM THE POST OFFICE IN HENDERSONVILLE, GO EAST ON U.S. 

HIGHWAY GC0770 31 FOR 0.9 MILE TO A CONCRETE CULVERT UNDER THE 

HIGHWAY. THE  

 GC0770 AZIMUTH MARK IS 49 FEET NORTH OF THE CENTERLINE OF U.S. 

HIGHWAY GC0770 31E, 16 FEET SOUTH OF A FENCE LINE, AND 13 FEET 

SOUTHEAST OF GC0770 A TELEPHONE POLE. THE DISK IS CEMENTED IN A 

DRILLED HOLE IN GC0770 THE NORTHEAST END OF THE CULVERT.  

  



 

  

GPS Almanacs  
The Satellite Planner and Satellite View functions both require a GPS 

satellite almanac in order to calculate the satellite data. The almanac can 

be downloaded from the following website and should be updated about 

every one or two months. ftp://ftp.navcen.uscg.mil/GPS/almanacs/sem/  
  

The general website is http://www.navcen.uscg.mil - you can also go 

there and navigate to the GPS section followed by going to the Almanac 

area and then the SEM section.  
  

There are two formats for a GPS almanac - SEM and YUMA. PC Survey 

can use either format, but the SEM format takes less space. A GPS 

almanac will start with either SEM or YUMA followed by a week number 

followed by the extension TXT. Week numbers range from 0 to 1023 with 

weeks beginning on Sunday at midnight GMT (Greenwich Mean Time). 

Week 0 began the week of August 22, 1999. As an example, SEM18.TXT 

is the SEM format almanac for the 18th GPS week - from December 26, 

1999 through Jan 1, 2000.  
  

When downloading the file, place it in the PC Survey almanac directory 

(the default is  

C:\PCS\ALMANAC), specified in the Directories section of the Options 

function. If there are multiple almanacs in the almanacs directory, PC 

Survey will use the most recent one, so all others can be safely deleted.  
  
  
  
  

GPS Post Processing Tutorial  
NOTE: Make sure your GPS hardware lock is securely attached to your parallel (printer) 

port before starting PC Survey.  

  

1. Start PC Survey. Go to “View 

Survey”, or press the  

Function 4 key (F4) on your 

keyboard.  

  

  

  

  

  



 

2. Go to GPS Load GPS 

Files. You will see what 

appears to be a standard  

“open file” dialog box. 

Select your first CE 

Survey file (usually your 

base point) and click 

“Open”.  

  

  

  

3. Notice that the “open 

file” dialog flashes 

briefly, then reappears. 

You may now select your 

next CE Survey file 

(usually a rover points 

file) and again click “Open”. Repeat this process for any 

remaining files. When you are finished, click “Cancel”.  

  

  

  

4. Your points should now be 

visible in the working field. A 

dialog appears, instructing you 

to select your control points. 

Click on your control point(s) 

(usually your base) in the 

working field. Return to the dialog box and click “Done”.  

  

  



 

6. Did you receive this error message?  

  

Let’s hope not. If so, you’ll have to reprocess those points.   

  

7. GPS post processing will now begin. 

If all is well with your points, they 

will change in color; first to  

blue, and then to green. If they 

change to red,  

those points failed. If they change to 

pink, then it is  

time to see a doctor, as you may be pregnant (just 

kidding).  

  

8. The following table summarizes the possible colors.  

  

5.   Next, the “Add GPS Control Point” dialog  

appears. If you have a known GPS monument  

that you have set up on, then enter its values  

here. This will tie your selected control point  

into a known control point. If you do not have  

any values to enter, then le ave those fields  

untouched. Click “OK”.    

  



 

  

  

Line 

Color  

Result  

Gray  Unprocessed  

Red  Failed  

Green  Passed  

9. After processing, a report will appear that will show 

information about each baseline. Following are some 

examples of processing reports.  

  



 

 

You may see either kind of report depending on which 

version of the software you are using. The most important 

information is the RMS and Reliability (called RMS 

Reliability in the old report style) values. The higher the 

    

    



 

RMS value, the less noise there was in the data. The 

higher the Reliability value, the higher the probability that 

the result is the correct one. The more important of the 

two is the Reliability. Ideally, this value should be greater 

than 2.0. The software will consider the baselines as 

“passed” when the value exceeds about 1.4. However, the 

higher the value, the safer you are from an error. 

Generally, the longer you collect data in a static mode, the 

higher this value will go. At least 20 minutes is usually 

necessary to obtain a 2.0 Reliability value with a single 

frequency receiver in good conditions (no trees, etc.). If 

the RMS value fails, the data was very noisy – usually 

indicating the presence of multipath or an obstructed view 

of the satellites. If a baseline fails, one or both of the RMS 

and Reliability values will be below the minimum. 

Regardless, this doesn’t mean that the baseline is wrong – 

indeed, you will find that most of the time when this 

happens, the solution is correct. What it means is that the 

probability that the solution is incorrect has become 

significant. In this situation, you can either recollect the 

data or, if you have performed error checks in the field, 

use the error check to verify the answer. CE Survey 

attempts to adjust for a lot of the problems that you can 

encounter while processing by extending the 

recommended sit time. However, the software has no way 

of knowing about multipath or trees unless the satellites 

actually become blocked. Signals that are delayed or 

deflected by things such as leaves on a tree will often 

appear as “good” data but will result in erroneous results. 

Tree leaves are particularly bad for kinematic surveying.  

  

10. KINEMATIC ONLY! If running static mode, go to 

step11.  

Next, the “Kinematic 

Transfer Options” 

dialog appears. 

Kinematic, as you 

know, collects one 

point every two 

seconds. The 

“Kinematic Transfer Options” dialog allows you to reduce 

file size by transferring only certain categories of points to 

COGO. After you select the points to transfer, click “OK”.  



 

  

11. Your points should now automatically transfer, and the 

COGO window will appear. If not, go to “Edit Generate 

Cogo Points”. Then, go to “View COGO”.  

  

At this time, all the points are in a state plane reference 

system, meaning that the assumed surface is either 

precisely (if you used a state plane monument for control) 

or approximately the WGS84 ellipsoid. Inverse distances 

between points will typically be less than the measured 

distances on the ground (e.g. with an EDM). To transform 

between the ellipsoid and the ground, a conversion 

function has been supplied. A simplified use of this function 

follows and a more detailed explanation of it is in the 

reference manual on p.185  

  

12. Select your points (refer to the PC Survey Tutorial if you 

are unsure how), then go to “COGO Coord. Transformation 

State Plane to Ground”.  

  

13.The  “State 

 Plane/Local  Grid 

Transformation” dialog 

will appear. Select the 

“State Plane to Local” 

radio button. Uncheck all 

transformation options 

EXCEPT “Scale”. Finally, 

enter your origin (base) 

in the “State 

Plane/Origin” prompt (the 

only option not greyed 

out at the bottom of the 

dialog). Click “OK”.  

  

  

  

Congratulations! You have usable, centimeter accurate 

COGO points. Now you can create alignments and 

boundaries, generate contours, and all the other functions 

you’ve become accustomed to performing in PC Survey.  
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Alignments, 95 creating, 155  
Editing, 155 Info, 164 Offsets, 155 Selection Filter, 112  
Angle  
Precision, 60 Angle adjust,  
78  
Angle Adjust  
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Geoid Calculator, 90  

Get, 217  
GPS, 87, 230 DGPS (Differential GPS), 231 mission 

planning, 89  
Graphics, 205  
Grid snapping, 33  
Groups, 206, 215 Creating, 215  

—H—  
HA, 63 HD, 63  
Height of Instrument (HI), 189  
Height of Rod (HR), 189  
Help online, 10 HI, 63, 69 hiding, 96 Hiding, 96  
Hold Angle, 70  
Hold Side, 70 Horizontal Angle, 70  

—I—  
Import DXF  

COGO, 36  
Layout, 37  

Import Points, 66  

Importing raw data from file, 64  

Importing data, 35  
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Info, 163, 164  
Insert  
Measurement, 71  
Insert Breakline, 196  

Insert Points, 195  

Insert Segment, 195  

Intersections, 173  
Bearing/Bearing, 173  

Bearing/Distance, 173  

Distance/Distance, 174  

Perpendicular Offset, 175  
Tangent Curve, 174  

Inverse, 177  

Alignment/Boundary, 165 Inversing, 123  

—L—  
Layer Sets, 27, 54 layers,  
114  
Layers,  
27, 54  
Colors, 55 defaults, 55 fonts,  
29  
Fonts, 55  
Line Style, 55  
Visibility, 55  
Layers (Modify)  
Set Layer, 118  
Layout  
Coordinate Display, 205 Select Status Bar, 205  
Toolbar,  
204 Layout Window, 204  
leader lines, 135  

Least Squares coordinate transformation, 187  
Least squares adjustment equipment errors, 77  

Least Squares Adjustment, 78, 79 Legal Writer, 167  
Library (Components), 225  
Linear Error Search, 80  
Linear Transformation. See Coordinate  

Transformation Linear Transformatiuon, 184  
lines cre ati ng,  

13 
3  

Lines, 95 annotation, 100 automatic creation, 138  
Best Fit, 135 Drawing, 42 extending, 136 Line Define 

dialog, 32 Line Entry (Mapcheck), 84 line styles, 227 

selection filter, 111 splitting, 136  
Style, 55, 117 links, 31  
Load GPS Files, 87  
Log File, 57 Loop, 63  

—M—  
Mapcheck, 84 creating, 84 Curve Entry, 84 Line entry, 84  

Mapchecks  
Editing, 85  

Reports, 86 Menu Bar, 93  
Menu Summary, 11 Menus popup, 34  
meters, 59 metric, 59 Minimum Text Size, 57  
Mode Change  
Command set, 67  

Modify Group (Points), 125  

Modify Line Text, 115  

Modify Profile Axis Parameters, 161 Multiply Determined  
Sideshot, 72  

—N—  
New, 50 Next Number, 190  

—O—  
Object snapping, 33  
Occupy Point, 189  
Occupy/Backsight, 189 Offset, 134 Offset(Aln/Bnd),  

155 offsets  
COGO, 134 points, 121 Offsets Line Define dialog, 32 

Perpendicular, 175 prism, 75  
Open, 50  
Options, 56  
COGO, 100  
Directories, 58 general, 56 Survey, 63  
Origin, 184 overlays, 114 visibility, 97  
Overlays, 114  

Overview, 10  
Overwrite, 190  

—P—  
Page Layout, 222 Pan View, 38 pcs.ini, 227 perches, 31 

Perpendicular Offset, 175 Place, 216  
Place North Arrow, 209 Plotting, 109 Point In Direction, 

123 points, 95 connecting with lines, 133 copying, 124 

creating, 86, 130 editing, 125 exporting, 107 finding,  
113 importing, 66 renumbering, 124  
visibility, 96  

Points creating, 119, 120, 122, 123 descriptions, 28 

Descriptions, 56 digitizing, 122 enabling and disabling, 28 

Generate COGO points, 81 hiding, 96 importing,  
104 numbers, turning off, 210 pre-defined descriptions, 28 

selection filter, 111 station/offset creation, 121 symbols, 

98, 137 visibility, 55, 91  
points_editing, 126 pointsNumber Report,  
190 Polygon, 39 Polyline, 39  
Popup menus, 34  
Precision, 60  
Advanced, 61  
Predetermined Area, 165 Printing, 109  
DTM, 193  
Layout, 222  
Survey, 66  

Prism, 63, 69 errors,  
75  
Prismoidal, 200  

Process This Session, 88  

Profile Create  
Cogo Points,  

162 selection,  
160  
Profile Parameters, Modify, 160 Profile window, 161  

Profiles, 159, 213 creating, 159 deleting, 159 editing,  
159  
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Printing,  

162  
Project files, 27  

—R—  
Rafraction, 74 raw data (Import), 64 Reciprocal 

Measurments, 72  
Recording, 57 Redraw Screen, 38 regular expressions, 137 

Regular Expressions, 192  
Reports  

Mapcheck, 86 Resection, 72  
Reset Position, 115  
Reset Units, 115, 143 Reverse Elevation, 70, 72 rods, 31 

Rotate, 222  
Rotation, 184  

—S—  
Satellite Planner, 89 Satellite Viewer, 90  

Save, 50  
Settings, 57 Save As, 50  

Save to Overlay, 82  

Scale, 184  
COGO, 101  
Scale Components, 208  
SD, 63  
Sea Level Corrections, 74 Select Layer Set, 55  
Select Status Bar, 94, 110 selecting, 110 Set Color,  
117  
Set Fill, 218  

Set Font, 29, 200, 212  
Set Layer, 118  

Set Scale, 209  

Settings  
Equipment, 76 Shot, 63  

Shot Entry, 67  
Editing, 71 Side Shot, 130 sideshot, 68 Sideshot, 72  

Multiply Determined Sideshot, 72  
Smash, 216  
Split Line, 136  

Stake Tool  

Curves, 128  
Points, 127  
State Plane to Ground, 185  
Station Line, 157 deleting, 158 Metric stationing,  
60  
Status Bar, 94  
STN Pt, 69  
String Characters, 192  
Survey  
Options, 63  
Terminology, 63 Survey Window, 62  

Symbols points, 98 Station, Sideshot, Coordinates, 63  

—T—  
Tables, 178  
Curve, 179  
Editing, 181  
Line, 180  
Placing in Layout, 214  
Point, 180  
Tangent Curve, 174  

Terminology  
Surv ey, 63 text copying, 142 pasting, 142 turning off, 

96 Text  
Editing, 211  

Text, 44, 95, 205 creating, 44 editing, 142 Layout, 211  
Minimum Text Size, 57 modifying line annotation, 115 

moving, 140 rotating, 140 Selection Filter, 112  
The Component Window, 224  
TIN, 193, 195  
Delete, 193  

Inf o, 198 Title  
Bar,  
93 To Cogo,  

86  
Tolerances, 63 Tool Bar, 93 traverse, 68 Traverse, 63,  
70, 72, 130  
Options, 130  
Traverse Loop, 63  
Triangle Solver, 191  

Triangle Swap, 195  

Triangulate, 198  

Turned Angle Calculator,  
30 Turning Points, 72  

—U—  
Undo, 118  
Ungroup, 215 Unhiding, 96  
Units, 59, See also Reset Units  
Chains, 31  
Links, 31  
Perches, 31  
Rods, 31  
Varra,  

31 Update,  

216  

—V—  
VA, 63 varra, 31  
Vertical  

Angle, 70  
Vertical Control Create Cogo  
Points, 162 selection, 160  
Vertical Control window, 161  

Vertical Controls, 159 creating, 159 deleting, 159 

editing,  
159  
Printing, 162 view areas, 113 visibility, 55 overlay, 

97  
Visibility, 91, 96, 202  

Volumetrics, 200, 201  

—W—  
Windings, 72  
Write Layer Set, 55  

—Z—  
Zoom In, 38  
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Zoom Out, 38  

Zoom Previous, 38  

  


